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One Step Forward,
Two Steps Back

ow many of us own the latest 3G cell phone, 64 MB handheld or a
DVD-Writer? Not too many, but we sure wish that we did.

These cool toys have tremendous drool value that’s built up by all the mar-
keting hype created around them. And companies need to sustain this hype in
order to boast that they’ve got the biggest, fastest, or most powerful technolo-
gy product in the world. Plus they get to build a feel good factor with their
shareholders, stock analysts and the general consumer who ends up associat-
ing any product or technology from that company as the best available.

Why are we letting a bunch of marketers dictate what we need?

We need to realise that the increased utility offered by most of these tech-
nological innovations is purely incremental—there’s no ‘this-will-change-my-
life’ experience associated with them. Actually, the benefits of most ‘cool’ tech-

Vinit Aggarwal

Assistant Editor

nologies are negated when you realise that instead of speeding up efficiency, or ¢ . .
allowing us to accomplish the same amount of work in less time, we are often ‘The Iﬂcreased Ut|||ty
faced with expectations that more must be done in the same time. Oﬁe red by MOost
Also the gee-whiz appeal with owning the largest hard disk, the fastest CPU .
and the most powerful video card is short-lived—there’s always a better, faster, teCh nO|Og|Ca|
and more affordable technology around the corner. In the end what’s impor- mnova’uons IS pure|y
tant is whether your new printer is capable of printing more than 500 print- ; . /
outs with a single ink cartridge and not whether it prints at 1200 or 2400 dpi lncr?m_ental there S
since you won'’t notice a perceptible difference in the first place. It doesn’t mat- NO J[h|5—\/\/| | |‘Cha ﬂge—
ter whether your killer 2 GHz notebook is three times faster than your desktop my_“fe’ experience
PC, if it won't let you watch an entire DVD movie during those boring flights . d . h
without requiring a battery recharge in the middle. assoclate Wl;,
We mistakenly concentrate only on unnecessary ‘tangible’ aspects of tech- them

nology—how fast or powerful it is—whereas we need to look at whether new
technological innovations fulfil their basic promise of greater convenience,
simplicity and efficiency.

What we really need are products and technologies that will simplify and
enrich our lives, allowing us to do things we actually care about—more free
time for family, personal goals and recreation.

And the only way this will happen is if we look beyond the hype and start
demanding the so-called innovators to drive innovations that really matter to
their customers—that’s you and me.

vinit_aggarwal@jasubhai.com
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USB OTG

N What is it?

A supplement to the already
existing USB 2.0 specifica-
tion. With this standard, USB
devices will be able to direct-
ly connect to other USB
devices. Being backward
compatible with prior USB
standards, devices based on
USB OTC will be able to
operate on all PCs equipped
with a USB interface.

B How does it work?
When connected to a com-
puter, a USB OTG device
behaves as any conventional
USB 2.0 device would. When
two USB OTG devices are
linked together, the cable
sets a default host and a
peripheral device. However,
if the nature of the applica-
tion decides that their roles
need to be reversed, then a
protocol called the Host
Negotiation Protocol (HNP)
changes the operating status
of the connected devices.

H What does this mean

. to me?
A digicam could interface
directly with a photo printer
or another camera to
exchange picures. A scanner
could join forces with a net-
work printer for sending
faxes. These combinations are
not possible today because
USB has a PC-centric tree
topology. The PC is the host
(tree) and the USB devices are
the branches. USB OTG wiill
allow devices to communi-
cate directly without a PC.

D | G | T EANESE IS

Anonymous P2P

ew of us are unaware of
Fthc legendary success of

peer-to-peer (P2P) servic-
es like Napster and Audio-
galaxy, that enabled millions
worldwide to trade movies,
songs and data freely. A group
of veteran hackers revealed a
new file sharing

standard  that —
promises  to
take P2P to

the next level

by increasing

security.  Devel-

oped by a 23-year-old hacker
called the Mixter, this proto-
col is called Six/Four (named
after the June 4, 1989 mas-
sacre at Tiananmen Square).
Six/Four is based upon P2P

technologies coupled with
VPN (Virtual Private Net-
works) and ‘open proxy' net-
working in order to mask
online identities. Traditional
VPN, used
even with
operating sys- %
&

Vp

ILLUsTRATIONS: Mahesh Benkar

tems like

Windows, estab-

lish a secure tunnel
between two computers

where information can be
securely transferred across the
Net. In Six/Four, the tunnel
follows many computers in

news feed

the network before finally
reaching the destination
on the Internet. The greater
the number
of  servers
between a user
and the destina-
tion, the harder it is
to trace the user’s
r address.
Six/Four
implements
about 100 steps of
layered anonymity before it
reaches the final destination
making it virtually impossible
to trace the user. This new
protocol was unveiled at the
H2K2 hacker conference held
between July 12 and 14 in
New York City.

=
=

Mushy robots

ynthia Breazeal, an
MIT professor, has
built the ‘sociable’

robot called Kismet, with a
cute face capable of smiling,
frowning, looking surprised,
and mimicking a few other
basic emotions.

Kismet responds to the
tone of voice, facial expres-
sions and physical behav-
iour and comes up with

an appropriate response.
Kismet is much like a child,
and is being developed
using theories of develop-
mental psychology. The goal
is to create a self-learning
robot that can pick up emo-
tions just like a growing
child and learn from its sur-
roundings.

Traditionally, robots have
been designed to operate
in hazardous and hostile
environments, but now the
applications are shifting
towards entertainment and
health care, where robots
have to interact with people
and play a part in their daily
lives. Kismet promises to be a
big step in this direction.

-~

Palm OS 5 unveiled

PalmSource Inc has begun
shipping the final version of
Palm OS 5 to licensees and
developers who can now
adopt the
highest-per-
formance
ARM chips
from Intel,
Motorola
and Texas
Instruments.
Palm OS 5 will deliver an
enhanced user interface
that enables increased per-
sonalisation, security, multi-
media and wireless net-
working, while maintaining
compatibility with today’s
Palm OS-based software
and hardware.

® Gnutella developer dies at 25 in apparent suicide ™ Counterfeits from China spell trouble for Intel ®1BM to offer Linux computing on a per-unit usage m

digith )
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The billionth PC

reclalert

he personal computer
industry has passed a
historical milestone as

the one-billionth PC was
shipped in April this year,
according to a Gartner
Dataquest research. While it
took 25 years for one billion
PCs to ship out, Gartner pre-
dicts that the two billionth
PC will ship out in just six
years’ time. In 2008, the PC
industry is projected to reach
the milestone of 2 billion PCs,
with the greatest growth
opportunity coming from

high emerging markets in
places such as China,
Latin  America
and Eastern
Europe. The Asia-
Pacific region
ranked as the
third major
regional mar-
ket, with more
than 100 mil- “§
lion PCs being
shipped to the
region.

The report also predicts
that the PC industry will get a

big boost in the next few

years from ubiquitous
broadband services.
Once broadband

services are avail-
able everywhere
at data rates
exceeding 10
Mbps, the PC
will  become
the central
appliance that
manages commu-
nications and entertain-
ment in homes. Here’s to the
next 1 billion PCs!

4G in India

India’s Ministry of Informa-
tion Technology has formed
a new wireless technology
group to develop the fourth-
generation wireless standard.
The plan is based on a study
by Vinay Deshpande, former
president of the Manufactur-
ers’ Association for Informa-
tion Technology and H.S.
Jamadagni, a professor at the
Indian Institute of Science.

Snail mail meets e-mail

an interesting experiment,

China plans to marry
e-mail and snail-mail to pro-
vide a convenient alternative
to Internet users. China Post,
the official Chinese postal
service, will soon introduce
the service which will allow

In what could be termed as

anyone with a computer to
type an e-mail, send it across
to the postal service, where
the mail will be printed, put
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in an envelope and be hand
delivered to its destination.

There is a large potential mar-
ket: according to government
figures, mainland China had
33.7 million Internet users at
the end of last year. In a coun-
try of 1.3 billion, that means
only a tiny fraction has access
to e-mail.

The Chinese postal service
hopes to bridge this digital
divide by attracting medium-
sized and small companies
along with appropriate entre-
preneurs with this offering.
Although the relatively high-
cost of the service will initial-
ly keep individuals away,
hopes are that the venture
will take off and eventually
drive costs down to a level
that will be affordable by the
common man.

JPEG virus

Here’s something that you
don’t see very often—a virus
that affects JPEG images.
Called Perrun, the virus
appends itself to JPG files and
requires an extractor to
extract and execute the virus
code. It arrives in the form of
an 11,780 byte portable exe-
cutable or EXE file. When exe-
cuted, the 5,636 byte extrac-
tor component (EXTRK.EXE)
is dropped to the current
directory and a system Reg-
istry key is modified.

Perrun is relatively harm-
less. Systems without the
Perrun extractor component
are not affected when they
open an infected JPEG file
and if the extractor is
installed, you are safe as long
as you don’t open infected
JPEG files. To prevent infec-
tion, ensure that your anti-
virus software is updated.
Also check if the size of JPEG
files has increased by the
specified amount.

Shakira’s here for
the monsoons

The latest Internet worm
spreads by inviting you to
open an infected mail that
promises to display pictures
of pop star Shakira. The VBS/
VBSWG.ag@MM worm con-
tains the subject line, ‘Shaki-
ra’s Pictures’, with the body
of the mail reading, ‘Hi : i
have sent the photos via
attachment Have funn...".
The attachment has the file-
name ‘ShakiraPics.jpg.vbs'.

It spreads via Outlook
and Internet Relay Chat (IRC)
and overwrites .vbs and .vbe
files with its own code. How-
ever, the damage caused is
minimal. Install the latest
virus updates for your anti-
virus software and delete any
suspicious e-mails.

= Microsoft stakes IP claims on OpenGL = IC makers, OEMs define next-generation digital interface: HDMI = Yahoo! gets a facelift—new home page
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Lets talk
Open Source

The power and utility of
mobile devices is always on
the rise—cell phones that
double up as PDAs, PDAs
that can do multimedia and
so on. This scenario is about
to get better with the cell
phone bigwigs showing a
trend of adopting open
source technologies, paving
the way for third-party
developers to create appli-
cations that can talk to the
next generation of mobile
devices. For
example, the
new Nokia
7650 phone
has aborted
the Psion
Link Protocol
(PLP) that
was used by
Symbian and
has now moved over to the
standard TCP/IP protocols.
Work on this is being car-
ried out by Jeremy Burton
of a company called
Intuwave, in conjunction
with Mark Melling who ear-
lier worked with Symbian.
With the path now
paved for developing on
open protocols, the route is
far easier for Linux and Mac-
intosh developers to create
software for these new
phones. Already Linux and
KDE hackers have success-
fully integrated support for
Psion-based handheld com-
puters directly into the
operating system’s interface.
With many such
advances on the way, the
erstwhile PLP protocol can
now be safely relegated to
the recycle bin since Psion
does not make PDAs any
more and the protocol is
quite dated.

didit i F:]

Aussies teleport laser beam

team of physicists at
the Australian National
University led by Dr

Ping Koy Lam has successfully
disembodied a laser

beam at one loca-
tion and rebuilt

it at another
spot about a
meter away and
in the blink of an
eye. The team tele-
ported the beam,
Star Trek style, but it
got destroyed in the
recreation process.
However, Lam
claims that day is
not too far when
solid matter could

be teleported from one loca-
tion to another. “My predic-
tion is that it will be done in
the next three to five years—
that is the teleportation of a
single atom.” But since
humans are made up of zil-
lions of atoms (one followed

by 27 zeroes), the possibility
of a Star Trek like transporter
is remote. “In theory, there is
nothing stopping us from
doing it, but the
complexity  of
the problem is
so huge that no
one is thinking
seriously about it
at the moment,”
Lam told a news
conference.
The immediate
benefits of such a
process lie else-
where. The break-
through opens up
€normous possi-
bilities for super-fast
and super-secure communica-
tions systems and quantum
computing, over the next
decade. Physicists believe
quantum computers have the
ability to solve problems mil-
lions of times faster than con-
ventional computers.

The new Celeron

ntel unveiled its first
ICeleron processor based

upon a 0.18 micron archi-
tecture with a Pentium 4-
derived core.
Debuting at
1.7 GHz, this
processor  will
feature 128 KB of
L2 cache as
opposed to the 256
KB of cache found in
the P4 processor.
Architecturally, the core of
this new Celeron is no dif -
ferent from the Willamette
core of the P4 that was
launched in November 2000.
This processor operates on
motherboards based on
Intel’s i845 and the i850
chipsets. Due to DDR and
RDRAM support offered by

these chipsets, their memory
bandwidth would be signifi-
cantly higher than that
offered by the erst-
while i815 mother-
boards. The new
Celeron uses the
same Quad-
pumped bus
that is utilised
by the P4,
which translates into
3.2 GBps of bandwidth—
enough to support this
processor at its current speed.
The icing on the cake? It's
priced nearly 40 per cent
cheaper than the P4 1.7 GHz.
Tests have also indicated that
this processor lends itself
well to overclocking and
could become a poor man’s
P4 if tweaked!

C for graphics
Programmable video cards
have been with us for some
time now, but the promise of
special effects and real-time
cinema-quality graphics
remains largely unfulfilled. A
large part of the blame can
be put squarely on the need
for assembly-level program-
ming to get anything good
out of these video cards.
Working at a hardware level
is a time-consuming and
non-intuitive process that
few programmers wish to get
into. This is where nVidia
hopes its latest offering—a
high-level language termed
Cg, ‘C for Graphics'—will
offer an easier solution.

Cg is an attempt to
replace OpenGL and
Direct3D and also offers
cross-API transparency in
which the same code can
run on Windows, Linux, Mac
OS X and the Xbox. Cg will
work with both, nVidia and
non-nVidia hardware and is
compatible with the upcom-
ing DirectX 9.0 High Level
Shading Language. In short,
Cg will allow game develop-
ers to utilise powerful pixel
and vertex shader effects
and finally put them to their
intended use.

As it approaches maturity
(expected by October this
year) a better picture will
emerge on its capabilities
and limitations.

snapshot

VSNL stands to lose

Rs 3.5 billion

if WorldCom Inc

files for bankruptcy

following the
accounting scandal

Source: Reuters

= Pac-Man headed for Sprint 3G = RealNetworks to launch GamePass monthly subscription to give free and discounted games ® Doom Il possible for Xbo
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Hijacked by a salesman

ivePerson Inc offers cus-
Ltomer service chat solu-

tions for some 3,000
Web sites. It is now pushing a
technology it calls Proactive
chat to engage online shop-
pers upon arrival.

“I'm alive rep here to

answer questions and
offer promotions,” \
says Cole when
you first visit
TechnoScout.com.
“What product did
you wish to chat
about today?”
TechnoScout.com is
one of the first

Macworld
Expo 2002

e largest convention for
Mac-addicts, the Mac-
world Expo was held on

July 17 in New York. Apple
showed off some new gadgets
and added new features to some
old ones—their iPod audio
player now works with Win-
dows. Also unveiled was the
new high-end Mac with a 17-
inch monitor. Enhancements in
Mac OS X include an improved
address book and increased
interoperability between the
computer and cell phones. But
there’s some bad news for Mac
aficionados—they  will now
have to pay for the .mac e-mail
address and Internet storage.

snapshot
15 million

people expected to

share digital images
on the Net in 2002

Source: Gartner Dataquest

didith.y)

|/

e-commerce sites to try Proac-
tive chat. As soon as you enter
the site, the salesbot asks you
what you need help with. It
then directs you to the prod-
uct or tells if the site does not
stock the particular item. The

salesbot can even get

;)

il

you attractive discounts.

One of the biggest e-com-
merce firms, eBay, has signed a
deal with LivePerson to help
surfers register bids. Instant
communication and problem
resolution is appealing both
to Web sites and their users.

Quite contrary to LivePer-
son’s claim, Esteban Kolksy,
a Gartner analyst, described
Proactive chat as “one of
the most annoying experi-
ences of my life. When you
do proactive chat, you
don’t know what the person
is looking for, you just get
in their faces”.

Go play outside!

research study conduct-
ed by Akio Mori, a pro-
essor in Nihon Univer-

sity’s College of Humanities
and Sciences, links playing
video games with reduction in
mental faculties. The activity
of the human brain can be

associated with brain waves—

electrical signals that are sent
out by the brain cells. Two
such waves were used as point-
ers in this study—beta waves
indicate liveliness and activity
and alpha waves are emitted
when resting. Mori analysed
the brain waves of 240 people
aged six to 29 years, and cate-
gorised the results according
to the type of person being

studied. The first category con-
sisted of people who rarely
played video games and
showed stronger emission of
beta waves, implying an active
mind. Those who spent
between one and three hours
each day playing games had
roughly equal beta and alpha
waves before each gaming ses-
sion. However, once they start-
ed playing games, the beta
activity rapidly decreased
below the level of alpha activ-
ity. In those who spent
between two and seven hours
each day, beta activity was
constantly near zero, even
when they were not playing.
“Many video games stir up
tension and a feeling of fear,
and there is concern that this
could have an effect on the
autonomic nerves,” Mori said.
Interestingly, the study
group did not play anything
cerebral like Civilization III,
or even a fairly strategic
action-game like CounterStrike.
Mori centered the study on
Nintendo video games.

*93 heroes

Gaming consoles
Console game sales received
a very healthy boost when
Sony Computer Entertain-
ment America sold over
5,20,000 PlayStation 2s in
June 2002 in the US and
Canada. In similar vein,
Microsoft's Xbox sold
around 2,30,00 units and
Nintendo's Gamecube
console moved 1,12,300
pieces.

E-governance

The Madhya Pradesh govern-
ment, along with Microsoft,
is embarking on a project
that aims to bring about
various levels of e-gover-
nance in its different depart-
ments and operations.

@ zeroes

Online shopping

Joseph D’Amelio thought
he’d found a great deal on
eBay—a 2000 Porsche 911
for $50,000. After talking
to the seller and getting a
copy of the car’s confirma-
tion sent to him in
advance, he wired the
money to an escrow com:
pany and fell victim to an
elaborate scam. The seller
had actually hijacked a
legitimate eBay member’s
account and set up a fake
escrow service.

P2P

American legislators are
readying a bill that could
sharply limit Americans’
rights relating to copying
music, taping TV shows
and transferring files over
the Internet. This could

seriously cripple P2P serv-
ices and could have an
affect on other users
worldwide.

= Universal Music to put its library online = Panasonic will launch a drive to read multiple DVD formats = China threatens unlicensed Internet cafe owners
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The new pay
Napster

Napster, the radical MP3
swapping application that
started the peer-to-peer revo-
lution, has opened a new
chapter. Faced with dire
financial situations, it reached
an agreement with German
media company Bertelsmann
AG to offer a secure music

file sharing service.

A beta program was start-
ed early this year, involving
reworking of the software to
integrate Digital Rights Man-
agement, accounts, audio
fingerprinting, etc to work in
tandem as part of the appli-
cation. Despite a few spoilers
like the download limit of 50
tracks a month and the
inability to burn the down-
loaded music on CDs, the
new Napster still feels like the
old one. Its best feature—
browsing through a real per-
son’s music collection, send-
ing them messages and rec-
ommending new music—still
survive. But the options to
write songs on to a CD or
move them to a portable
player are noticeable by their
absence, as is the option to
search for MP3 files alone.
The music player built into
the software seems good
enough, though the playlist-
ing feature is a bit wobbly.
But even with the ability to
chat with other users and
browse through their hard
drives (albeit only the copy-
right-cleared .nap tracks),
it is tough to find tracks to
download. But in terms of
technology and how true it
has stayed to the original
model, the new Napster
could still be a winner.

didit b.y]

Blind games

at started off as a
friendship has
developed into

inspiration. Jeremie Spitzer
and Paul Silva at the Universi-
ty of Massachusetts were
hanging out with a visually
impaired friend, Tim Keenan,
when they decided to make
computer games with
such strong audio that
even the visually impaired
could play them.

The trio have co-
founded a small com-
pany called ZForm,
which is present-
ing its first prod-
uct, an online
video poker game,
at the convention of the
National Federation of
the Blind. The game is
quite simple: it tells
the player the cards
he is holding and
what the other players
are doing.

Spitzer maintains that the
blind and sighted can com-

pete on the same level in this
video game. ZForm is also
building a prototype of Quake,
the ultimate proof of their
work.

Modifying Quake to create
an environment with only
sound cues hasn’t exactly
been child’s play—a pair

of headphones is imper-
ative to playing the
game. For example,
when a new passageway

comes up, the
player can hear a
slight gust of air on
that side. Objects
like guns or
compet-
ing players
give off charac-
teristic sounds, their direc-
tion indicated by their rela-
tive volume.

tomorrow’stechnology
Autonomic computing

Researchers at IBM have iden-
tified a problem that has long
been associated with comput-
ing—far too much time is
spent in maintaining the sys-
tem itself than getting the job
at hand done. If computing
systems can take care of them-
selves and adapt to situations
as they arise, users would have
more time to think about
working with their actual
applications. Inspiration for
this computing philosophy
was drawn from the most bril-
liant autonomous system

found in nature—the human
body, which transparently
takes care of all complex func-
tioning like telling the heart
when to beat, moderating
temperature and repairing
damages.

Autonomic computing
will be a marriage of fields like
artificial intelligence, neural
networks, control theory as
well as cybernetics. It promis-
es systems with the ability to
dynamically adjust to exter-
nal conditions, diagnose
errors and bottlenecks and

quoteworthy

“We're starting to
shrink [chips] Tess rap-
idly than in the past”
Intel’s Gordon Moore states
that his prediction of chip
performance doubling every
two years may start to slow
down from now on as the
physical limits of processor
fabrication are being reached

“Then we'll have
options, and we like
to have options”

Steve Jobs, on the fact that
Apple is first concentrating on
the company transitioning
over to OS X before consider-
ing moving from using
Motorola chips in their
computers to Intel chips

snapshot

Losses due to soft-
ware piracy in Asia-

Pacific pegged at

$4.7 billion

in 2001

Source: Gartner

take appropriate action, pro-
tect itself from external
threats, optimise and antici-
pate information delivery for
the fastest possible opera-
tion—and all this is going to
be transparent to users,
enabling them to concentrate
on the task at hand.

Working systems are
already being demonstrated
with ‘cellular’ chips that can
recover from damage or fail-
ure and heterogeneous sys-
tems that can manage work-
loads over networks.

= Tuned-up version of Morpheus imminent = Vinod Dham, brain behind Pentium, to invest in Indian hardware industry = eBay buys PayPal for $1.5 billion
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Head2Head: Magazine or CD?

Dear Vinit,

I have been a regular reader of Digit and have wit
nessed an increase in the number of covermount
CDs (from one to two) and a decrease in the nunt
ber of editorial pages (from in excess of 150 to
around 130 pages) over the years. Please keep in
mind that there are readers who have limited
access to a PC and buy Digit for the magazine
alone. | feel it would be better if you introduce a
copy of the magazine without any CDs.

Swaminathan Karthik
Via e-mail

Dear Editor,
| really love the 48
Digit CDs. I was
wondering,
whether it would
be possible for
Digit to be pub-
lished entirely on

a CD. | bet the digital Digit would solve a lot of prob-
lems, including the paper crisis.

Hemanth Hariharan
Via e-mail

Send your letters marked ‘Readers Letters’ to the Digit office:
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706,

Phone: 022-7629191/9200 Fax: 022-7629224

E-mail: readersletters@jasubhai.com
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Short Bytes

Superb

Hi Guys,

Each month I see Digit
getting younger and pret-
tier. The comparison tests
are simply great. How do
you guys manage to test
so many products every
month?

S. Sarathe

Via e-mail

Hi S,

Unlike what some believe, we
don't have a magic wand
that we twirl every month
and hey presto! The tests are
completed! Getting all those
products tested is hard work
and the guys at our Test
Centre deserve all the credit.

Well done

Dear Vinit,

I am a great fan of Digit
and eagerly await the 1st
of the month. The maga-
zine is simply superb and I
really appreciate all the
effort you put into making
every edition absolutely
memorable. Thank you for
doing such a wonderful
job.

Joy Thomas

Via e-mail

Go’f Ups

= TO a query from our reader,

K. Amit, in the July 2002 issue
(Q&A, page 104) we wrongly
mentioned using System File
Checker with Windows Me. The
correct solution would be to run
msconfig.exe and then extract
the required file from the Wir
dows Me CD. We thank our dili-
gent reader Mohan for pointing
this out.

= N the HTML editing software
test in the July issue, we wrong-
ly mentioned Wipro Infotech as
the contact for Macromedia
Dreamweaver MX (page 80).
The correct contactis:
Macromedia, 022-8201705,
nchawla@macromedia.com

Notice any goof-ups? Write to
goof@jasubhai.com
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UNITED

A coalition of Linux vendors promises to bring some order to the

Gurunandan Bhat
Professor, Goa University

“ Unlike bot-
tled water, the
exercise of
building a distri-
bution goes
beyond mere
superficial
branding and

packaging ,,

FCM 26

ackaging and marketing a Linux

‘distribution’ is a bit like selling

bottled water. Take something

that is freely available, add value
to differentiate your distribution from
the rest, create a brand and then hope
that your intended audience shifts their
loyalties. But unlike bottled water, the
exercise of building a distribution goes
beyond mere superficial branding and
packaging. Linux distributions tend to be
judged by the ease with which they
install, their adherence to standards, the
simplicity with which they can be cus-
tomised and maintained, as well as the
quality of support and availability of
upgrades and bug-fixes provided by the
distribution maker once installation and
deployment is complete.

Today, over 200 Linux distributions
are fighting for a share of the market,
each one targeted at a unique set of
deployment scenarios and end users.
Mandrake and Lycoris (earlier called
Redmond Linux) are clearly targeted
at the desktop user, Debian is for the
austere security-conscious GNU enthusi-
ast and RedHat and SuSE for the enter-
prise user. The ‘freedom’ to choose from
a large number of Linux distributions
does have a frustrating aspect since dis-
tributions go their own way in matters
such as mandating the location of
system files, startup scripts and configu-
ration tools. These differences have
also necessitated distribution-specific
certification.

The announcement of a new consol-
idated Linux distribution—one that
brings together four frontline Linux dis-
tribution vendors and called rather ambi-
tiously ‘United Linux'—is heartening.
The four vendors are Caldera, SuSE, Tur-
bolinux and Connectiva—the number is
expected to increase as more vendors

increasingly chaotic Linux distribution market

join the coalition. Though RedHat and
Mandrake are not yet a part of the Unit-
ed Linux coalition, the announcement
has been greeted with hope and relief
from industry heavyweights such as IBM,
HP, Computer Associates, Borland and
SAP. Designed to be an enterprise-class,
industry-standard distribution, United
Linux is being promoted as a single, sta-
ble and uniform platform for application
development, certification, and deploy-
ment allowing Linux vendors, Indepen-
dent Software Vendors and Independent
Hardware Vendors to support a single
high-value Linux offering rather than
multiple different versions.

This bodes well for desktop Linux
users who have to battle with the fact that
each distribution has its own proprietary
packaging standards for binaries. RedHat,
Mandrake and SuSE use the rpm (RedHat
Package Manager) to distribute applica-
tions but a SuSE rpm won't install cleanly
on a RedHat or a Mandrake system. If this
broad coalition of vendors can work
towards addressing and resolving these
issues, United Linux would be a signifi-
cant catalyst in the widespread acceptance
of Linux.

Many years ago, Caldera, one of the
partners in the United Linux initiative,
released a delightful Linux distribution
that allowed the user to play tic-tac-toe
during the install. The idea that a Linux
install could be as easy as tic-tac-toe was
revolutionary for those times. Today
most distributions, with their increas-
ingly improving ability to detect hard-
ware and configure drivers, have matured
to an extent that ease of installation is
no longer a stumbling block. It is time
now to move on to life after tic-tac-toe
and how United Linux performs there
will decide the future of Linux, whether
United or not.

Gurunandan Bhat teaches at Goa University and works with Synapse—a Goa-based non-prof-
it organisation working in the area of Information Technology and Media. He has been an avid

Linux enthusiast since 1993
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A cornucopia of information stored on something the size of a
sugar cube or a postage stamp...brace yourself to be enveloped in
all the digital information you could ever dream of accessing!

ach time you watch a fast-paced

DVD movie or pull down a piece

of information from the Internet

r even access the ATM at the

corner of your street, you are actually
tapping into large repositories of digital
information. The ability to store large
amounts of digital information has
brought about the various comforts and
possibilities that we are so used to—
ready access to any kind of information,
portable entertainment devices that fit
in the palm of your hands, blazing fast

diditk)y

portable computers, data farms for enter-
prises and movie experiences that can
challenge reality itself.

How big is big?
The rate of advancement in storage tech-
nology has been truly amazing. From the
first instance of digital storage with
IBM’s 5 MB RAMAC hard disk
drive invented in 1956, all the

way to the mammoth 180 GB
hard disk drives available today,
there has been a 36,000-fold increase

St

(yes thirty-six thousand!) in storage
capacities over the last 50-odd years.
However, we are fast approaching
the physical limit for storing information
on media such as the magnetic platters of
hard disks or the chemical layers in opti-
cal devices such as CDs and DVDs. With
the promise of tomorrow's operating sys-
tems incorporating stunning graphical
interfaces that offer truly immersive
virtual reality and next generation
games that will blur the line
between fiction and reality, the
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demands of being able to quickly store
and retrieve enormous quantities of data
are ever increasing.

Scientists are now exploring hitherto
uncharted territories, delving into
advanced sciences such as holography,
nanotechnology and advanced lasers. The
implementation of these technologies
will result in an increase in storage capac-
ities, which is equivalent to what we've
seen over the last few decades!

Research in these fields has created
storage solutions such as holographic stor-
age, blue laser and Millipede—each offer-
ing digital storage densities that are orders
of magnitude greater than anything we
know and use today. Even though devices
that use these technologies are still on the
outskirts of implementation, they are
slowly and surely advancing down the
road to commercial availability. The
implications of what these technologies
promise us is as dramatic as when we com-
pare any of the commercially available
gigabyte solutions today with the clunky
sub-10 MB storage devices that were first
used in computing!

Holographic storage

Consider the maximum data storage lim-
its we have reached today: 15.9 GB on a
double-layer, double-sided DVD? 180 GB
on the largest hard disks? Think about a
system that can store about a terabyte of
information (that’s over 1,500 CDs!) on a
crystal the size of a sugar cube! Sounds like
science fiction? Today, this is closer than
ever to science fact! Holographic storage is
a breakthrough technology that literally
goes beneath the surface of the media and
stores information within its volume. Cur-
rent generation storage media store digital
information on layers of platters either
magnetically or optically. Holographic
storage utilises the space within special
types of crystals with optical characteris-
tics, which are very similar to those used
to create 3D holograms (the kind that you
find in holographic stickers or on some
product packages). Even though holo-

= technology next

Inside a Holographic Data
Storage System

In this simplified representation of a Holo-
graphic Data Storage System, the main
component is a blue-green Argon laser,
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which is split into two separate beams
through a beam splitter. The first beam
(object/signal beam) goes straight and pass-
es through a special device called a Spatial
Light Modulator (SLM), which is very much
like a conventional LCD. This screen is fed
with a page of binary data, which shows up
as clear and dark boxes. When the signal
beam passes through this device, it picks up
this page of information. The resulting
image is precisely focussed through a series
of lenses on an area in the light-sensitive
recording material, which is made of lithi-

graphic storage has been around for over
a decade now, giants in the field of tech-
nology such as IBM, Lucent and Rockwell
are just beginning to make serious break-
throughs with this technology. Holo-
graphic storage incorporates the use of
lasers, optics, image sensors and special
crystals that respond to laser light.
Besides the astounding amount of
data that can be stored using this tech-
nology, there are other inherent advan-
tages that holographic storage offers. The

um-niobate crystal. To record the informa-
tion, a second laser beam (the reference
beam) is focussed on the exact same spot as
the object beam that contains the data.
When both these lasers meet inside the crys-
tal, a phenomenon called interference
occurs and an image of the data is created
within the crystal in the form of a hologram.
To read back this page of information,
the reference beam needs to be focused at
exactly the same location as it was when the
hologram was first created to store the data.
The hologram of the data inside the crystal
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diffracts this laser and the resulting page is
projected onto a CCD (charge coupled
device) sensor, much like the sensors used in
digital cameras. The binary information can
now be read from this CCD and the origi-
nally stored data is retrieved.

main advantage is the speed of retrieving
the data—such systems will be able to
retrieve data in tens of microseconds as
compared to a data access time of almost
10 milliseconds offered by the fastest hard
disks today. By the time they are com-
mercially available, scientists say holo-
graphic systems could transfer an entire
DVD movie in under 30 seconds! Anoth-
er very important advantage is that of
information search and retrieval. Consid-
er the case of large databases that are
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stored on hard disks today. To retrieve a
piece of information, you first provide
some reference data (say, a keyword), the
data is then searched for by its address,
track, sector and so on, after which it is
compared with the reference data. In
holographic storage, entire pages can be
retrieved, where the contents of two or
more pages can be compared optically
(light patterns are compared) without
having to retrieve the information con-
tained in them. Imagine what this would
imply in the field of data mining and
warehousing—massive sets of data values
can be compared in fractions of a second!
While this technology points to an
almost utopian era for storage, there are a
number of roadblocks that need to be
overcome before you can buy a 1 terabyte
holographic crystal from your local hard-
ware store. The success of holographic
storage lies in the ability to accurately
focus the reference laser on the exact posi-
tion within the crystal to retrieve that
page of information (see box, ‘Inside a
Holographic Data Storage System’). You
would be unable to locate the data if
there’s an error of even a thousandth of
an inch. Also, the crystals used in the fab-
rication of the storage element need to
exhibit very exacting optical characteris-
tics to store the data correctly and there
are very few substances that adequately
and economically meet these needs. The
good news is that scientists indicate that
holographic storage systems should be
available in the next five years and they
would debut with capacities of about 125
GB with a data transfer rate of 40 MBps.

Millipede

Flashback to 110 years ago to the age of
the punch cards. This was the first device
that could be used to store digital infor-
mation. It was based on a very simple prin-
ciple of indentations on cards that were
read by a machine and translated into Os
and 1s. Fast forward to today. IBM has
recently developed a very similar system
but has scaled it down to extremely small
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dimensions, almost bordering
on the realm of atoms! Known
as Millipede, this technology is
theoretically capable of storing
information equivalent to
about 25 million books in an
area the size of a postage stamp!
(See box, ‘The Operational Con-
cept behind Millipede’.)

One of the most obvious
advantages with this technolo-
gy is the fact that very large
storage densities can be
achieved in very small areas.
Lower power consumption
makes it ideal for mobile appli-
cations such as handheld com-
puters and cellular phones—
your next generation cellular
phone would be able to hold a
gigabyte of multimedia content
and contact information! The
main hurdle that lies in the
path of commercialisation of
this technology is the fabrica-
tion of the controllers that go
into these chips.

Blue laser

Lasers have long been used in
the optical storage of digital
data. We see them in everything
from CD-ROM to DVD and
magneto-optical drives. Infor-
mation is stored in these devices
by encoding data into a stream
of Os and 1s in a spiral on the
surface of the media. The
amount of digital information
that can be stored on a single
layer of optical media depends
on two factors: the size of the
encoded bits on the media sur-
face and how close these bits are
packed onto the surface. The
density of these bits is directly

The Operational Concept
behind Millipede

The Millipede chip is created using an array of very
tiny cantilevers to create almost atomic-sized indenta-
tions in a plastic substrate that is used as the record-
ing material. This array works in a massively parallel
fashion where a bank of cantilevers access or create
information.
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Before a read or write operation, the polymer-based
medium, which is just about 50 nanometers thick, is
positioned beneath the cantilever array. This medium is
mounted on a magnetically driven scanner that can
move in three dimensions. During read-write, the
medium is moved by the cantilevers along the X-Y axis
while the cantilevers actuate and create indentations on
the recording surface. Using this process and with a sin-
gle cantilever design, researchers have managed to
achieve a storage density of an astounding 60 to 80 GB
per square centimetre. Also, this substrate can be
‘erased’ and data can be re-written onto it repeatedly.
This is achieved by momentarily heating the polymer to
a temperature of 150°C so that the surface is effectively
smoothened and ready for rewrite. However, individual
bits of information cannot be erased; only larger sec-
tions of the polymer surface can be cleared. The image
above also shows an actual electron microscope image
of one of the Millipede cantilevers. The tip of the can-
tilever head is about 50 Angstroms wide—that's just a
few atoms clustered together!

laﬂ laurnches

dictated by the wavelength of the laser
beam that reads them. The shorter the
wavelength of the light, the narrower is
the laser beam, and consequently the

introduoes the
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smaller can be the size of the bits of infor-
mation that are encoded on the disk (see
diagram, ‘DVD vs Blue Laser CD’).

As of now, the lasers used in CD and
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Battle of the Bits

Blue Laser

Holographic Storage

Millipede

Storage capacity 30 GB per layer per side Terabyte class 80 GB per square cm

Technology used 400 nm wavelength laser Optics and holography Nanotechnology

Data transfer speed Medium Very high High

Cost of implementation Relatively low High Medium

Time to implement 1-2 years 5-7 years 4-6 years

Applications Enhanced DVD applications Data mining and warehousing  Storage for mobile and portable
devices

Companies involved Hitachi, LG Electronics, Matsushita, Pioneer, IBM, Rockwell, Lucent IBM

Philips, Samsung, Sharp, Sony and
Thomson Multimedia

DVD-ROM drives have a wavelength
between 630 nm and 650 nm (1 nm =1
millionth of a millimetre), which puts
them in the red band of light. The reason
why blue lasers are so exciting is because
their wavelength lies in the 400 to 450
nm range. This shorter wavelength light
translates into disks written with blue
laser being capable of storing between 25
to 30 GB of data per layer per side! That
gives it five to six times the storage den-
sity of existing DVDs. Imagine having all
the Star Wars movies with full-blown sur-
round audio and crystal-clear video qual-
ity on a single disk with room to spare!
If it is simply a question of using
laser light with a smaller wavelength, you
might ask why this wasn’t done before.
The reason for this is that the materials
used to generate blue lasers have a rela-
tively shorter lifespan compared to those
used for red lasers. While blue lasers are
still in the research phase, there are three
types of methods that are used to gener-
ate these lasers:
Zinc Selenide (ZnSe): The initial
method for implementing blue lasers
involved the use of Zinc Selenide to fab-
ricate the diodes that generate blue lasers.
However, this material has a relatively
short lifespan and its power requirements
make it economically unsuitable for com-
mercial implementation. Also, these
lasers have wavelengths ranging from 460
to 520 nm, putting them at the end of the

1T PDEICC

blue and closer to the green light band of
the spectrum.

Gallium Nitride (GaN): This material
has proved to be very successful in the
creation of blue lasers and has generated
wavelengths as low as 370 nm with
relatively high reliability. Most of the
work in blue lasers today is based on this
material.
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The shorter wavelength of the blue laser
allows for more data than on a DVD

Second Harmonic Generation
lasers: These lasers are relatively new on
the blue laser scene but have exhibited
very high levels of reliability. Through
this intelligent method, the frequency of
a given laser is doubled (that is, the wave-
length is halved) and laser light within
the blue spectrum is generated. This is
done through an apparatus called a Dis-
tributed Bragg Reflector (DBR) where, for
example, the frequency of an infrared
laser with a wavelength of 850 nm is dou-
bled, resulting in a blue laser with a wave-
length of 425 nm.

It will be some time before blue laser
technology becomes commercially viable.
The major hindrance to this technology is
the cost of implementation. A Blue-ray
device available today would cost about
Rs 2 lakh! The second hurdle is that of
reliability: red lasers that are used in all
CD-ROM and DVD-ROM drives today
have a life cycle of about 10,000 hours.
Now compare that to the meagre hun-
dreds of hours that the Gallium Nitride-
based blue lasers last for using today’s
technology! However, it is just a matter
of time before these issues are addressed.
Scientists predict that in just a couple of
years nearly all new optical storage
devices would be based on blue lasers.

Looking ahead
While the very thought of the storage
capacity offered by these path-breaking
technologies is overwhelming, there will
soon come a time when we will think
nothing of being able to copy a 10 GB
computer game onto a terabyte-class stor-
age device. But this is going to take time.
All these technologies are still only limit-
ed to the confines of a handful of well-
guarded research laboratories. These
technologies will be available for mass con-
sumption only when the materials and the
technologies used to fabricate these mam-
moth storage systems become economi-
cally viable. fi]
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Philips 50PF9964 Plasma Display »»

Size does matter
Philips has created the ultimate display for those who
lust after larger-than-life movie experiences. This multi-
functional, flat panel, 50-inch wide-screen plasma video
display is the ideal companion for your DVD player. The
50PF9964 imparts clarity that blurs the line between
movies and reality. All right, so this giant screen does not
exactly fit on your desktop, but once you find a wall
large enough to accommodate it, brace yourself for the
ultimate home theatre experience.
Web site: www.philips.com

44 Sony DAV-S500 DVD Dream System

There goes the neighbourhood
The new DAV-S500 is an elegantly designed, full-fledged
home entertainment solution. It incorporates a DVD and CD
player along with CD-RW playback capability and 5.1 Dolby
Digital surround sound support. For those who expect noth-
ing but the best in their music, this is one of the few systems
that supports the new multi-channel Super Audio CD format.
With a power output of 200 watts RMS, be prepared to rock
your neighbourhood!
Fite .com

For the ultimate Hi-Fi experience, ; —

PRO FX Audio Equipment ' P e =
with technology from Denon. A g ' - :
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Sony DCR-PC5 Mini DV F+

pangycam CD-+CD-RICD-RW Recorder
Make yourself handy
Sony is taking digital video to new
extremes in portability with the introduc-
tion of its smallest Mini DV Handycam.
This new camcorder uses Sony’s Memory
Stick media, a high-performance Carl Zeiss
lens, a 2.5-inch SwivelScreen LCD Monitor
with Touchscreen controls and an ;
advanced InfoLithium battery that will . CORW1500 'i,_-@:'.e‘.-
help you make the most of your recording bt
time on the road. With an astounding
120x digital zoom and a CCD resolution of
0.4 megapixels, this camcorder brings all
the action up close and personal!
Web site: www.sony.com
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Beatnik DM2
Mix and scratch

The DM2 is an affordable, easy-to-use sound generation
device that allows music enthusiasts to create, perform and
publish their music from their PC. The only device of its
kind, it's a godsend for amateur digital DJs. It combines two
scratchable decks, a sampler, a cross-fader and an effects
box, all in one unit. With this little gizmo, you will be able
to create real-time club music mixes even if you don’t have
any turntable or studio experience.

A

A Alesis airFX
It's in the air

This intriguing musical toy lets you make smooth
flanges, crazy grooves and cool sound effects with-
out having to touch a thing. Connect the airFX to
any line-level sound source and speaker system and
then simply move your hands through an invisible
3D sphere above the device to manipulate the
sound in an infinite number of ways. The smallest
movement is captured by airFX’s onboard DSP to
generate a corresponding sound. With amazingly
intuitive usage, one moving part and 50 presets,
this effects processor is for musicians as well as the
tone deaf.

Web site: www.alesis.com
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HARDWAR

FREAK

ou must have come across them

at one point in time or another—

the shy, introverted type, with a

few opinions on the Ilatest
movies or the hippest serials, and a taste
in music that you find hard to digest.
They’ll rarely pose for a photograph or
show up at social events. But mention
technology in general or computers in
particular, and their face lights up. Some-
how they suddenly seem to come alive.
You've just encountered a technology
geek, or as they prefer to call themselves,
‘A Digital Guru’.

They are out there
“She was a thing of beauty, a joy to work

FEM 40

with. Thin, sleek and very easy on the
eyes... damn, I miss her!”, says Kinnar
Sanjanwala, an otherwise normal man,
about his Apple notebook. “It's bad
enough that my wife doesn’t understand
my passion, did she have to make me give
her away?” Err... her away? “I called her
[the notebook] Emily, from that Pink
Floyd song. It isn’t that strange you know.
We give names to things we cherish, kids,
pets...Heck! I know a guy who has named
his shoes! At least with an inanimate
object you don’t have to worry about get-
ting the name wrong.”

Guys like Kinnar are not an uncom-
mon breed; you will meet them in the
unlikeliest of places, doing the most

ILLUSTRAT EM: Iula hizsh Bankar

The latest Pentium processor,
the best gaming console, the
most expensive handheld are
what they crave. Let’'s meet
some people who only get out
of their beds because of their
lust for technology...

normal of things (Kinnar is a chartered
accountant). But once you get to know
them, it won't be too long before their
love for anything remotely related to
technology emerges. And even if you
can’t identify yourself with their passion,
it’s infectious and chances are, they'll pass
it on to you.

This ‘passion’, as Kinnar puts it, runs
deep—it gives them a foundation to
build their world upon and a feeling of
power. Remember the time you had to
call a friend because your PC was being
its essential self—a pain? Chances are,
your call for help sounded something
like, “Hey Mangesh, could you help me
out please, I think my computer hates
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me. | have some very important and
urgent work to finish, and the damn
thing refuses to start.” And Mangesh
being the almighty Hardware God (and
he knows it) would of course reply with
“Yeah, you know what? I'm watching
Farscape, and it would be great if you
could call back in an hours’ time, so
later, okay?” Of course you'll call back,
because you know that if anyone can
solve your problem, it’s him.

So how do these guys get into tech-
nology? Is there an induction ceremony
to be performed, complete with pacts that
have to be sealed with blood on full
moon nights? Chris, a self-confessed
hardware lover explains, “I'm not sure
how it all happened. It started out when
the family Hewlett-Packard P2400 was
acting up. I had to get a new mother-
board, then some RAM. I started research-
ing so that I could build the next PC from
scratch. From that point on I have just
been hooked on to hardware. At first, it
was only the desire to run the latest
games but later it grew into an all-con-
suming hobby.”

There is an evolution angle to it too,
as Chris adds: “Now I am more interested
in getting the most performance from
lower-end parts rather than buying the
best—this is much more fun and easier
on the wallet.”

Chris, all of 16 years of age, already
knows his SMPS from his SMTP. A gamer
at heart, is he able to balance his studies
and his passion? “I try not to place
studies too high. Since I plan on getting
a career in gaming, my game time
becomes my study time. But so far I have

j

and will be able to game all I want. So I
just keep thinking about that.” Does he
plan to move out and change cities? “I'm
trying to get into a college in the US, so I
guess that could be considered changing
cities.”

But riding the
hardware ride is an
expensive thrill. Every
six months or so, there
is something new on
the scene—a new
video card, a faster
processor, and if you
are into gadgets in gen-
eral, the temptations
are many and avenues
of escape, very few.
Being a 16-year-old,
what do his parents think about all this?
More importantly where does he get the
money from? “I am lucky. My dad likes
computers and uses them a lot so he does-
n’t mind the upgrade cycle; I don’t spend
money on much else, so most of it goes
into computers,” says Chris.

If it isn’t broken, tweak it
Overclocking is the art of running your
computer at speeds much faster than they
were meant to run. It’s akin to tuning the
engine of your car for better performance,
or replacing the engine altogether for that
my-Maruti-800-can-go-faster-than-your-
Ford-lkon bragging rights. Overclocking
falls into the much broader category of
modding (geek-speak for modification). It
is a process not without its risks, so why do
it? “Why? I wanted the best performance
for the lowest possible price. It is amazing
what one can do when limited to a

“ There have been a
few times when I've
neglected studies

But | have eventually
recovered ,’

Chris, Hardware Freak

done okay, although there have been a
few times when I have had a gaming
spree and neglected my studies.” So are
there times in his life when he would
rather be playing games than anything
else? “Well, sometimes I do feel like that,
but it’s not going to be for much longer.
I'll soon have my own PC and a house,

FEMm42

small amount of resources and a lot of
time.” Chris and modding are inseparable.
The only thing that comes close to his pas-
sion for modifications is an equally fervent
desire to overclock his PC.

For some people budget is not the
only reason. Take the case of Utkarsh
Dalmia. He is 19 years old, lives in a dif-
ferent part of the country, but talking to

4
Utkarsh Dalmia
HARDWARE FREAK

while on a gaming spree.

Utkarsh is like talking to a Chris clone—
they share the same love for hardware
and games, even their tastes in music
run similar, and both of them overclock
and modify their computers. Utkarsh
chips in: “It is the desire to experiment,

“ Power excites and just
having a powerful
system at my disposal
gives me immense
satisfaction ,’

to optimise. I want the best experience
possible from my computer, so when I
upgrade, it is always cutting edge. For
example, my next upgrade will be before
DOOMIII. Right now, no game can stress
my PC.”

So the driving force is the games
then? “Not really, sometimes it’s just for
the testosterone feed. Power excites and
just having a powerful system at my dis-
posal gives me immense satisfaction. It is
like zipping at high speeds in a Ferrari.”
But before we put this down as a need
for speed, at whatever cost, Utkarsh clar-
ifies, “It’s a balance between practicality
and desire—you can never have the
fastest computer for long. Newer stuff
releases every week, so buy what you can
afford and then tweak it to get the per-
formance you desire!”

Utkarsh also has a fairly elaborate
scheme to source his money: “I lived in
Singapore for about six months. You can
buy the latest hardware at half the price
you’d have to pay here. My dad has an
office there, and some old college friends;
so themodus operandi is that I do the price
search online, decide what I want, and
then import it to India”. And if you
thought that the custom duty would be a
killer, Utkarsh has that covered too:
“...just put it in a bag or two, no prob-
lem”! After six months or so, when it is
time to upgrade, Utkarsh sells his old
hardware in India at a premium; then
uses the net amount to fund his next
object of desire. It is a beautiful cycle that
works for Utkarsh. What about his nag-
ging parents? Any lectures on saving
money? “...lots of lectures, but I plan my
purchases at birthdays, or when I get
good grades. And basically, since I don’t
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Spot-a-Geek Contest

this quiz and find out!

rll John Carmack is...

a. The forward in the American soccer team
b. Just another guy named John

¢ The one true God

d. Not as pretty as Killcreek

a. My PC
b. My girlfriend
¢ You mean I’d have to leave my chair?

do you do?
a. Apologise with chocolates

¢ Say it with flowers

going to do with it?
a. Put it in the bank

¢. GefForce 4! Here | come!
d. Donate it to charity

you wear?
a. My best tuxedo/dress
b. My neighbour’s best tuxedo/dress

spend much of their cash (thanks to the
magic buy-sell cycle), they don’t mind”.

More than just computers

But hardware does not begin and end
with computers. There are other objects
of desire, ranging from cell phones, to
PDAs, MP3 players and game consoles.
If it is shiny and requires a power source
to run, you can bet these guys are inter-
ested. The case of Kinnar and Emily
comes to mind. Ask him about gadgets
though and his smile turns to an evil
grin, as he removes his Nokia 7650 cell-
phone. “Sexy isn’t she? I just got her. It
pays to have contacts! What I would
really like to own is Sharp’s Zaurus SL-
5000—it’s a PDA that runs Linux and
Java applications. It has a very neat key-
board that slides out. I think I saw an ad
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Are you a true blue techie, or just another wannabe? Take

er If you are stranded on a desert island, and allowed
only one possesion. What would it be?

d. My PC, my girlfriend, my fridge... (Help! | can’t count)
Q Your girlfriend caught you cheating on her, what

b. Ha, ha, that would never happen, I’'m too smart
d Ha, ha, that would never happen. Err... what's a girl?

(41 You've inherited lots of money! What are you

b. Buy that cell phone I've been dreaming about!

(51 So you are invited to a formal event. What would

¢ My black Gorillaz T-shirt and those torn jeans.
d. Hey I told you—I am not leaving this chair!

that offered the PDA
free with a Linux
development kit.
Since I want it bad
enough, I think I'll
buy the Kit, just to get
at the Zaurus.” Sur
prisingly, Kinnar isn’t
what you'd consider a
geek; he just likes col-
lecting shiny gadgets
and naming them!

Not all gadgets are
created equal, as Chris
points out: “MP3
players are pieces of
trash and a waste of
money. You need 128
MB of RAM just to get
an hour of good qual-
ity music on one of
those. If I ever buy a
compressed portable
audio player it would
have to be a Mini
Disk. Right now I
have a Sony Discman
which does all I need
it to do.” And since he
is a certified gamer, a
console can’t be far
behind: “I considered
a Nintendo Gameboy
Advance (a handheld
gaming console) but
once I actually got to
try one out, I dropped
the idea—it wasn’t
very comfortable with
the small buttons
seated so close to each
other. The other consoles I have owned
are the Nintendo Entertainment System,
Sega Genesis, Sony PSOne and Ninten-
do Gameboy.” But monetary problems
forced Chris to make some sacrifices:
“Right now I only have a Sega Dream-
cast. I had to sell the others.”

The conversation slowly tilts towards
modding. “I have been considering a
Dreamcast mod, but never got around to
completing it. I wanted to shift the guts
into a wooden case and put a 120 mm fan
on the back. I opened it up and checked
out the insides, the idea is quite possible,”
says Chris. One can only shake one’s head
in disbelief.

Utkarsh shares the console passion
with Chris—he owns a Nintendo 64, a
Sega Dreamcast, a Sony PlayStation 2 and
more peripherals than you can shake a

stick at. He is also quite sad: “I had
planned to go to my friend’s place and
check out the Xbox, but he bailed out on
me. I really wanted to check it out.” With
the next generation of consoles raining
down upon the gaming masses, lines
have been drawn between the supporters
and the opposition, and fights on the
scale of Mahabharata, are not unheard of.

At the end of the day what will this fer-
vour get them? The fact is that a gadget
freak, by definition, knows the inner work-
ings of his latest procurement—the theory
behind its working and even the industri-
al trends that will dictate where his pas-
sion will take him six months from now. If
tempered with the right professional train-
ing, a technology guru can go very far in
this digital world. They make great engi-
neers, professional technical help
providers and assemblers. They can even
work in the game development sector or
teach at IT training centres. The avenues
are limited only by their imagination.

So there you have them ladies and
gentlemen—a race of individuals who set
alarms on their gaming consoles, a breed
that eats technology information over
breakfast and laughs in the face of hard-
ware problems. They are out there, trad-
ing in the latest gadgets that most of us
can only dream of getting our hands on,
let alone owning them. They will laugh
at you, they will help you out, they will
bug you with facts and figures on the ris-
ing trend of mobile handsets, and they
will constantly surprise you with the
amount of money that they spend on
satiating their passion. Are you one of
them? Stand up and be counted.f]

AHMED SHAIKH

SCOREBOARD

Question a b crilld

1 FOuLnSinitise 20
2 E5Y L2050
3 10 15 5 20
4 L5 iSa 20255
5 5 10 15 20

20-40: You poor thing, you need help dialling
a telephone.

40-55: Okay, so you can tell a cell phone
from a PDA, but don't let it go to your head!
55-70: You think gadgets are cute, but only if
they come in different colours, preferably
polka-dotted.

70-100: You‘ve won yourself a life long sub-
scription to Digit. Send in your cheque for Rs
10,000 to...
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It looks good and the technology is glitzy, but does it do the job?

he Digital Media

Test & Research

Centre (DMTRC)

conducts a series
of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around
the world.

Comparison Tests

We use a dual rating system, the first of which is
applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc.

Weightages are then
applied to the various test
parameters according to
their  importance  for
that particular category of
products.

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

al @ )= P
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The Awards

Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each  comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.
This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived
taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar

The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating.

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows (»).

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

The 5-point Rating System used in Bazaar

(AN Excellent: a brilliant combination of price, performance and features—far
beyond expectations

»h ) Good: a good buy, better than most products in its category

»h ) Average: reasonably competent but nothing spectacular about the product

> Mediocre: does not live up to expectations, needs improvement in many areas

A Poor: has serious drawbacks and needs improvement before it can be

used for its target application
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In Test this Month

In our featured comparison
test we evaluate 23 flatbed
scanners across three price
brackets for applications
ranging from general home
use to full-blown profes-
sional imaging. Find out
which scanner is best
suited to your needs as we
torture these scanners
through our wide range of
speed and image-quality
tests.

Going in tandem with
the scanners test, we also
check out five OCR soft-
ware that will get you
closer to that dream of a
paperless office (or home).
With higher accuracy levels
and an ever-increasing
number of features, these
new-generation OCR soft-
ware can digitise all your
paper into searchable,
editable digital informa-
tion.

It’s taken a long while,
but the graphics chips
comparison test that
you’ve been waiting for all
these months is finally
here. You can now pur-
chase the right graphics
card for your needs, based
on our exhaustive compari-
son of the latest graphics
chips available in the
market. Also find out
whether the GeForce4 Ti
4600 deserves its drool
status among gamers
worldwide!

In our Bazaar section we
bring you the first-ever test
of some of the hottest
products and technologies
in the country. This month
we put the formidable Intel
Pentium 4 2.53 GHz
through a battery of
benchmarks and tell you
whether it lives up to all
the hype.
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Real pictu

We
test 23 scanners
across three price
categories to help you
choose the right scanner
for your needs

i (a

ngcanners

ou plug in a scanner, throw a photo onto the glass,

and push one button without even starting the

software and hey presto! It’s scanned! Scanners

have become so user-friendly that almost anybody

can use them. Plus, they are a great multipurpose

tool for the office and for professionals. From

putting images on the Web to digital data management, it’s all
possible.

Scanners are the link in our effort to digitise the analogue real

life that we live: the average person wants a colour scanner for
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photos, graphics or plain document scanning. A small to medi-
um business enterprise might be looking for a scanner that can
do fast black and white scanning which can later be OCR-ed into
editable text. Graphic artists or desktop publishers and profes-
sional imaging studios might be looking for an ultra high-end,
specialised, feature-packed photo scanner.

So how do you go about choosing a scanner? Is a 32-bit scan-
ner better than a 36-bit scanner? Obvious? What about resolu-
tion? Do you need 600 dpi (dots per inch) or will 300 dpi do
the trick? And what’s this stuff about optical resolution versus



interpolated resolution? Still obvious? What if we told you
that there are 11 scanners to choose from that cost just under
Rs 6,000?

Specifications, prices, features and a whole lot of mumbo
jumbo will only lead you to choices that are made out of confu-
sion. But worry not! We have tested 23 scanners in three cate-
gories split by price, and have come up with the best scanners
that you can choose from.

Digit Test Process

The scanners were categorised according to price as:
= Budget scanners: Up to Rs 6,000

= Mid range scanners: From Rs 6,001 to Rs 12,000

= High-end scanners: Rs 12,001 to Rs 20,000

The test system used to evaluate the scanners consisted of
a Pentium III (Tualatin) 1.2 GHz processor, 256 MB SDRAM
and a 40 GB, 7,200-rpm IBM Deskstar hard disk drive. Since the
performance of the scanners would be affected by the interface
it uses, we configured the parallel port to operate using the
ECP+EPP mode. Where the scanner offered two modes of inter-
facing with the PC, we used the faster interface for testing.
Hence, if the scanner supported Parallel and USB ports, we
used the USB port and for those with USB and SCSI ports,
we used SCSI. We used Photoshop 6.01 to evalute the scanned
images.

The operating system loaded was Windows 2000 Profession-
al with DirectX 8.1 on a cleanly formatted system and the image
of the drive with the operating system and all the basic drivers
were loaded using Norton Ghost. This image was then restored
after each scanner was tested so as to eliminate any interference
from previously loaded TWAIN drivers.

Test methodology

We evaluated the scanners on various parameters such as
features (30 per cent weightage), performance (40 per cent weigh-
tage), warranty and support (10 per cent weightage), and value
for money (20 per cent weightage).

Features: We awarded points depending on the features and
the capabilities of the scanners. These included the maximum
resolution supported, document scan area, colour depth, and
bundled accessories such as power adapters and interface cables.
We also evaluated the software bundled with the scanner for
basic image editing capabilities such as image scaling, colour
and gamma correction, effect filters, batch scanning, and net-
work scanning support. As beginners might be overwhelmed
with the plethora of features that modern scanners offer, we
checked the quality of documentation and manuals shipped
with the scanners for quick setup instructions, a troubleshoot-
ing guide and after-sales support and contact information.
This parameter was given a 30 per cent weightage in the over-
all score.

Performance: Each scanner was subjected to a range of tests
that evaluated their performance on three basic criteria: scan-
ning speed, quality and the ability to capture high-quality
images. This parameter was given a 40 per cent weightage.

a) Scanning Speed: We scanned a text document and a colour
photo in various modes at a constant 300 dpi. We scanned the
text document in black and white mode and the photo was pre-
scanned and then completely rescanned in true colour and
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greyscale modes. The time taken to scan in each mode was noted
using a stopwatch.
b) Image Quality: This consisted of two tests:

= The IT8 card test: An IT8 card was used to determine the
ability of a scanner to differentiate between dark, light and bright
coloured areas (tonal variation). The IT8 card has three distinct
areas (light, dark and bright), with three sub areas each. We took
readings of the standard deviation values (using Photoshop 6.01)
of the red, blue and
green channels of
these three areas
(including all the sub
areas) and compared

The IT8 card tests a
scanner’s ability to pick
up tonal variations in
dark, light and bright
areas of an image

them against a reference value. A higher tonal deviation score in
each zone indicates that the scanner can differentiate between
the varying tones in a much better fashion. To arrive at the final
score for each area, we took the average of all three readings for
each sub area. Hence, 27 readings were taken in all, which on
averaging came to nine different readings per area. We also meas-
ured the tonal deviations in greyscale mode by observing the
tonal deviation of the various bars in the lower block of the IT8
card. Here we noted the maximum number of bars the scanner
could distinctly identify.

= Photograph test: A spe-
cial glossy photograph was
scanned at the highest optical
resolution supported by the
scanner. We compared the
scanned image with the original
photo for colour, overall
smoothness of the image, realis-
tic glossy effect as present in the
original photograph, contrast,
crispness in detail, etc.
c) Resolution Test: To evalu-
ate the resolution of each scan-
ner we scanned a special
document consisting of five pat-
terned blocks in greyscale mode.

30 Ippi (120 ppi)
pr

The image u;ed for the photo
quality test

Each block contained closely
packed lines with increasing den-
sity. The resolution of a scanner is
judged by the number of distinct
readings it can take per inch in
each direction. Using Photoshop
6.01, we tried to select the indi-
vidual lines present in the blocks.
To differentiate between the
lines, we used the Magic Wand
tool in Photoshop.

70 Ippi (300 ppi)

140 Ippi (600 ppi)

The ability of the scanner to pick up
closely packed lines in each of these
blocks deteremines its resolution
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Selecting individual lines in the blocks indicates the clarity
with which the scanner can capture images. If Photoshop detects
a solid block instead of the constituent lines, it indicates that the
scanner cannot capture the finer details.

Warranty and support: Here we took into account the war-
ranty period for the scanners, the number of authorised service
centres appointed by the companies and the number of cities in
which authorised service centres are present. The information
was provided by the respective companies. The weightage allot-
ted to this category was 10 per cent.

Value for money: This is a factor of the performance and fea-
tures offered by the scanner as compared to its price. We com-
puted this value by dividing the sum of a scanner’s scores in the
performance and features tests by its price. The weightage allot-
ted to this category was 20 per cent.

How they fared

We found a wide variation in the performance and features
offered by the scanners in each category. It was also quite sur-
prising to note that some of the budget scanners actually out-per-
formed most mid range scanners, while the high-end scanners
were in a class of their own. What's obvious from our test results
is that you can find the right scanner for any need depending on
your budget.

Features

We looked for standard features such as the maximum resolution
and colour depth supported, time-saving features such as one-
touch scanning support, the bundled accessories and software
and the quality of documentation and manuals provided.

Resolution: We gave primacy to optical resolution over inter-
polated resolution, which is the actual resolution that a scan-

Scanning a Scanner

A scanner is a device that captures
and converts images and documents to a
digital format. It does so by using an array of
photosensitive cells that detect light reflect-
ed off or transmitted through the object
being scanned. This array of receptors,
referred to as a charge-coupled device
(CCD), measures light intensity and

An Inside View

[N

convert it into an electrical signal.

Lamp: This is usually a cold cathode fluo-
rescent lamp. It lights up the area to be
scanned with pure white light, which is

ner can support (this is a hardware limitation), but it can be
interpolated to a much higher value using software. In the
budget segment we found that all scanners supported at least
a 600x1200 dpi resolution with the exception of the Agfa Snap-
Scan 310P—it was the only scanner that offered a 300x600 dpi
resolution. The BenQ and Mustek scanners had the best driv-
ers—both supported a maximum interpolated resolution of
19200x19200 dpi.

Among the mid range scanners, the Umax scanners came out
tops—the Astra 4400 and 5400 were the only scanners in this
category to support an optical resolution of 1200x1200, but as
observed in the budget category, the BenQ ScanPrisa 640BT and
Mustek 1200ED had the highest interpolated resolution
(19200x19200 dpi) in this category as well.

In the high-end segment, the HP ScanJet 5400C and 5470C
supported a whopping 2400x2400 dpi optical resolution and infi-
nite interpolated resolution. This was reflected in the scanned
images, which were very crisp and realistic.

Interface: Almost every vendor in the budget segment has
switched over to the USB interface since it provides a faster scan-
ning speed and plug-and-play connectivity. The only exceptions
were Agfa SnapScan 310P and Canon CanoScan N640P. Surpris-
ingly no scanner supported the USB 2.0 interface.

The scenario was a little different for mid range scanners—
four of seven scanners tested supported the USB interface (BenQ
ScanPrisa 640BT, Microtek ScanMaker V6UPL, Umax Astra 4400
and Astra 5400). Agfa SnapScan 1212P and Mustek 1200ED were
the only scanners that used the older and slower parallel inter-
face, and Microtek ScanMaker X6EL was the only SCSI scanner
in this segment.

In the high-end segment, the Epson Perfection 1650 and
Umax Astra 4000U had only a USB interface. The two HP mod-
els also had a parallel interface, while Microtek ScanMaker
X12USL had a SCSI interface along with USB. The only short-

Glass plate: This is where the document is

placed. It is larger in size than the docu-

ment (A3, A4) it supports. The scan quality

depends a fair deal on the glass—if there is
dirt over or under the glass, the
scanned image will have artefacts and
smudges.

converts it into an electrical charge.

An analogue to digital converter
(ADC) is required to digitise the infor-
mation. Each cell in the CCD array then
creates one pixel and for each pixel a
certain number of bits is stored. The
more bits of information assigned to each
pixel, the better the image quality.

There are a few essential parts which go
in the making of the scanner. These are:
CCD: The Charge Coupled Device is the
heart of a scanner. It is made up of an array

of photo diodes, which sense the light and scanning.

it}

reflected back from the document and is
captured by the CCD.

Scan head: This is the area which holds
the CCD and the fluorescent lamp. The
head assembly is mounted on the stabiliser
bar, which moves from end-to-end while

Paper Lens/mirror: The mirror reflects the
O)Lieht ' light to the lens. There are usually
[Distieres two or three mirrors in a scanner. It is
(Diwrm very critical for the placement of the
E:TF; mirror and the lens to be accurate so

that all the light is concentrated on

the CCD—otherwise some areas of
the scanned image will be cut.
Stepper motor: The CCD, lamp, mirror
and lens are all placed on the same head
assembly. This assembly is moved by the
stepper motor which takes its control sig-
nal from the circuitry placed at the bot-
tom of the scanner.
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coming for a SCSI scanner is its
immobility from one machine to
another, as it requires the PC to
have a SCSI adapter.

Colour depth: As a rule, if you
An Automatic Document Feeder ~ plan on getting a scanner for slides,
lets you feed a stack of pages negatives or transparencies, you
for scanning without having to need at least 30-bit colour depth,
manually place each page in though 36-bit would be preferable.
the scanner But if you intend to scan high res-

olution photographs then nothing
less than 48-bit for colour and 16-bit for greyscale should do. Also
make sure that the scanner supports upwards of 1200x1200 dpi
resolutions.

Most of the scanners in the budget segment offered 48-bit
colour depth. The exceptions were the Microtek ScanMaker 3730,
Canon CanoScan D646U and CanoScan N640P (42-bit each) and
the Agfa SnapScan 310P (30-bit). In the mid range section, all the
scanners offered 36-bit or more colour depth, except the Mustek
1200ED, which offered a paltry colour depth of 30-bit. Microtek
ScanMaker X12USL offered a bit depth of 42 bits, while the others
in the high-end segment had a colour depth of 48 bits.

Ease of use: Features like Scan-to-Web, Fax, Email, Print and Copy
allow even novice users to scan images without difficulty, as details
regarding resolution and colour depth are handled by the TWAIN
driver. For example, if you need a scanned image to be sent across
to your sister in the US, you just press the Scan-to-Web button and
the scanner scans at the resolution best suited for transferring it
across the Net.

We found such features missing in many of the budget scanners.
For example, the Agfa SnapScan 310P, the BenQ SW2 3300U and
SW2 5000E, the Canon series and the Umax AstraSlim had no such
buttons on them. The best of the lot here were the Microtek Scan-
Maker 3800 and the Mustek BearPaw 1200CU, which had all of
these buttons.

In the mid range segment, the BenQ ScanPrisa 640BT and the
Umax scanners had three buttons on their panel. No other manu-
facturer in this segment provided such easy-to-use buttons on their
front panel.

Both HP scanners were clearly a step above the rest in the high-
end category. The HP scanners had the four standard buttons for
Copy, Email, Fax and Print plus you can also adjust brightness and
contrast on the scanner.

Miscellaneous features and bundled accessories: Trans-
parency adapters for scanning films and transparencies add greater
functionality but also add to the cost of the scanner. Built-in trans-
parency adapters were only available
in three of the 23 scanners tested and
that too only in the mid and high-
end segment. In the mid range, the
BenQ ScanPrisa 640BT was the only
one with a bundled transparency
adapter with support for 35 mm
films, while the Umax Astra 4400 and
Microtek X6EL had optional device
connectors. Among the high-end  With a Transparency Adapter
scanners, Epson Perfection 1650  you can scan negatives,
Photo had integrated transparency slides, and transparencies
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Jargon Buster

Artefacts and noise: Marks and
smudges picked up in the course of
scanning or data transfer that do not corre-
spond to the original document. Artefacts
might include pixellation, dotted lines, reg-
ularly repeated patterns, moiré, etc.
Batch scanning: Some scanners can auto-
matically recognise several images placed
on it and save them as separate files. Also,
an automatic document feeder can be
used to send pages one at a time to be
scanned, saving a lot of time.
Bit depth: The scanner stores a certain
number of bits of data for each pixel in an
image: 1 bit represents two colours (black
and white). Similarly, 2 bits represent four
colours—black, two shades of grey and
white. The higher the number of bits
devoted for this (bit depth), the better the
scanner is at distinguishing between really
close shades of the same colour. This
results in better image quality.
Contrast: Contrast determines the gap
between the darkest shade and lightest
shade (in effect the number of shades actu-
ally used in an image). An image with low
contrast tends to look lifeless and flat.
CCD array: Known as Charge Coupled
Device array, this is a set of light-sensitive
diodes used in scanners and digital

cameras. |t sweeps across a document dur
ing capture and, when exposed to light,
generates a series of digital signals that are
converted into pixel values.

Halftone: Most printing processes are not
capable of printing continuous tone images.
Hence, dots of varying size or density are
used to give the impression of grey areas in
a greyscale image.

Histogram: An imaging tool that shows
how pixels are distributed by tonal value in
an image. Each
grey level in a
greyscale image
has a vertical line

that shows the
number of pixels.
Usually, a his-
The histogram function togram shows low
in Photoshop values (dark parts

of the images) on
the left, climbing to the highest and lightest
on the right. A histogram is a useful method
for checking that you have a good scan,
with a full range of colours.
Hue and saturation: The aspect of colour
that distinguishes it from another colour
(what makes a colour red or green or blue).
Hue is distinct from saturation, which
measures the intensity of the hue (more

red, more green, etc).

Midtones: An image is logically divided
into highlights (bright areas), midtones
(medium-bright areas) and shadows (dark
areas). If converted to greyscale, midtones
correspond to 50 per cent grey.
Resolution: The resolution, measured in
dots or pixels per inch (dpi or ppi), defines
the ability of an imaging device to capture
or display individual dots or picture ele-
ments (pixels). There are two types of res-
olution: optical and interpolated, of which
the first is more important. More pixels
mean better resolution and sharper image
quality. The resolution can be increased to
capture finer details, but after a point,
added resolution will not result in an
appreciable gain in image quality but only
results in a larger file size.

Tonal range: Also called the dynamic
range or the optical density (OD) of a scan-
ner, it is a measure of how well the scanner
can capture the gradations from bright
highlights to dark shadows in an image.
TWAIN: It is a software industry standard
that allows TWAIN-compliant applications
and scanners to communicate. It allows
the scanner to be accessed from within
another program, for example an image
editing or DTP application.

adapters for both 35 mm and wide format films, used largely by
professionals. HP ScanJet 5400C only had the interface for attach-
ing the adapter, whereas its elder sibling the HP ScanJet 5470C
had the adapter too.

Power saving is another critical feature—if the CCF (cold cath-
ode fluorescent) tube is not in use for a specified period, the scan-

ner shuts off automatically. This not only saves
power but also enhances the life of the
CCF. In the Budget range, only
three scanners—BenQ SW2
4300U, SW2 5000E and
Umax AstraSlim 600—
had this feature.
i Among the mid
range scanners, only
Agfa SnapScan 1212P
and Mustek 1200ED did
not have provision for
power saving, while all
the scanners in the high-
end category possessed
power saving features.

A transport lock pro-
tects the scanner from damage during transporting. In the budg-
et range all three BenQ scanners, the two Canon scanners and the
Microtek ScanMaker 3800 had the transport lock feature. In the
mid range, the transport lock feature was available only in two

Epson Perfection 1650 Photo offers the
maximum number of features from one-
touch controls to excellent bundled soft-
ware and even a transparency adapter
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models—BenQ ScanPrisa 640BT and Microtek Scanmaker X6EL.
Among high-end scanners, the transport lock was missing only
in the Umax Astra 4000U.

A removable lid becomes an important consideration if you
need to scan images from thick magazines or books, as its absence
would adversely affect the quality of the scanned images. Among
the budget scanners, only the Microtek ScanMaker 3800 and
3730 sported this feature. In the mid range segment again only
the Microtek series and the Umax Astra 5400 supported the
removable lid feature. In the high-end segment, all five scanners
had support for removable lids—not surprising as these scanners
are used by professionals who need to scan from a variety of
source documents.

Overall: In the budget category, Microtek Scanmaker 3800 came
out to be the clear winner with an aggregate of 18 points, edg-
ing out its nearest rival, the BenQ 4300U. Canon CanoScan
D646U had the lowest score for features here, managing only
10.75 points, mainly because its driver did not support a major-
ity of the functions for image enhancement, nor did it have one-
touch control buttons for easier scanning.

In the mid range segment, Microtek’s ScanMaker X6EL
scraped in as a winner with just one point more than its near-
est rivals, BenQ ScanPrisa 640BT and Umax Astra 5400. It
scored higher mainly because of its support for legal paper
size—a feature which will be appreciated by lawyers and
tax consultants. The Mustek 1200ED could only manage
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9.25, which was incidentally also the lowest score across all
categories.

In the high-end segment, the Epson Perfection 1650 came out
the winner with a score of 24.5 points, which is over 4 points
higher than its nearest competitor, HP ScanJet 5470. The Perfec-
tion 1650 is feature-rich, has a detailed user manual as well as a
detailed troubleshooting guide. The only two mising features are
support for batch scanning and network scanning. The Umax
Astra 4000U scored a decent 19.5, but even though it supported
network and batch scanning—features that are not common—it
fell short as its TWAIN driver didn’t offer too many enhanced
imaging features.

Performance

A scanner’s performance is judged by the quality of the image and
the speed at which it is capable of scanning. Whether you should
consider speed or quality when buying a scanner will depend on
how you plan to use it. If you need to scan in large volumes, the
speed should rate higher, but if you need scans for presentations,
professional level imaging or printing, the quality of the image is
more critical. In fact, if a scanner gives you great quality, you can
consider compromising a little on speed.

Black and white scan speed: On an average, we found that
most budget scanners took about 30 seconds to scan a black and
white text document. The scanner that really stood out here was
the Microtek ScanMaker 3800, finishing the scan in a blazing
9 seconds! No other scanner came even close to breaking the 20-
second barrier in the budget range. The closest that came to it were
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the Microtek ScanMaker 3630 and the Agfa SnapScan 310P—both
finished the scan in just under 25 seconds. The slower ones, except
for the Canon series of scanners, took between 25 to 30 seconds,
which is quite tolerable. The Canon CanoScan N640P was by far
the slowest in the entire comparison test—it took over a minute (65
seconds) to finish scanning the document. We ran the test several
times but got the same result each time.

One would expect the scanning speeds to improve as you move
up the price ladder, but this was not the case. Also, scanning black
and white documents at 300 dpi should hardly tax a scanner,
regardless of whether the scanner has a SCSI, USB or parallel inter-
face—there is hardly enough data to put the interface, scanning
engine or the TWAIN driver under any pressure. This fact was
brought home in the mid range section: Agfa SnapScan 1212P,
which uses a parallel interface, finished scanning the document in
just under 14 seconds. On the other hand, Microtek ScanMaker
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Speed Tests

Comparing scanner speeds is tricky as the
speed of scanning depends on the speed
of the scan engine and some of it depends
on the scanner’ s interface with the PC.
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X6EL, which is basically a SCSI scanner, took all of 41 seconds. The
slowest scanner here was the Umax Astra 5400, a USB scanner; it
took almost 46 seconds to scan the simple black and white docu-
ment!

ScanMaker X12USL from Microtek took top honours in the
high-end segment. It uses a SCSI interface and finished scanning
the document in a neat 18 seconds. It was followed closely by the
HP ScanJet 5470C, a USB scanner, which took a decent 19 sec-
onds to scan the document. The rest took over 25 seconds, with
the Umax Astra 4000U being the slowest—it took 37 seconds to
finish the test.

So if you have tonnes of documents to scan, there is only one
choice—the Microtek ScanMaker 3800. By the time you pick up
the next page to scan, you will have the previous document
scanned and ready to use!

Colour photo prescan speed: Most people preview a full pho-
tograph, crop it, select the areas they want and then scan it. This
makes the time taken to preview very important, especially if you
scan a truckload of photographs and graphically intensive doc-
uments. The scores in this test were quite varied and the preview
times ranged from under 10 seconds to about 30-odd seconds.
Ideally, a 10 second preview is what you should look for when
scanning a photograph.

Most of the budget scanners took less than 20 seconds to
preview. The Microtek ScanMaker 3800 performed well in this
test too, taking 9 seconds to preview the photograph, but was
surprisingly beaten by the Agfa SnapScan 310P, which came
out with top honours here, taking 8 seconds to preview the
photograph.

The scanners in the mid range segment were quite sluggish—
not one scanner could break the 10 second barrier. The best times
were logged by BenQ ScanPrisa 640BT (12 seconds) and the Umax
Astra 4400 (13 seconds). The Microtek ScanMaker V6UPL was the
slowest here, taking 32 seconds to finish the preview.

The high-end scanners got to show off their mettle in this
test—the HP Scanjet 5470C and ScanJet 5400C finished the
photo preview in 8 seconds flat. The slowest scanner here was the
Umax Astra 4000U at a disappointing 25 seconds.

Colour photo scan speed: This is where speed really counts.
Scanning full colour documents or photographs can really put
the scanner, its interface and the TWAIN driver under severe
stress. Besides, as most users buy a scanner to scan photographs,
the time taken for this test becomes an important consideration.
We scanned a colour photograph at 300 dpi, and under ideal
circumstances it should take not more than
40-odd seconds (multiplier of 4 on the
preview time) to complete this test,
but, on an average, we found
the scanners taking about a
minute.
A scanner with a
faster interface such as
SCSI or USB should be
faster. This was clearly evi-
dent in the budget segment
where the USB scanner
from Canon (the CanoScan
D646U) was significantly
faster than its parallel port

Microtek ScanMaker X12USL offers

blazing fast colour photo scanning
speeds—our test photograph was
scanned in an amazing 19 seconds!
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sibling, the Canon CanoScan N640P. The N640P took nearly
200 seconds (3 minutes 20 seconds) to scan the photograph,
while the D646U took only 56 seconds, making it nearly three-
and-a-half times as fast! For heavy scanning, a parallel interface
truly becomes a bottleneck. The USB scanners on the other
hand consistently logged a time of around 60 seconds. The
Microtek ScanMaker 3730 was the fastest here, taking just 42
seconds to scan the colour photo. In fact, all the Microtek
entries in the budget segment performed exceptionally well,
taking around 40-45 seconds. The slowest USB scanner here was
the Umax AstraSlim 600—it took over a minute-and-a-half to
complete the test.

Once again, the scanners represented in the mid range seg-
ment did not live up to their price points. They were much slow-
er than the budget ‘speedos’ and only the Microtek ScanMaker
X6EL, a SCSI scanner, showed some promise by finishing the
scan in 45 seconds. The rest turtled in at over a minute at an
average.

The high-end segment proved to be quite exciting, with the
photo being scanned at warp speeds! The Microtek ScanMaker
X12USL was a true speed demon taking just 19 seconds to scan
the photograph! The Microtek scanners performed well in the
speed tests across segments, but this one truly takes the cake.
With such scanning speed, you needn’t even preview the pho-
tograph before scanning! Almost all the scanners finished the
scanning in under our 40 second speed limit in this test, except
for the Umax Astra 4000U which was surprisingly slow and took
over a minute to scan the photograph.

This is the first time we’ve seen a test segment being com-
pletely dominated by a brand. Microtek seems to have gotten all
the elements right when it comes to high speed scanning. Their
scanners proved to be unbeatable across categories and are high-
ly recommended for bulk scanning.

IT8 card test: Tonal quality is measured on a logarithmic
(exponential) scale ranging from pure white to pure black. The
tonal range is the difference between the darkest and the bright-
est optical densities (shades) a scanner can capture. The bigger
the difference, the larger the dynamic range of the shades it
can capture and hence better the scanner’s image reproduction
ability. The ability of a scanner to detect a wider tonal range is
inherent in its hardware. A scanner that can detect sublime
tonal variations needs to be built solidly from the bottom
up. No amount of driver tweaking will make up for any build
quality flaws.
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Smooth Scanning Tips

= Selecting scanning area: Always preview the docu-
ment and select just the area to be scanned, instead of scan-
ning the full document. This will reduce the scanning time as well
as the file size, especially when scanning at high resolutions.
= Resist scanning at high resolutions: If you intend to scan your
documents only to view them onscreen, scanning at a resolution
between 100-150 dpi is enough as monitors can only display 72
dots per inch (dpi). Scanning documents at higher resolutions will
only result in a larger file size. If you are scanning a document for
faxing or OCR-ing, 200-300 dpi is sufficient and for printing pho-
tos, 300-600 dpi is fine. For photo scanning, keep the setting at
the maximum colour depth that your scanner supports.
= Use Descreen: When you scan content from magazines or
newspapers, you will notice a lot of moiré (converging and
diverging lines) on the scanned image. The best way to reduce
this pattern is to use the Descreen option in the scanner software.
If your scanner software does not have a Descreen option, you
can use an image editing software.
= Image format: Select an image format depending on where
you will be using the image. If you will be using it for the Web or
for animation, save it in JPEG or GIF—these compressed formats
save a lot of hard disk space. On the other hand, if you are scan-
ning the image for print, TIFF is the best format as it compresses
the image without loss in image quality.
= Correct ghost images: A ghost image occurs when the scanner
picks up images from the back of the page. This can usually be
corrected by changing the darkness and contrast settings. Experi-
ment to find the best settings for your scanner. Another simple
way to correct this is to place a thick white paper over the docu-
ment being scanned.
= Adjust brightness, contrast and sharpness: Many a times the
scanned image turns out to be dull. This can be easily fixed
through the TWAIN driver (if your scanner supports it) or through
the image editing software where you can adjust the contrast and
brightness levels.

In the greyscale tonal deviation test, there are 22 distinctly
shaded bars. The last four bars have very minor differences in
shade, and it is a big feat for a scanner to pick up these differences.
Hence, a score of 18 should be considered quite acceptable, where-
as a score of 20 and above would be exceptional. In the colour
tonal deviation test, a combined weighted score of about 4 points
out of 10 for the dark, mid and light zones should be considered
acceptable. The variations in colour in the dark and the mid zones
are relatively easy to achieve but most scanners cannot pick up the
variations in the light coloured areas. Here, if a scanner scores more
than 5 points, it means that it has decent capabilities to capture
tonal variations. It is rare to find a scanner that can manage all
three zones without trouble—such scanners will achieve a com-
bined weighted score of over 6 points.

In the greyscale tonal deviation test, all the scanners in the
budget segment detected at least 18 of the 22 shades. The Microtek
ScanMaker 3800 detected 21 bars. No other scanner in this category
could match that score, but the Agfa SnapScan 310P, Canon
CanoScan N640P and the Microtek ScanMaker 3630 did manage
to detect 20 bars each. In the colour deviation test, most budget
scanners crossed 4 points. Only the Canon CanoScan N640P and
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Colour Tonal Deviation ITS Card Test (Scale of 10}
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the Microtek ScanMaker 3800 could go beyond 5—they scored
5.26 and 5.13 respectively.

The mid range segment proved to be a mixed bag. While the
Mustek 1200ED and the Microtek ScanMaker X6EL scored below
18 in the greyscale deviation test (17 and 16 respectively), the rest
detected more than 18 bars. The Agfa SnapScan 1212P, Microtek
ScanMaker V6UPL and Umax Astra 4400 scored 21 each. These
three scanners did well in the colour deviation test too, scoring
over 5 points. Surprisingly, the Umax Astra 5400 took top hon-
ours in the colour deviation test, scoring a healthy 5.91. The Astra
5400 has been quite an underperforming scanner, with its
younger sibling, the Umax Astra 4400, trouncing it in almost all
the performance tests.

All the scanners in the high-end segment detected over 20
bars in the greyscale tonal deviation test. The HP ScanJet 5470C
and the Microtek ScanMaker X12USL stood out by detecting 21
bars each. But the colour deviation test was where these big boys

Scanner Calibration

got to show their real muscle. Scoring 5 was not a problem for
these scanners, but the real champions were the HP Scan]et series
of scanners—the 5400C and the 5470C scored an impressive 8.01
each. A scanner that can replicate such sublime variations in
tone as seen on an IT8 card speaks a lot about the quality of its
scan engine.

Colour photo scan quality: This is a test where bit depth mat-
ters the most. You need a minimum bit depth of 24 bits for
decent image quality. A certain loss or distortion of information
is inherent in the scanning process. This is commonly referred
to as noise or artefacting. In reality, artefacting cuts a standard
24-bit depth to around 16, which directly decreases the num-
ber of colours represented and hence the quality of the scanned
image suffers.

The technically inclined may wonder that a monitor can
display only 24 bits of colour data, so what happens to a 48-bit
scan? Well, the answer is simple: with more information in each
pixel, the image has smoother colour gradations and a much
improved overall image colour reproduction.

The quality of the scanned photo in the budget scanners was
pretty average. This could be directly attributed to the lower
resolutions that these scanners support. A score of 5 out of 10
should be considered fairly average. The highlights and shad-
ows of the photo were more subdued and one could distinctly
observe jagged edges in parts of the image. Artefacting was also
fairly pronounced—we found about five to eight white patch-
es (artefacts) with these scanners. The best scores were logged
by the Agfa SnapScan 310P and the Mustek BearPaw 1200CU
(6.79 points each). Their scanned images had almost zero arte-
facting, the colours were smooth and the edges sharp. The Agfa
SnapScan 310P scores are quite astonishing—this scanner has

Colour calibrating your scanner can
go a long way towards ensuring that
what you scan, what you see on screen
and what you print look the same.
Basic visual calibration: The first step is to
calibrate your monitor. The next step is to
scan something and make adjustments
using a gamma correction tool like Adobe
Gamma until the colours on the scanned
image on your
monitor and
the actual
IS photograph
match.
s Use any
high-quality
photographic
image with a
= wide range of
EgT tonal values.
- Ensure that
before scan-
ning, all auto-
matic colour

Fissinne temere L |

'3 Qe Wl

Adjust gamma settings for
optimal colour matching
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correction is turned off. After scanning,
adjust the controls from within your scan-
ning software and rescan until what you
scan matches your monitor display. Note
all adjustments and save them as a profile
for future use.

Colour calibration with ICC profiles: ICC
profiles provide a more thorough way to
ensure consistent colour. These files are
specific to each device on your system and
contain information about how that device
produces colour. If your scanner comes
with a pre-made colour profile for your
scanner model, use it—it may give better
results than manual calibration.

Colour calibration using an IT8 card: Cal-
ibration or profiling software may come
with an IT8 scanner target—a printed card
that includes photographic images,
greyscale bars and different colour bars.
Different manufacturers have their own IT8
cards, but they all generally conform to
the same standard for colour representa-
tion. The IT8 card requires a digital refer-

ence file (colour profile) specific to that
image. However, some scanners come
with pre-defined profiles; in order to accu-
rately calibrate your scanner you will
require profiling software that comes bun-
dled with the IT8 card.

First scan the IT8 card. The scanned
image will be an RGB image; change it to
Lab colour (this can be done using a cali
bration software such as Color Blind
Matchbox). Now compare the lab values
of the scanned patches on the IT8 card
with the values in the digital reference file
of the IT8 card. The software can now cal
culate your input system’s colour error for
each patch. The software will use this
information to build a corrective colour
table. This table and its supporting infor-
mation can be saved as a colour profile.

Preferably, calibrate your scanner every
month, depending on how much you use
your scanner. If you make changes to your
software or hardware, it may be necessary
to re-calibrate.
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arated colour scan depth of 30 bits and a greyscale scan depth of
10 bits, but it beats scanners rated at 48 bits!

In the mid range segment, the Microtek ScanMaker V6UPL
scored an amazing 7.86 followed closely by the Umax Astra 4400,
which scored a nifty 7.50. The Umax Astra 4400 unlike its sibling,
the Umax Astra 5400, has consistently shown better perform-
ance—it’s a little slow in scanning speeds, but is up there with the
best when it comes to scan quality.

Scores of 8 out of 10 were quite common in the high-end seg-
ment with crisp reproduction of colours, sharp rendition of edges
and excellent contrast. The HP ScanJet 5470C and Microtek
X12USL scored an impressive 8.93 each—the scanned images
were so beautiful that the original photograph itself looked a bit
jaded. A complete surprise here was the Epson Perfection 1650.
So far, its performance ranged between average to decent, but in
this test it scores a brilliant 8.57.

Resolution test: When comparing the listed resolutions, always
consider the smaller number, which denotes the optical resolu-
tion. If you need to pick up fine details, small fonts or complex
lines and fine edges, you will need more optical resolution. The
number of pixels a scanner can generate is based on how many
CCDs are arranged horizontally and vertically in the scan head.
Resolution is quoted both horizontally and vertically (for exam-
ple, 300x600 denotes 300 pixels horizontally and 600 vertically).

All of this is theory. In practice, the ability of a scanner to actu
ally capture as much data as possible depends on a variety of fac-
tors. A score of 3 out of 5 is acceptable here.

The budget scanners scored pretty decently in this test, with
almost all of them scoring 3 out of 5. Most of them listed a reso-
lution of 600x1200 dpi and were able to catch the finer details.
Even the Agfa SnapScan 310P, which has a pretty low listed opti-
cal resolution of 300x600, scored a decent 3 points. The scanners
that failed to impress here were the Microtek ScanMaker 3630
and the Umax AstraSlim 600, both scoring 2 points, even though
they support a decent optical resolution of 600x1200.

Only two scanners in the mid range segment had support for
optical resolutions higher than 600x1200. The Umax Astra 4400
and the 5400 support an impressive optical resolution of
1200x2400 and 1200x1200, respectively. This higher resolution
directly translated into an impressive scan of the resolution bars—
both detected four of the five bars in this test. Amongst the scan-
ners with a rated resolution of 600x1200, only the Agfa SnapScan
1212P could manage 4 points; the rest were stuck at 3.

Among the high-end scanners, the HP ScanJet 5400C and
5470C had a very high rated resolution of 2400x2400. We expect-
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Scanner Maintenance

General maintenance

= Place your scanner away from heating vents or windows, or
other locations where moisture might affect its functioning.

= Always keep the scanner on a level surface so that it gets a
good grip, otherwise the mechanism carrying the CCD and flu-
orescent lamp will get damaged over a period of time.
Cleaning your scanner

= If you find that the images you are scanning are marred with
artefacts, light or dark stripes or a chequered board pattern, its
time you cleaned your scanner glass. Unplug the scanner and
raise the front lid. Apply a very mild streak-free cleaner to a soft
lint-free cloth and clean the glass. Never use abrasives, Isopropyl
alcohol, benzene or acetone on the scanner glass as this will
streak and cloud the glass and can even cause damage. Wipe
the glass dry with a soft cloth; wait until it completely dries out.
If you find that the glass is dirty underneath, on the inside, do
not unscrew the lid to clean it. Instead, call the authorised serv-
ice centre to get it cleaned.

Moving a scanner

= When transporting a scanner, ensure that the transportation
lock is enabled as this prevents the CCD array mechanism tray
from moving. To activate the lock, turn off the scanner and
push down the lock, which is located at the back of the scan-
ner. Remember to unlock the scanner before you attempt to
operate it, else you may end up damaging it.

ed them to return a perfect 5 in this test, but were disappoint-
ed as the HP ScanJet 5400C managed only 3 points, with the
rest of the high-end scanners scoring 4.

Warranty and support
Not one manufacturer provided a repair warranty for more than
one year. Providing a large service network and support across
cities helps to a certain extent but the lack of a three-year repair
warranty is hard to justify.

HP has the largest service network in this country—it claims
to have over 230 service centres across 79 Indian cities. It pro-
vides a carry-in warranty on its scanners and the best thing is that
a scanner will be replaced or repaired within 48 hours. With such
a wide network you generally wouldn’t face a problem getting
your scanner serviced.

What it all leads to...

Whether you need a scanner for professional use, or simply for
scanning your personal photos at home, there’s a wide range of
scanners available in the market, catering to a cross-section of
needs. Here are the best of the lot in performance as well as value
for money.

Budget scanners: Despite a price cap of Rs 6,000, we received
11 scanners in this segment. Competition was fierce but there
is little doubt about who wins the Best Performance Award—the
Microtek ScanMaker 3800 is probably the best scanner you
can purchase for under Rs 6,000. It has a good set of features
and returned consistently good performance in our speed and
quality tests. It had the fastest black and white text scanning
speed and passed the IT8 card test with flying colours. The Best
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Value Award goes to BenQ SW2 3300U. Its scores are pretty
average, but with a price tag of Rs 3,900 there is little that one
could complain about—it is a ‘no-frills-no-thrills’ scanner at
a rock bottom price. Nonetheless, it gets the job done and is
ideal for users who don’t care what shade of red the scanner
really scans!

Mid range scanners: We received seven scanners in this seg-
ment. The Umax Astra 4400 won the Best Performance
Award—its performance in the quality tests was exceptional.
With great photograph scan capabilities, a high dynamic
range (colour and greyscale) and excellent support for high
resolution scanning, this scanner is a tough one to beat.
The Agfa SnapScan 1212P bagged the Best Value Award.
It costs just Rs 6,500 but offers a good balance of perfor-
mance and features, with our only gripe being that it uses a
parallel port.

High-end scanners: These scanners represent the true pocket
pinchers, performance demons and feature-packed monsters.
They are targeted at professionals, imaging studios, design hous-
es and corporates. The HP ScanJet 5470C won the Best Per-
formance Award. It can scan photographs without artefacts or
noise at high resolutions (supports 2400x2400 dpi) and has excel-
lent colour reproduction capabilities. The Best Value Award was
taken by the HP ScanJet 5400C. It too supports a 2400x2400
dpi resolution but is almost Rs 5,000 cheaper than the 5470C.
Though it scores really well in the photo quality and colour tone
tests, it performed below par in our resolution test.

The Winners!

Microtek ScanMaker 3800: The ScanMaker 3800
from Microtek is equipped with
five one-touch buttons which
make the task of scanning very
simple. It is capable of scanning
at 600x1200 dpi at 48-bit colour
depth and sports a USB interface. This
budget scanner performed exceptional-
ly well in all the speed tests and gave
the mid range scanners a run for
their money. It comes bundled with
Adobe Photoshop LE and Adobe
PhotoDeluxe for editing the scanned
images and ABBYY FineReader Sprint
OCR to convert your valuable information into editable digitised
formats. The scanner is priced at Rs 5,500, which makes it a lit-
tle pricey for its category, but given the performance, it's worth
the price.
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Microtek ScanMaker
3800: the best possible
combination of speed
and quality

BenQ S2W 3300U: The BenQ S2W
3300U has a rated resolution e
of 600x1200 dpi with 48-bit _

colour depth and works ' _
using a USB interface.
Though not the fastest, it
returned pretty decent scores in the &£ e,
benchmarks. Its TWAIN driver allows “\/_
you to make basic corrections such as
adjusting highlights and gamma from
within the interface itself. Priced at Rs

BenQ S2W 3300U: its
price is irresistible
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Entry-level scanner

Good balance of scan speed and quality Super fast speed; excellent quality

You need To scan documents and photographs To scan photographs at decent resolu- Very high resolution scans which can be
occasionally. Quality is not that tions along with coloured documents and used for professional purposes (studios,
important magazine pages media houses, etc) and has all features to

tweak the image from within the driver

Look for A minimum optical resolution of 600 An optical resolution of 1200 dpi and An optical resolution of 2400 dpi and
dpi and support for 36-bit colour 48-bit colour depth and one-touch but-  48-bit colour depth. The scanner should

tons to save time be bundled with image editing and OCR
software

Our pick Microtek ScanMaker 3800 Umax Astra 4400 HP Scanjet 5470C
BenQ SW2 3300U Microtek ScanMaker V6UPL HP Scanjet 5400C
BenQ SW2 4300U BenQ ScanPrisa 640BT Epson Perfection 1650 Photo

Price range Rs 4,000 to Rs 5,500 Rs 8,500 to Rs 9,000 Rs 13,000 to Rs 19,000

3,900, it is the cheapest scanner in this comparison test and is an
affordable option for those looking for a decent mixture of per-
formance and features at a rock-bottom price.

Umax Astra 4400: The Umax Astra 4400 has a
rated resolution of 1200x2400 dpi and 48-bit
colour depth. There are three one-touch

buttons on the front-panel. The

scanner wasn'’t the fastest but
gave good results in the IT8 |
card test and resolution chart
test. It is an excellent buy for the
professional or someone who needs
good colour reproduction and a wide
tonal range, as well as for general
office use where it will be used by
multiple users—its driver has support
for network scanning. The scanner is
priced at Rs 8,950 but its top-notch performance makes it worth
the price.

Umax Astra 4400: an
excellent choice for the
professional user

Agfa SnapScan 1212P: Agfa SnapScan 1212P sports an opti-
cal resolution of 600x1200 dpi and a 36-bit colour depth. Despite
using a parallel interface, it was faster at scanning black and white
documents than the SCSI and USB scanners in its category and

e Shopping for a Scanner

PS = Always check the optical resolution of the scanner and
not the interpolated resolution.

= Make sure the scanner comes complete with all connection
cables and especially the drivers for your operating system.
= Always cross-check the warranty—whether it is a carry-in or
onsite warranty.
= If you often need to scan transparencies, buy a scanner that
allows you to connect a transparency adapter.
= Always examine the scanner glass to ensure that it is clean; a
dirty scanner glass will drastically affect the scan quality.
= A flexible lid makes it easier to scan books and 3D objects.
= Opt for a scanner that supports 48-bit colour depth.
= Go in for a scanner with a good software bundle—it could save
you on buying an image editing and an OCR software.
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also did quite well in the
quality tests. Bundled with
the scanner are Corel Print
House, PageKeeper, Omni-
Page LE OCR software and
MicroFrontier Colour It—soft- il
ware that will take care of all your o
imaging, printing and OCR tasks.
The scanner is available for just Rs
6,500 which makes it the cheapest
in its category.

Agfa SnapScan 1212P: more
than adequate for your day-
to-day scanning requirements

HP ScanjJet 5470C: This sleek
scanner’s front panel is
loaded with buttons which
make it very easy to scan in
bulk—you won’t have to wait for
the image application to open for i
the scanning job to start. The 5470C -
has a rated resolution of 2400x2400
dpi and 48-bit colour depth. The
package includes HP Precisionscan
Pro, which is a very good colour cal-
ibrating utility, and Readiris, an OCR software. The scanner costs
a hefty Rs 17,999, but the price can be easily justified given the
performance, bundled software and HP’s service network.

HP Scanjet 5470C: every
professional’s dream

HP ScanjJet 5400C: The HP ScanJet 5400C is capa-
ble of scanning documents at an optical
resolution of 2400x2400 dpi
and 48-bit colour depth. The
scanner has 11 buttons on the
front panel and you can even set
the number of copies you want
using the + and - buttons. The 5400C
was neck and neck throughout our
tests with its sibling, the ScanJet
5470C—the difference being that
this model is available for Rs 12,999,
which makes it an affordable scanner
for those looking for a 2400 dpi scan-
ning solution. Couple this with its long list of software and it
would be tough for you find a better deal. d|

HP Scanjet 5400C: a great
combination of features and
performance at an afford-
able price

DIGIT TEST CENTRE
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...which one should you bet on? We put various graphics chips through e
an ordeal by fire to seperate the winners from the losers
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raphics chipsets have
undergone a major
metamorphosis  from
the time they were first
introduced. Manufac-
turers have always kept
the end-users interested by releasing
newer, faster and even more feature-
crammed chipsets. The graphics chipset
has evolved from a polygon-pumping
machinery to a completely programma-
ble solution that could very well revolu-
tionise the way we work and play.

It all started innocently enough when
3Dfx released their Voodoo chipset and
forever changed the way games were per-
ceived. Things soon snowballed and the
year 1998 saw a boom in the graphics sec-
tor with the release of a number of high
performance 3D chipsets like ATi’s Rage
128, nVidia’s Riva TNT, Matrox’s G200
and S3’s Savage 3D.

The intense competition forced man-
ufacturers to adopt a six-monthly prod-
uct cycle that doubled the performance
of their offerings. The heat of the game
got to a few companies and they had to
leave the business, huffing and panting—
3dfx made a surprising exit, Matrox went
the 2D way, 3Dlabs decided to cater to the
niche market of CAD/CAM professionals.
The gamer got the short end of the stick
with only ATi and nVidia left standing in
the fray.

What followed was a lot of catch-me-
if-you-can between nVidia and ATi, as
both tried to go one-up on the other with
cyclical assaults. nVidia’s GeForce and
GeForce2 were countered by ATi's Radeon
chipset, the GeForce3 GPU went up
against the Radeon 8500, which was in
turn upstaged by the GeForce4.

As things currently stand, nVidia still
rules the market thanks to their aggres-
sive release cycles and their excellent driv-
er quality. But before you take the leap of
faith and purchase the latest video card,
temper that decision with what the Indi-
an market has to offer you and get a bet-
ter picture on the chipset that powers
your next graphics card.

We have tested a number of graphics
cards based on 15 discrete graphics
chipsets currently available in India, to
help you make that all-important buying
decision.

Market reality in India

A 3D graphics card is still considered a
luxury by most computer users in India
and the market is still nascent. Product
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launch times are skewed to such an
extent in India that by the time you get
your hands on a GeForce4 card, nVidia
would already be ready to launch its suc-
cessor. Timing apart, the price at which
the cards are initially sold is simply
unjustifiable. This is the primary reason
that compels users to shy away from
high-end cards. When a graphics card is
imported into India, many surcharges
and custom duties are applied on it.
Additionally, the local dealer and distrib-
utor knows the relative low volumes the
product will sell and the short life span of
each high-end graphics chipset, which
forces him to levy more margins on the
product, taking it further out of the reach
of most users.

Also even though almost all the high-
end chipsets are available in the Indian
market, a major chunk of the users swear
by their outdated SiS and nVidia TNT2
Mo64 based cards. The fact is that there are
a number of better performing chipsets
available at the same price point, but
users are simply not aware of the situa-
tion. Take for example, the ATi Radeon
VE and the nVidia GeForce2
MX200/MX400—the cards sporting these
chipsets provide decent performance, are
a great value for money and are ideally
suited for the budget audience.

Digit Test Process

We tested cards based on all the available
graphics chipsets in the market. Since
most card manufacturers closely follow
the chipset vendor’s listed specifications,
the real-world performance difference
between a GeForce card from Vendor X
and Vendor Y is negligible. What's
important is having the requisite infor-
mation to choose the graphics chipset
that is right for you.

The test system consisted of an Intel
Pentium 4 2.4 GHz processor based on
the Intel D8S0EMV2 motherboard along
with 256 MB of RDRAM and a 20 GB,
7,200-rpm hard disk. All 3D tests were
conducted under Windows 98SE and we
used Windows XP for testing the 2D per-
formance of the cards. Prior to running
the tests on every card, a ghost image of
Windows 98SE was loaded, followed by
a driver update. The desktop resolution
was kept constant at 1024x768x16 at a
refresh rate of 75 Hz. DirectX version 8.1
was used. VSync was turned off through
the Display Properties and the ‘Always
on top’ mode was disabled for the Win-
dows taskbar.

Something for Everyone

Graphics cards don’t come in the plain
vanilla flavour anymore; there are

many different versions available for
each graphics chipset, each at varying
price points. Thus, a GeForce2 chipset
will have an MX variant for the budget
crowd and an Ultra version for those
that demand performance. Also, manu-
facturers add funny sounding names like
Ultra, Pure, Deluxe, Pro, VIVO, etc to
their cards to highlight additional
features such as higher memory speeds,
TV tuner capability, FM radio, Video Out,
VR glasses, etc. As an example, take the
cards based on the GeForce2 MX200
chipset. The Maxtone GeForce2 MX200
based cards come in three flavours: one
features a TV-Out port (Rs 1,900), while
the other doesn’t (Rs 1,500); both have
32 MB of on-board RAM. The third
variant comes with both TV-Out and an
S-Video port and is priced at Rs 2,400.
Sounds confusing? It is!

For testing the onboard video chipsets
we used the following test beds:
= Intel 815 using the Intel D81SEEA2
motherboard with a Pentium III Tualatin
1.13 GHz and 256 MB SDRAM
= Intel 845GL using the Intel D845GBV
motherboard with a Pentium 4 2.4GHz
and 256 MB DDR RAM

Test method

We evaluated the different chipsets on
performance (75 per cent weightage) and
value for money (25 per cent weightage).
To separate their offering from the crowd,
vendors routinely offer features such as
video-in/video-out or support for 3D vir-
tual glasses. Our standard parameters
such as features, and warranty and sup-
port do not apply here since we're evalu-
ating the graphics chips themselves and
not cards based on these solutions.

Performance

When one thinks of a graphics chipset,
the first question that comes to our mind
is: How powerful is it? The power of a 3D
graphics chipset is mainly reflected by the
average frames per second it is able to
output and the new technologies that it
sports to give rich visual quality at sus-
tained high frame rates. Therefore, our
benchmarks consist of a number of speed
and quality tests. The overall weightage
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for this category is 75 per cent with speed
tests getting 60 per cent weightage and
quality tests getting 15 per cent.

3D speed tests

Our speed benchmarks were broken down
into OpenGL and Direct3D as every 3D
game released today supports either one
of these standards. Therefore it’s impera-
tive that your graphics card performs well
in these tests.

= Quake III Arena (OpenGL):
Extremely bandwidth-sensitive, the
Quake III Arena engine still has what it
takes to bring most graphics chips down
to its knees. We used an in-game pre-
recorded demo (demo four) with the
retail version of Quake III Arena patched
to version 1.30. We ran the tests in three
different modes (resolution x colour
depth x texture depth): Normal
(640x480x16x16), High (800x600x
32x32), and Maximum (1024x768x
32x32)—and the average fps over three
test runs was noted down.

= 3DMark2001 SE (Direct3D):
3DMark is a synthetic benchmark that
runs 21 tests to evaluate the graphics
performance of your system and brings
out any bottlenecks that might be hin-
dering its performance. The test suite
evaluates various features supported by
the graphics chip including hardware
Transform and Lighting, fill rate, image
quality, etc. This new version also tests
the performance of the latest program-
mable graphics chips. We ran 3DMark at
the default settings (1024x768 at 32-bit
colour with trilinear filtering and hard-
ware T&L support enabled).

s Comanche 4 (Direct3D):
Comanche 4 is a helicopter-based action
game that pushes the video chipsets to
their limits. Good performance under this
benchmark guarantees a safe and future-
proof buy. We ran the tests in three dif-
ferent settings: 640x480x16, 800x600x16
and 1024x768x32—and the average fps
was noted down. A chipset has to support
Hardware T&L for this benchmark to run.

2D speed tests

For the 2D speed test, we used
PCMark2002 Pro to check the speed of a
particular chipset in drawing 2D lines,
curves and images. This program runs a
series of benchmarks that tells you
whether your graphics chip can handle
the day to day work under the latest oper-
ating systems. This test was performed
under Windows XP.
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Our test suite consisted of two games and
one benchmark application:

1. Quake Ill Arena, which is an OpenGL-
based 3D game

2. 3DMark2001 SE, which is a benchmark
that tests DirectX 8.1 compatibility of a video
chipset

3. Comanche 4, which is a Direct3D-based
game that utilises advanced pixel and shader
effects present is newer graphics chipsets

Quality tests

The 2D image quality of the graphics
chips was tested under Windows XP. We
used an ordinary word document filled
with text in different font types and
sizes to evaluate the 2D quality of the
graphics chips. The 3D image quality
was tested using Quake III Arena with
FSAA and anisotropic filtering turned
on (1024x768x32, 2x/4x FSAA and
anisotropic filtering). We took screenshots
at selected points in the game and
checked for quality issues such as aliasing
problems, texture artefacting and colour
bleeding.

Value for money

This provides us with a price-performance
ratio. A chipset offering good perform-
ance at a great price will score higher in
this category than one offering excellent
performance with a hefty price-tag. We

computed this value by taking into con-
sideration the price of the cheapest card
available in the market for each graphics
chipset. The weightage allotted to this cat-
egory was 25 per cent .

How they fared

Sure games are cool, games are fun, but not
if they run like a slideshow on your sys-
tem. To truly enjoy a game, a decent frame
rate is an absolute essential. Of course, the
word decent is relative and can mean any-
thing from 30 fps for a role-playing or an
adventure game, to 60 fps for an action
packed game like Quake III Arena.

3D performance

The main aim here was to evaluate which
chipset was the ultimate performer on the
basis of raw speed. In 3D graphics termi-
nology, speed is measured in frames per
second (fps) or the number of frames that
a chipset can output in one second.

If you want an enjoyable experience,
30 fps is the minimum that you should
expect from any game. However, games
are fickle things—in one scene you might
see trees waving in the air and nothing
but some rocks to keep you company,
while the next second the entire screen
could be filled with monsters and gener-
al baddies of all sizes and shapes. A sce-
nario like this is not uncommon,
regardless of the type of game and it will
always cause a sudden and drastic drop in
the frame rate. Thus, it is not without rea-
son that we have considered a frame rate
of 60 fps as the minimum that your
graphics chipset should run a game at.
This will be our cut-off value, anything
above is cool and anything below is not.

Quake III Arena (OpenGL)

With the Quake III Arena engine power-
ing most of the new first person action
games, you're assured of adequate per-
formance across the board if your graph-
ics chip can handle this test.
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Normal quality: This is a very low-resolution, no-frills set-
ting. It is not meant for the serious gamer, but rather for
someone who enjoys that occasional game of Quake during
coffee breaks. As you can expect, the mid and the high-
end chipsets burn right through this test and are not worth
talking about here. Only the absolute lower-end graphics
chips like the Trident T64, nVidia TNT2 M64, ATi Rage 128
Pro, ATi Radeon VE and nVidia’s GeForce2 MX200 are
stressed under this mode.

The performance of the T64 was not up to par as prom-
ised by its specifications on paper. It managed only a lowly
56.1 fps. The nVidia TNT2 M64 scored 81.8 fps in the same
test and easily overshadowed the T64. It comes across as a
much safer bet if you want to have a decent gaming experi-
ence without burning a hole in your pocket. The final con-
tender from amongst these old chipsets is the ATi Rage 128
Pro. It sports a 128-bit wide memory bus which provides it
with a memory bandwidth of 2.5 Gbps, almost double
that of the TNT2 M64. The core though, still runs at a lowly
140 MHz and is based on a 128-bit architecture. The per-
formance of the
Rage 128 Pro falls
between that of a
O3A Mornal Quality (Irames;/sac) TNT2 M64 and

GeForce2 MX200

Trident 164 N

TrT2 M54 Bl chipset and offers

Rage 128 P AU a healthy 89.2 fps.
Madecn VE I 7 The ATi
GoForre? BAXIOO D000 1z Radeon VE per-
forms significantly

better than its older cousin, breaking the 100 fps barrier with
ascore of 107.9 fps. If you fancy an ATi card which also offers
excellent 2D and 3D quality visuals, then a card based on
this chipset would be a good choice. The GeForce2 MX200 is
the last budget chipset under consideration. It sports a simi-
lar architecture and is a direct contender with the Radeon VE
chipset. The MX200 is also the fastest amongst the older gen-
eration chipsets (it delivers a cool 113.2 fps) which should-
n’t be surprising considering the fact that it is a stripped down
version of the higher-end GeForce2 chips.

High quality: This setting offers a balanced combination of
a decent resolution with good picture quality and is quite
harsh on the lower-end graphics chips. Since we have decid-
ed to keep the cut off at 60 fps, we’ll have to wave our low-
end buddies goodbye.

The mid-range of the graphics spectrum comprises of the
GeForce2 MX400, ATi Radeon 7500, GeForce2 Ti VX and the
GeForce4 MX420 chips. The GeForce3/4 and the Radeon
8500 are still too powerful to be perturbed at this setting.

The first of our two mini battles takes place between the
GeForce2 MX400 and the Radeon 7500. The MX400 puts up
a healthy score of 85.7 fps but it is not enough to distance
itself from the 7500. We see that the ATi chip does pretty
well for itself, registering a score of 115.3 fps. The Radeon
7500 is manufactured using a 0.15 micron process, which
allows for an increased core frequency. This baby runs at a
neat 270 MHz core and 460 MHz DDR memory speeds and
has enough power to zoom past the MX400 without trou-
ble. Moreover, the Radeon has some nifty memory optimi-
sations which take it further past its competitor in this
32-bit colour test.
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Our second battle takes place between
two nVidia brethren: the GeForce2 Ti VX
and the GeForce4 MX420 chips. The
GeForce4 tag on the latter chipset is a mis-
nomer. In reality the GeForce4 MX420
suffers from a great deal of ignominy due
to the fact that it hardly carries any of the
GeForce4 chipset features. Nevertheless,
it does manage to show its teeth and beats
all of the chipsets mentioned in this test.
It scores a wonderful 152.8 fps.

We finally finish this round up with the
GeForce2 Ti VX. This chipset packs a pret-
ty mean punch and finishes a close second
to the GeForce4 MX420 with 134.5 fps.
Cards based on this chip can be considered
pretty affordable and thus we can safely
recommend this chipset to those of you
who are looking for a cheaper alternative
to the GeForce4 MX420 chipset.
Maximum quality: To put the latest
graphics chipsets through their paces and
evaluate their performance, a resolution
of 1024x768 is a must. The high quality
of visuals that this mode delivers rules out
every other chipset except for the latest
generation GPUs. The maximum quality
test is useful to evaluate the memory
bandwidth of a chipset, since the textures
are now much larger than those used in
the previous modes.

Integrated Graphics

Graphics chipsets integrated onto mother-
boards have always come as an ideal solu-
tion for the budget-conscious consumer.
When Intel came out with a motherboard
based on the 810 chipset, they became
quite popular in the value category. The
main reason for this was that the boards
were priced low and the graphics perform-
ance offered by them enabled the user to
play most of the games available then. The
only drawback was that your upgrade
choices were limited by the lack of an AGP
slot on these motherboards. Intel followed
up the success of the 810 chipset with
another successful entry—the 815 chipset.
This chipset offered better performance
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This is where things get interesting, as
the GeForce2 MX400 leaves us and the
big guns from nVidia and ATi decide to
crash the party.

An interesting observation that this
test offers is that almost all the cards from
the mid-range pass our 60 fps hurdle to
join us in this final round. Some of these
chipsets are based on old technology
while others are brand-spanking new,
with cool features to boot and a promise
of a healthy life-cycle. This is what will
separate the grain from the chaff in this
test, we think. Remember, we will assume
that budget is a thing of the past and you
are looking for the best. If you are still
restricted by the green stuff, then by all
means go for one of the mid-range
chipsets—they should serve you just fine.

With that out of the way, we decide to
shift our attention to the ATi Radeon
8500, nVidia’s GeForce3 Ti 500, GeForce4
Ti 4200 and GeForce4 Ti 4600. All the
chipsets that will now be discussed are
known as GPUs, short for Graphical Pro-
cessing Units since they are programma-
ble. This is where the future lies and if you
are spending a significant amount of
money on a card based on one of these
chipsets, you need to be assured that
future games will not leave it panting.

Let us start with the ATi card. The
Radeon 8500 is future proof, and John
Carmack, the id Software programming
guru, reckons that this chipset will be
more than capable of running the highly-
anticipated DOOM III. The Radeon 8500
also offers an excellent anti-aliasing and
anisotropic filtering solution—features
that help enhance the 3D quality of a
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*These are chipsets that are integrated into
your computer system motherboard

than the 810 and boards based on these
chipsets even sported an AGP slot for

future upgrades. The latest offering from
Intel, the 845GL chipset, aims to further

game. However, the fact remains that ATi
has iffy drivers, as it will soon be evident.
Considering the superior architecture and
the price that you pay for this card, one
would expect it to run alongside the
GeForce4 chipsets, but we observe other-
wise (it scores only 143.3 fps). Also note-
worthy is that a card based on an ATi
chipset will always offer excellent 2D and
3D quality. Moreover, the Radeon 8500
accelerates your DVD for crisp and clear
viewing. If you find these facts alluring,
then by all means go for this chipset.
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The performance of the GeForce3 Ti
500 chipset brings into question the driv-
er quality of the ATi chips. Although infe-
rior to the 8500, the Ti 500 is almost 6 fps
ahead of the former (149.2 fps). The pos-
sibility that current games are not
designed to get the most out of the brand
new Radeon 8500 goes for a toss as we see
the architecturally similar GeForce4 Ti
4200 and Ti 4600 do pretty well for them-
selves.

Too well in fact, they burn right
through everything. Posting an amazing
231.8 fps the GeForce4 Ti 4200 puts
everything else to shame. The chipset is
quickly upstaged by its older brother the
Ti 4600 that comes quite close to that
magical score of 300 fps (290.4 fps).

increase performance levels in the onboard
graphics arena.

Both the current chipsets, the 815 and
the 845GL, performed adequately through
our speed tests—in Quake lll Arena, you
can expect decent performance with the
845GL at lower resolutions as reflected by
its score of 105 fps. Also, even though its
3DMark2001 score bordered on the lower
end of the spectrum, the 845GL with 1345
3DMarks can hold its own against
GeForce2 MX200 based solutions. Not too
bad considering that this onboard video
chip misses out on the more whiz-bang
features that are available in the current
generation 3D chipsets.
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The GeForce4 Ti 4200 and Ti 4600 are nVidia’s answer to
the Radeon 8500. Although the 8500 retains a slight lead in
the architecture department, consider the excellent driver
support that nVidia provides and the fact that the Ti 4200 and
Ti 4600 are designed with future games in mind and you have
the winners among the big boys.

Comanche 4 (Direct 3D)

Comanche 4 is a helicopter-based action game that
demands a chipset with hardware T&L support in order to
run. Our low-end solutions are thus shown the door as the
ATi Rage 128 Pro, Radeon VE, Trident T64 and the TNT2
Mo64 walk out in shame.

At the highest resolution of 1024x768, the GeForce2
MX200 scores a pitiful 9.47 fps while the MX400 manages to
squeeze out a mere 15.49 fps. Even at lower resolutions nei-
ther of these chipsets managed to cross the bare minimum
score of 30 fps. The ATi Radeon 7500 and the GeForce4
MX420 also show a similar performance and fail to cross the
30 fps mark. Considering the fact that these chipsets should
allow for higher resolution gaming, their performance in any-
thing except the lowest setting reflects quite badly on them.

None of the chipsets in our test manage to cross our 60
fps boundary. Even the high-end GPUs are left licking their
wounds at around 40-50 fps. An interesting fact to note is
the difference in the scores that the GPUs registered under
the three resolutions—the point of interest being that
there is virtually no difference! The ATi 8500 maintains a
score in the 35-40 fps range, regardless of resolution.

Similarly, the
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GeForce2 Ti VX
fail to cross the
magic 5000 num-
ber with scores of
3833, 4561 and
4713 3DMarks
respectively. The
GeForce2 Ti VX
takes the perform-
ance lead against
the MX420, once
again bringing to
light the true
nature of the
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enough data to our GPUs to let them do
their thing.

3DMark2001 SE (Direct 3D)

As we move on to the 3DMark2001 SE
benchmark, we need to change a few rules.
Since this benchmark evaluates much more
than just the frame rate, our magic number
of 60 fps is no longer valid. The benchmark
awards a number, known as a 3DMark to
each chipset, after it has performed the 21
tests. Based on the number we can safely
comment on the game worthiness of the
particular chipset in question.

A synthetic test like this will give you
a fair representation of how any Direct3D
game will perform on your system. If you
want to play the next generation of
Direct3D games, like Unreal Tournament
2003, then scores upwards of 5000
3DMarks are recommended. Few older
generation chipsets can manage to cross
that number. A more forgiving game like
Need for Speed 5: Porsche Edition will
require a minimum of 2000 3DMarks to
run successfully.

The low-end chipsets, not surprisingly,
fare pretty badly. The Trident T64 comes
across as the worst of the performers with a
lowly 580 3DMarks, closely followed by the
TNT2 M64 with a score of 833 3DMarks.
The GeForce2 MX200 manages to cross the
1000 barrier with a so-so score of 1441
3DMarks, a performance closely mirrored
by the ATi Rage 128 Pro (1543 3DMarks)
and the ATi Radeon VE (1686 3DMarks).

The nVidia GeForce2 MX400 posts a
very reasonable 2700 3DMarks; a card
based on this chipset may not shine under
future games, but will be more than happy
to take on any current generation game.
Even other chipsets like the ATi Radeon
7500; the GeForce4 MX420 and the
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GeForce4 MX420
chipset.

Moving on to
the GPUs, our
5000 3DMark barrier is well and truly bro-
ken. The ATi Radeon 8500 posts a healthy
score of 7952 3DMarks and is a pretty good
choice given its price. Although the
GeForce3 Ti 500 scores more than the ATi
Radeon 8500 (8470 3DMarks), when you
compare it against its newer GeForce4
based cousins, the chipset doesn’t look as
attractive. The GeForce4 Ti 4200 scores an
amazing 9478 points and the GeForce4 Ti
4600 is the only chipset in our roundup
that crosses the 10,000 point hurdle to post
a phenomenal 10760 3DMarks. This is the
best chipset to be sitting in your graphics
card, if price is not a factor.
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2D performance

Do you click on the Windows Start button
and then twiddle your thumbs while the
menu appears?
Does scrolling
through text result

it was the ATi Rage 128 Pro with a score of
13706.2 lines per second and 1477.1
curves per second that took the lead here.
The rest weren't beaten by a mile but lost
nonetheless.

The chipset that could render the
maximum number of images in a second
was the GeForce2 Ti VX with an impres-
sive 639.1 images per second and the
GeForce4 MX 420 followed closely with
633.2 images per second.

These tests confirm that all modern
chipsets can handle 2D content with rel-
ative ease and if you are not the least bit
inclined towards gaming, then you can
pick almost any card and get more than
adequate performance for your day-to-
day needs.

Image quality

Image quality is a very important factor
while evaluating a video chipset. A good
frame rate is pretty much useless if the
game looks sub-par thanks to textures that
show artefacts or pixels that pop in and out
of the screen. Similarly, while working with
2D, a good graphics chipset should accu-
rately recreate colours and ensure decent
rendering of an operating system’s GUL

Word Document (2D quality)

Windows XP has a nifty feature called
Clear Type font, which basically anti-alias-
es the on-screen text to give a crisp and
clear look that is much easier on the eyes.
Some of the latest graphics chipsets (like
the ATi Radeon 8500 and the nVidia

FRAA Test under 034 Maxinmum Guality (frames/sec)

in a horrendous
lag? If you can iden-
tify with any of
these situations
then you have your
video card to blame.

PCMark2002 Pro
It became evident

that all of the
chipsets in our test
can provide decent
2D GUI speed. Even
under extreme cir-
cumstances when
there were multiple
windows open,
these chipsets did
not stutter or slow
down the GUL
Quite surprisingly,
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Given the excellent visual quality that FSAA delivers, a suitable
implementation that limits the performance hit when using this
feature is a major selling point of all of the new generation

chipsets. As this graph demonstrates, at the medium FSAA setting
of 2x, both the ATi Radeon 8500 and the Geforce4 Ti 4600 excel at
delivering good frame rates. However, the Ti 4600 demonstrates its
true power by offering a mind-blowing 105.7 fps at the maximum
AA setting of 4x which leaves the 8500 far behind.
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Geforce4 Ti 4200/4600) have a feature that
accelerates this anti-aliasing in hardware.

We found almost no differences
between the chipsets here. All the tested
chips performed well and the Word doc-
ument showed no visible errors under any
of these chipsets. The differences were so
minute that we had to stick our noses to
the monitor to notice anything worth-
while. All in all, the performance was
pretty similar across the board.

Quake IIT Arena (3D quality)

Introduced by 3dfx in their now defunct
Voodoo 5 chipset, Full Screen Anti-Alias-
ing (FSAA) has now become a major fac-
tor in determining 3D quality. Along
with the recently introduced feature of

Be it nVidia with its nFiniteFX engine or ATi
with its Truform technology, great efforts
are taken by the chipset makers to incor-
porate features that can enhance image
quality without sacrificing on performance.

New features like Environment
Mapped Bump Mapping (EMBM), Full
Screen Anti-Alaising (FSAA), Programma-
ble Vertex and Pixel Shaders, 3D Textures,
Shadow Buffers, are promising to deliver
the holy grail of computer graphics—
true-to-life realism.

Anti-Aliasing (AA): This is an important
feature which is incorporated in the new
generation chipsets and which greatly
enhances image quality. Simply put, AA
reduces the jagged edges that are visible
on the textures comprising a 3D game.
Enabling AA reduces frame rates consider-
ably, but the trade-off is excellent picture

quality.

Anti-aliasing removes the jagged step-like
artefacts along the edges of game objects

Anisotropic filtering: This serves to
reduce texture artefacting and blurring

B 71

anisotropic filtering, FSAA can
provide 3D images that are crisp,
clear and free of artefacts. Of
course, not all the chipsets tested
sported these features and thus
the quality of their output was not
up to par.

The TNT2 M64 and the Trident
T64 fared the worst in this test.
The image quality within Quake IIT
Arena looked washed out when
running under these chipsets.

One fact was clearly evident after
scouring all the images. The entire
Radeon chipset series (the VE, 7500
and the 8500) have brilliant 3D
image quality. Of the GeForce series,
only the GeForce4 managed to score

Advanced Imaging Features

and greatly enhances the image quality
with the help of advanced texture filter-
ing techniques. This feature is seen in the
latest chipsets such as the GeForce3/4
and the Radeon 8500. Anisotropic filter-
ing in tandem with AA provides excellent,
crisp, artefact-free visuals, albeit at a
frame rate loss.

Anisotropic filtering greatly enhances the
fidelity of an in-game texture. As seen here,
the walls sport sharp colours and clean
shadows, thanks to this feature

Bump mapping: This is a visual trick that
attempts to simulate a texture's roughness
or smoothness, depending on how the
texture reflects lights. Therefore, you can
now have a pond of water with life-like
ripple and wave effects. The common
techniques used for bump mapping are
Emboss Bump Mapping, DOT3 Bump
Mapping, Environment Mapped Bump
Mapping and True, Reflective Bump

Mapping.

Anisotropic filtering
(AF) can make a sig-
nificant impact on
image quality. As we
can see in the image
on the right, AF has
helped in making
the floor texture
clearer and sharper

Bump mapping has been used in this game
to give wave and ripple effects to the water

Programmable shaders: The biggest
breakthrough in graphics technology
would have to be the introduction of pro-
grammable shaders in graphics chipsets,
which give developers complete freedom
to create custom special effects for their
games. Therefore, next generation games
will feature eye-candy such as underwater
refractions, facial expressions, realistic skin
and hair that will make game characters
and environments look more true to life
than ever before!

Pixel and vertex shaders will enable game
developers to create highly-detailed charac-
ters like Wolfman here
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MODEL

FEATURES
Manufacturing Process (microns)
Core Architecture (bits)
Clock Speed (MHz)
Memory Speed (MHz), Type
Memory bus width (bits)
Memory bandwidth (Gbps)
RAMDAC Speed (MHz)
Max Resolution Supported (Hz)
Interface (Type/Version)
Fill rate (Millions of Texels/sec)
Millions of Triangles/sec
Hardware T&L Support
Rendering Architecture

Pixel Pipelines

Texture Mapping Units (per pipeline)
Pixel Shader/Vertex Shader
Visual Effects

Bump Mapping Technology

Hardware Anti-Aliasing Technology
Trilinear/Anisotropic Filtering
PERFORMANCE

TNT2 Meé64

0.25

128

125

150, SDR
64

1.2

300
1920x1200 @75
AGP/4X
250

9

Graphics Chipsets at a Glance

Trident T64

0.25

128

125

150, SDR
64

1.2

300
1600x1200 @75
AGP/4X
250

8

ATI Rage 128
Pro

0.25

128

140

160, SDR
128

2.5

300
1920x1200 @75
AGP/4X
NA

8

Emboss, DOT3

4X
0o

ATI Radeon VE

0.18

128

183

370, DDR
64

2.9

350
2048x1536 @75
AGP/4X
NA

NA

O

2
oo

Emboss, DOT3,
EMBM

4X

0oad

ATI Radeon ATI Radeon
7500 8500

0.18 0.15

128 128

270 275

460, DDR 550, DDR
128 128

7.3 8.8

350 350
2048x1536 @75 | 2048x1536 @75
AGP/4X AGP/4X
1700 2000

45 60

0 0

2 4

3 3

oo od

Emboss, DOT3,
EMBM

4X

oad

Emboss, DOT3,
EMBM

4X

0o

3D Speed Tests
Quake Ill Arena (fps)

Normal (640x480x16)

High (800x600x32)

Max (1024x768x32)
3DMark2001 SE (3DMarks)
Comanche 4 (fps) **

640x480x16

800x600x16

1024x768x32
2D Speed Tests
PCMark2002 Pro

2D Lines (Lines/sec)

2D Curves (Curves/sec)

2D Image Drawing (Images/sec)
Image Quality Tests
Word Document (Scale of 5)
Quake Il Arena (Scale of 5)
OVERALL SCORE
Performance (75%)

Value for Money (25%)
Overall Product Rating
Overall Grade

Price Range (In Rupees)
Cards using this chipset and
contact details

81.8 56.1 89.2 107.9 241.6 358.6
26.8 19.2 41.3 47.4 115.3 247.6
14.8 8.5 22.2 25.4 60.5 143.3
833 580 1543 1686 3833 7952
0 0 0 0 34.73 41.36
0 0 0 0 30.48 40.67
0 0 0 0 22.29 34.68
13458.6 12985.8 13706.2 13691 13157.5 12840.4
1446.4 1464.4 14771 1475.9 1461.3 1459.5
542.1 454.9 523.5 495.5 480.7 482.8
2.5 2.5 2.5 2.5 3 3.5
1.5 2.5 3 4 4 4
| OVERALLSCORE
18.1 18.5 22.1 22.7 41.7 54.6
13.12 22.47 3.86 10.23 8.63 5.78
31.23 41.01 25.98 32.93 50.35 60.42
LG J @ L] © o [ E-]
2,300 1,375 9,550 3,700-5,550 8,050 15,750
MSI-MS8088 Maxtone Tri- Supergrace ATl | Ennyah ATI Supergrace ATl | Supergrace ATI
(Priya Ltd, jain@ dent Blade T64 | All In Wonder Pro| Radeon VE Radeon 7500 Radeon 8500
priyagroup.com) (Maxtone (Integra Micro (Great World Tech [ (Integra Micro (Integra Micro

* Integrated video on motherboard
**Comanche 4 needs Hardware T&L support

Electronics Pvt
Ltd, maxtone@
vsnl.com)

Systems Pvt Ltd,
mumbai@
integramicro.com)

Pvt Ltd, sales@
gtechworld.com),
Supergrace ATI
Radeon VE
(Integra Micro
Systems Pvt Ltd,
mumbai@
integramicro.com)

Systems Pvt Ltd,
mumbai@
integramicro.com)

Systems Pvt Ltd,
mumbai@
integramicro.com)



GeForce2 GeForce2 GeForce2 Ti VX | GeForce3 GeForce4 GeForce4 GeForce4 Intel 815* Intel 845GL*

MX200 MX400 Ti 500 MX420 Ti 4200 Ti 4600

0.18 0.18 0.18 0.15 0.15 0.15 0.15 NA NA

256 256 256 256 256 256 256 128 128

175 175 250 240 250 250 300 NA 200

166, SDR 166, SDR 400, DDR 500, DDR 333, DDR 444, DDR 650, DDR NA NA

64 128 128 128 128 128 128 128 128

1.3 2.7 6.4 8 2.6 8 10.4 NA NA

350 350 350 350 350 350 350 230 350

2048x1536 @75 | 2048x1536 @75| 2048x1536 @75 [ 2048x1536 @75 [ 2048x1536 @75 | 2048x1536 @75 | 2048x1536 @75 | 1600x1200x@60 | 2048x1536 @6(

AGP/4X AGP/4X AGP/4X AGP/4X AGP/4X AGP/4X AGP/4X AGP/4X AGP/4X

700 700 1000 3800 1000 4000 4800 NA NA

20 20 31 48 31 130 136 NA NA

O O O O ] 0 [ g U

2 2 4 4 2 4 4 NA NA

2 2 2 2 2 2 2 NA NA

RN oo RN oo oo [N oo oo oo

Emboss, DOT3 Emboss, DOT3 Emboss, DOT3 DOT3, EMBM Emboss, DOT3, Emboss, DOT3, Emboss, DOT3 Emboss, DOT3 Emboss, DOT3

EMBM EMBM EMBM

4X 4X 4X 4X 4X, Quincunx, 4XS| 4X, Quincunx, 4Xy 4X, Quincunx, 4XS| 4X 4X

0o 0o 0o 0o g og 0o od ogd

113.2 231.8 366.7 278.4 321.6 372.1 379.5 38.9 105

46.7 85.7 134.5 242.2 152.8 339.2 367.3 20.8 37.4

23.9 41.3 68.9 149.2 86.5 231.8 290.4 11.4 0

1441 2700 4713 8470 4561 9478 10760 601 1345

21.13 27.68 26.65 46.62 38.32 45.83 46.11 0 0

17.53 22.93 22.93 43.04 34.79 46.34 46.51 0 0

9.47 15.49 16.81 40.05 25.32 44.65 46.12 0 0

13454 13454.8 13418.5 13259.3 13443.9 13417.6 13409.2 12485.3 13453

1467.2 1464.3 1465.9 1467.8 1469.3 1466.9 1465.1 1460.2 1462.6

527.5 534.1 639.1 628.8 633.2 628.4 629.5 453.8 540.9

3 3 3 3.5 3.5 3.5 3.5 3 3

3 3 3 3 3 4 4 2.5 3
000

29.1 35.9 423 53.0 46.0 62.3 64.9 18.6 21.8

23.07 18.12 9.92 4.28 8.72 5.53 3.13 25.00 25.00

52.17 54.00 52.21 57.32 54.76 67.85 67.99 43.57 46.79

LE ] o (5 ] o {6 ] o A o o

2,100-7,000 3,300-4,300 7,100 20,650 8,000-13,000 18,750 34,500-40,000 NA NA

Maxforce Maxforce ASUS V7700 ASUS V8200 Ti ASUS V8170 ASUS V8420 ASUS V8460 Ultral Intel Desktop Intel Desktop

GeForce2 MX200 GeForce2 TiVX 500 Deluxe Magic Deluxe (Zeta electronics, | Motherboard Motherboard

(Maxtone MX400 (Zeta electronics, | (Rashi Peripherals, | (Zeta electronics, | (Zeta electronics, | tejas@zetaindia EEA2 D845 GBV

Electronics Pvt Ltd, | (Maxtone tejas@zetaindia ho@rptechindia. | tejas@zetaindia. tejas@zetaindia .com), (Nebula (Nebula

maxtone@ Electronics Pvt .com) com) com), .com) ASUS V8460 Ultral Technologies, Technologies,

vsnl.com), Ltd, maxtone@ ASUS V8170 SE Deluxe pradip@ pradip@

ASUS GeForce2 vsnl.com), (Zeta electronics, (Zeta electronics, | nebulatech.com) | nebulatech.com)

MX200 Magic MSI GeForce2 tejas@zetaindia. tejas@zetaindia

(Rashi Peripherals, MX400 com) .com)

ho@rptechindia
.com),

MSI GeForce2
MX200

(Priya Ltd,
jain@priyagroup
.com)

(Priya Ltd, jain@
priyagroup.com)




test drive »

» graphic chips

You want A graphics chipset that A solution that should Top-notch perform-
helps you play an occa- run most of the games,  ance in both 2D and
sional game. Needs to  but price is a considera-  3D. Price no bar!
be cheap tion

You need A chipset that will give A chipset that will give ~ You need maximum
you a minimum of 60  you a minimum of 60 performance with all
fps in low resolutions  fps in medium resolu- the eye candy enabled
with compromises in  tions with minimum and with zero compro-
visual quality compromises in video mise in resolution or

quality quality

Look for Cards based on the Cards based on the Cards based on the ATi
nVidia GeForce2 nVidia GeForce2 Ti VX Radeon 8500, the
MX200 and the and the GeForce4 nVidia GeForce4 Ti
GeForce2 MX400 MX420 chipsets 4200 and the Ti 4600
chipsets chipsets

Recommended Intel Pentium Il 500 Intel Pentium Ill or AMD Intel P4 2.4 GHz or

System MHz, 64 or 128 MB Athlon 1 GHz, 128 or AMD Athlon XP
RAM 256 MB RAM 1700+, 256 or 512 MB

RAM
Price range Rs 2,100 to 7,000 Rs 7,100 to 13,000 Rs 15,750 to 40,000

4 out S in this test. The rest languished at
3, whereas the entire ATi Radeon series
scored 4 of 5.

What it all leads to...

In our test process, we have tried to eval-
uate every nuance of what makes a good
graphics chipset. Decent performance
under Quake III Arena ensures that your
graphics chip will run most current games
without a hitch, while Comanche 4 and
3DMark2001 give a good indication of
their performance in future games.

Overall, the results were not very sur-
prising. Older generation chipsets did
pretty badly in the high performance
tests and are not for someone who is look-
ing for a future-proof buy. The GeForce2
MX200 comes out on top as our Best
Value winner, offering adequate gaming
horsepower at a price that is within most
people’s grasp.

However, if you want the ultimate
gaming experience, don’t mind the price
and wish to be future-proof for a healthy
period of time, you should set your eyes
on the cards based on the high-end
chipsets like the GeForce 4 Ti series and
the ATi Radeon 8500. These chipsets fea-
ture cutting edge technology that future
games will make use of. Playing games at
maximum resolutions on the cards based
on these chipsets is not a problem at all
even if extras like FSAA and anisotropic
filtering are enabled. But the truly out-
standing performer in our tests was the
GeForce4 Ti 4600. This beast is truly the
fastest graphics chip in the world and wins
our Best Performance Award with ease.
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Winners!
nVidia GeForce 4 Ti 4600: Fresh out
of the nVidia stables, the GeForce4 Ti
4600 is a real power-horse. This chipset
is a piece of engineering marvel with
very efficient memory architecture, and
a core that is DirectX 8 compliant. It can
handle current and next generation
games at extremely high-resolutions
with FSAA and anisotropic filtering
turned on, resulting in excel-

lent 3D quality. The fact that
the chipset can support a

= | The ASUS V8460 Ultra Deluxe is based
on the nVidia Geforce4 Ti 4600 chipset.
It also offers a DVI connector ensuring
brilliant image quality on TFTs

maximum of 128 MB of high-speed, on-
board DDR memory means that games
featuring high-quality textures will run
with ease on this chip.

This chipset was the clear winner in
every test that we ran. It posted an
amazing 290.4 fps in Quake III Arena at
a maximum resolution and quality set-

ting of 1024x768, running at 32-bit
colour and with 32-bit textures. It also
posted a record-setting score of 10760
3DMarks in 3DMark2001 SE, a bench-
mark that few chips can conquer. With
a card based on this chipset inside your
system, you won't have to worry about
dropping frame rates when playing cur-
rent or future games.

nVidia GeForce2 MX200: Based on
the venerable GeForce2 chipset, the
GeForce2 MX200 is an ideal purchase for
those seeking a low-cost solution to their
gaming needs. Sporting a twin pixel
pipeline, with two texture mapping units
per pipe, this chip is architecturally adept
at handling all of the current-generation
games.

Considering its price, the chipset did

= . very well in our test suite. It

comes with an S-Video Out and is
based on the nVidia GeForce2
MX200 chipset

scored an impressive 113.2 fps in Quake III
Arena at normal quality and managed a
decent showing at the high quality set-
ting (with 46.7 fps). 3DMark2001 SE was
not very kind to the older generation
chipsets but the GeForce2 MX200
received a fairly decent score of 1441
3DMarks. Similarly the Comanche 4
benchmark managed to humiliate every
other low-end solution except for the
MX200.

It becomes pretty evident that a card
based on this particular chipset would
cater very well to the casual gamer. It
can run almost all the games that are
currently out there at a decent frame
rate and if you are into slow-paced
games like role-playing or adventures,
this chipset will even handle them at a
high-resolution. d|

YATISH SUVARNAand AHMED SHAIKH
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test drive '- ocr software

hetweel

and many imore WinQCR -
system that works with an
Features :

Fast and accurate omni-font OCR echnglogy res
Multi-lingual (Enghsh, German, Frenchi. 5pan
Powertul but extremely sasy to use. Reads iette

wds' Iis & funously fast, unbelievably accurate and easy to

ci designed for Windows 95/98 and Windows NT 4.0
w such as OLF automation, Drag&Drop. direct Word export
id tughly accurate Oplical Character Recognition (QCR)

Miant scanner,

-k

fomts, Over 99% accuracy
1, Danish, Finnish, Insnhj,
print and faxes, Automatic

de-skew 10 correct sianted images (up to 15 degrees). Word verifier for easy on-screen proofing,
interactive spelling checker, User definabie dicionane

we test the best OCR software
that promise to convert all the
information stored on paper
into an editable, searchable
digital database

anning out of space for all those

stacks of magaginges, hills and

research material vou've gathered

weer the vears? Cant find thal
article on greal monsoon gelaways that
your are certain you saw in one of those
travel magazines you've been collecting?
In a fit of irritaticon with all that paper
lying about, you might be tempted to sl
it ol to the seddivala, but vou never
ke when you might need the infor-
miation hidden in there,

Dron't tear vour hair cut just yel. An
pptical character recognition (OCR) pack-
ape and o low-cost scanner that allows
ol Lo scan atb _!:J[Idpi 1% wour answer
corverting all that information e paper
into: a digital format, which can be

f[76

archived and retrieved casily, OCR pack-
ages today include features such as batch
scanning and scheduling, A Lexl search
and indexing tool completes the pictare!

Wi test the best of the ot with o clean
goal—minimal effort and maximum pro-
ductivity!

Test process
The test bad wsed to evaluate The OCR
software consisted of a Tentivm I
U ML processar, 125 PR BAM sl an
HO5 G 5,00 rpm haed drive, We used
scanner with 24-hit colour depth and a
resolution nf G0 1200 dpi—you would
need just 300 dpi and 24-bil colour for
any OCK software to recognise fonts
accurately, The test documaents were
seanned with defaule sertings and savedd
1o Microsoll Word 200000 andd Fxoel.
Before testing vach C4CR s kape, we
loacded Windows QESE on oo cleanly Tor-
matted svstem. Cachoman 511 Togged
Ehe ey wsage ol U Ui B osoftware,
e Lested the OO R software an the Tol-
lowrine parameters:

rasItG Solomaon Lewis

Ferformance: We looked for the accu-
racy with which Yhe OCE engine could
recognise words, characters and symbols
anel ils ability o retain the original Tvout
and formatting.

Another measure of good perform
ance is the O solbaare’s ability 1o deal
with many kinds of documents, sommd
involving complex formatting and oth
ers that are smadged or have Taded et
Henwe, we challenged the OCR packages
with o sel of nine documents: a regulan
word docament printed enoan inkjel
printer, a combination document with
various ASCH characters and symbals
an Fxeel sheet with complex table for
matting, o dot maleis print, photocopy
af o oword document, a |}'|||'-1'.'rillt-:|
sheet, o Tax copy, o newspaper sheel
and o magarine page wilh com e
loarmatting,

Featurees: The fealure set of an OCH solft
ware adds 1o its functionality, The Tea
fures that  omatter  doclude mudtiph
language  support,  lable recognilion
sehwduling and batch processing, supspor
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for removing smudges and speckles, the
ability to correct skewed scans, and the
ability to process documents in landscape
and portrait format depending on the
text formatting, irrespective of how the
document is placed in the scanner.

Ease of Use: Here we observed whether
the icons had descriptive imagery or
captions explaining their function, menu
navigation (grouping of features, menu
structure and intuitive placement of
important features), presence of wizards
to guide you through the OCR functions,
and help and documentation.

Value for money: This is a factor of the
performance and features offered by the
OCR package as compared to its price.
The greater the performance and features
and the lower the price, the higher will
be the value for money offered. We com-
puted this value by dividing the sum of
an OCR software’s performance and fea-
tures scores by its price.

How they fared

Features

OCR-ing large volumes of prints can

become a nightmare, but most good pack-

ages offer time and effort saving features.
ABBYY FineReader 6.0 CE supports an

and was also the only software to not
have support for recognising characters
placed on a coloured background—a big
disadvantage if you OCR magazines,
brochures or other heavily designed
documents.

CuneiForm 2000 did not have sup-
port for page orientation detection. This
feature makes working with magazine
pages rather difficult as it affects the OCR
engine’s ability to pick up the formatting.

Ease of use
The simplicity of the user interface, pres-
ence of productivity enhancing tools
such as wizards and auto processing, and
sufficiently detailed help and documen-
tation help ease the tedium of OCR-ing
large volumes of printed documents.
ABBYY FineReader 6.0 CE and Readiris
Pro 7 have the best menu navigation and
structure. Both have well defined sub-
menus and present a very intuitive inter-
face. A wizard pops up on loading the
software. Though FineReader 6.0 CE has a
more sophisticated look and feel to its wiz-
ard, the functionality is similar to the
other software in this comparison. The
help and documentation provided with

impressive 122 languages. Sadly though, e
Indian languages are not included! It also e, e e Ty
has a table recognition feature and retains B
the table layout when it saves the docu- e .
ment as a Word file—a useful feature if 2= Sl e
you are OCR-ing balance sheets, challans, o B agie, 5%
reports, etc. It also has support for sched- E.' =
ling and batch processing. : ?E
h FiE
e i | mee | _em |
|
S Wizards in FineReader make OCR-ing a breeze

e = R A L A
iwm it o| o EFT ol fasmrt | s e 1w L Lo

OmniPage Pro is the only OCR software with
Text-to-Speech facility

The only other software to have
scheduling was OmniPage Pro 11. This
software supports 114 languages and can
also detect page orientation. However, it
does not support auto table detection,
which means that you will have to man-
ually format tables in Word documents.

PageGenie Pro is rather meagre on
features. It supports only 10 languages,

FEm77

both software is also pretty good.

CuneiForm 2000, on the other hand,
at first glance presents you with only
three tabs: File, View and Help. The rest of
the menu items are visible only after the
page is scanned—this is quite irritating
after a few attempts. It also didn’t have
any online help.

PageGenie Pro 4.0 was the only soft-
ware here to have poor wizard function-
ality. It also lagged behind the others in
the bundled help and documentation.

Performance

Converting those different kinds of docu-
ments, bills, receipts, and newspaper/mag-
azine cuttings into an editable and search-
able digital format can be rather frustrat-

Hands free Scanning

Tired of manually feeding in paper and
scanning? An Automatic Document
Feeder would be

the right g ;/f
choice if you \[
need to do w

batch processing. (s [ :
All you have to do is o
feed the necessary text docu-

ments in the tray and the Automatic
Document Feeder will handle the rest.

ing if in the end the OCR software picks
up junk and garbled text.

Inkjet printout: We scanned a plain
text document with basic formatting such
as a drop caps, bold, italics, underline,
indents, Web links, superscript and sub-
script styles. The text used three fonts—
Times New Roman, Arial and Garamond.
The font size used for the e-mail and Web
links was 8 and 10 points respectively, to
make character recognition difficult for
the OCR engines.

An inkjet printout at high quality is
not too much trouble for an OCR soft-
ware, as it is usually very clean, with few
smudges. You should expect nothing less
than 99 per cent accuracy from your OCR
package and a score of 4 out of 5 for for-
matting. Also, there should be little or no
junk characters in the OCRed documents.

All software except PageGenie logged
high scores for accuracy (ranging between
97 and 99 per cent). OmniPage Pro 11 was
particularly impressive, logging 99.29 per
cent accuracy—the scanned document
had only a couple of spelling mistakes. Plus
it was the only software to retain e-mail
and Web links, which were underlined and
used coloured fonts, and were also click-
able when saved as a Word document.

Close on its heels was ABBYY
FineReader 6.0 CE, with an accuracy score
of 99.05 per cent. This software, along with
Readiris Pro 7, were the only two that were
able to show drop caps precisely while
retaining the original document layout
(both scored a brilliant 4.26 out of 5).

The lowest score was of PageGenie
Pro 4.0 at 92.92 per cent accuracy,
which means that you will have to
spend a fair amount of time correcting
the scanned document. It picked up the
drop caps, but displayed it as a bold font
separately and wasn'’t able to retain the
layout. PageGenie Pro 4.0 was unable to
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detect the links; in fact, it failed to pick
up the small-sized fonts.

Combi document: This was a test of the
OCR package’s ability to read special sym-
bols (such as currency symbols, Greek
alphabets and mathematical notations)
commonly found in business and scien-
tific documents. The formatting on this
document included bold and italicised
text and two different sets of reverse
fonts—black text on grey background and
white text on grey background.

Overall, the results here were quite
disappointing for accuracy as well as
retaining formatting. All five software
found it particularly difficult to detect the
black text on grey background.

The best performer here was ABBYY
FineReader 6.0 CE, with an accuracy of
96.77 per cent. It was also the best when
it came to retaining formatting—it scored
2.5 out 5. However, like the other soft-
ware, it was unable to detect Greek sym-
bols such as ‘p’ and ‘@’ and the currency
symbols. Of the nine currency symbols
included in the document, the software
were only able to read $, £ and ¥— Page-
Genie Pro 4.0 simply ignored the entire
line containing currency symbols and
returned junk characters for the white
text on grey background.

CuneiForm 2000 logged only 69 per
cent accuracy—the poorest results here.
The document was full of junk characters
and reverse fonts were missing entirely.

Excel spreadsheet: If you have a large
number of bills, chalans or complex Excel
spreadsheets then the results of this test
should be of interest to you. Here
the ability of the OCR software to read
characters accurately as well as retain for-
matting are equally important.

Our document had a table with
native Excel formatting such as horizon-
tally and vertically merged cells, text writ-

Wineherhasrd Test Score Log for May 2002
Wicick TFTCAMH X7 |

Treegemed i,
i o |50 panie §
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]
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The Excel spreadsheet
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Level of Accuracy (%)

Readlrls Pro 7

Pa-gl;ﬁr.nil: Pro 4.0

OmniPaye Pro 11 gl s L

CuneiForm 2000 Pra o

ABBYY
FineReader 6.0 CE
again displayed its
prowess in recog-
nising characters
and returned an
impressive 95.28
per cent accuracy.
It did miss out
some characters,
reading ‘0’ as ‘Q’
and ‘Z' as ‘2.
OmniPage Pro 11
came in second

W Magazine Page T Mewspaper Clipping

W Furcl Shect

ten in vertical format, and coloured cells
with text and data. We also checked to see
if the vertical text and ® symbol were
detected after saving the file in Excel.

ABBYY Finereader 6.0 CE and Omni-
Page Pro 11 both scored over 90 per cent
in accuracy and also retained the layout.
PageGenie Pro 4.0, on the other hand, did
very poorly here—the entire document
was filled with junk characters and was
saved in one column only (it scored
zero for both, layout and accuracy).
CuneiForm 2000 and Readiris Pro 7 also
scored nothing for layout and formatting
here! Also, none of the OCR software in
this test were able to retain the colour of
the cells.

Dot matrix printout: Dot matrix
printouts really put the OCR engine to
test—here the characters are formed
using fine dots and it is a great challenge
for the OCR engine to recognise it as a
complete letter.

= A document which is free of wrinkles,
tears, smudges or creases will yield more
accurate results.

= Keep a sheet of white paper behind the
document when you scan it for OCR-ing,
especially when scanning newspapers and
thin paper. This will help eliminate
smudges during scanning.

= Use the Rotate and Crop tools of an
imaging software to align the text if there
is no Deskew option in your OCR software.
= Despeckle the scanned image before
you begin OCR-ing the document. This
will remove the dots (background noise)
and help the OCR engine recognise

M inkjet Printourt

with a decent
91.03 per cent
accuracy.  Once
again, only ABBYY
FineReader 6.0 CE and OmniPage Pro 11
retained the layout to a certain degree and
scored 2.49 out of 5 each.

The poorest performer here was
CuneiForm 2000; it scored a paltry 23.82
per cent in the accuracy test and had lots
of misspelled words and junk characters.
It was also the worst of the lot at retain-
ing formatting—not a single formatting
element was retained and the entire doc-
ument was a mess.

Photocopied document: A photo-
copied document tests the true mettle of
the OCR engine—the text is usually faded
and there are smudges on the sheet. For
this test, an inkjet printout was photo-
copied at normal quality mode.

ABBYY FineReader 6.0 CE once
again came out tops, with an accuracy
level of 95.75 per cent—there were no
junk characters in the OCR-ed docu-
ment! But it scored only 3.32 out of 5
for formatting.

Tips for Better OCR Results

neighbouring fonts correctly.

= Scan the image in full colour mode. If
the document has simple black fonts on a
white background, use the greyscale
mode. You will get poor results if you
select Line art (black and white) mode.

= Use the image splitting tool to manually
define the text and image area. This will
help the OCR engine retain the format
and layout more accurately.

« If your documents have custom fonts
and formats that are not picked up by the
OCR software, train the OCR software by
adding those specific fonts and letter
types into its dictionary.
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Farmatting Retained (Scale of 5)

ChminiFacge Pro 11

CumneiForm 2000 Pro

FineReader 6.0

was the clear win-
ner with an excel-
lent score of 97.16
per cent accuracy.
Although  there
were some minor
errors in recognis-
ing characters
such as ‘1’ and ‘0’,
which were read as
‘1" and ‘Q’ respec-
tively, a score of
over 90 per cent
accuracy for a fax

B Magazine Page T Mewspaper Clipping ply
M inkjrt Printoot

W Fxeel Shoet

PageGenie Pro 4.0, on the other hand,
fared poorly, logging a low 39.15 per cent
accuracy. Compare this with its 92.92 per
cent accuracy level in the inkjet printout
test and it becomes clear that just chang-
ing the printing medium causes more
than a 50 per cent drop in its character
recognition capability.
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Phototcopied document

OmniPage Pro 11 did really well in
retaining the layout and formatting, scor-
ing an impressive 4.15 out of 5. Readiris
Pro 7 and CuneiForm 2000 on the other
hand did not retain any of the layout and
formatting and scored nothing!

Fax document: Yet another stress test
for the OCR engine is when it comes to
reading fax copies. We made a fax copy
of the inkjet printout; it had a lot of
smudges and smears.

Here again, ABBYY FineReader 6.0 CE

FEMm79

document is sim-
amazing.
OmniPage too did
well here, logging
95.75 per cent
accuracy. As for retaining formatting,
OmniPage Pro 11 edged out FineReader
6.0 CE by a fair margin—it scored 2.49
against 1.66 for FineReader 6.0 CE.

Readiris Pro 7 returned disappointing
results with an accuracy level of only
72.87 per cent. It, along with CuneiForm
2000, scored nil for formatting because
there was absolutely no font formatting
left. Every font had the same font type
and size and it failed to retain even sim-
ple formatting like underlines, bold text
and italics text!

OCR with Office XP

Microsoft Office XP includes a separate
program called Office Document
Imaging. With this program you can

=
e FAAL prmnds
[l o iepppay prei g ot e
\peas s e 5oL
- | P | il |

Installing Office Document Imaging

quickly and easily convert a scanned docu-
ment into text with the optical character
recognition (OCR) command.

To access the program, insert the Office
XP CD. Select the Add/Remove option and
navigate to Office Shared features. Here,
select the Office Document Imaging

Newspaper clipping: OCR-ing a news-
paper is one of the most troublesome
tasks. The varied formatting, fonts, thin
paper and poor print quality make it very
difficult for an OCR software to recognise
the text.

The newspaper clipping we used for
the test had text in the standard
two-column layout. Plus there were
logos, reverse fonts (white on black) and
highlights. There was a lot of smudging
between fonts, with fonts getting mixed
- o, W W sz
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Newspaper cllppmg

option and continue with the installation
process. Once this feature is installed, go

ke, el maplhe—ya's s
B e e
. ke - e v e e

Office XP’s built-in OCR engine does a fairly
decent job

to Start > Programs > Microsoft Office
Tools and click on Document Imaging.
Open the text document which you have
scanned, or select Scan New Document if
you wish to directly scan it into this pro-
gram. Now click File > Recognize text using
OCR. This text can then be directly trans-
ferred to Microsoft Word.
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@ ABBYY Cuneiform | ScanSoft XMLCities | Readiris up. We also observed whether the OCR

Software FineReader | 2000 Pro- | OmniPage | PageGenie | Pro 7 software could pick up the custom font
6.0 CE fessional | Pro 11 Pro 4.0 SP2 used for the company logo.
Digital Camera Support 5 = = = = In t.his test OmniPage Pro 11 scored a
No. of Languages Supported | 122 20 114 10 93 whopping 97.27 per cent accuracy, beat-
Page Orientation Detection | [ 0 0 0 0 ing ABBYY FineReader 6.0 CE (96.88 per
Coloured Documents a ] O o ] cent) by a small margin. However,
Support FineReader 6.0 CE retained the layout
Auto Table Recognition O 0 O O 0 much better than OmniPage Pro 11. It
Scheduling a ] a ] | was able to show the reverse fonts and
Batch Processing u o o o o even detected the bulleting as it was on
Deskew / Despeckle Support | [ [J oo oo oo oo the newspaper clip. It scored 3.55 as
Image Formats Supported BMP, TIFF & | TIFF & JPEG | BMP, TIFF & | BMP & TIFF | BMP, TIFF & against 2.13 scored by OmniPage Pro 11.
(before OCR) JPEG JPEG JPEG
Export Formats (after OCR) | DOC, RTF, DOC, RTF, DOC, RTF, RTF, HTML & DOC, RTF, . . .
TXT, HTML, | TXT, HTML & | TXT, HTML, | PDF TXT, HTML, Magazine page: A typical magazine
PDF & XLS | XLS PDF & XLS PDF & XLS page with coloured background, coloured
Text Search and Indexing O 0 O 0 0 fonts, images and reverse fonts was
Image / Text Splitting Tool | [J | | | | OCRed. We looked for accuracy in pick-
Text to Speech o O o O O ing up text written in different font sizes,
Resource Utilisation and the ability to retain colour and lay-
Memory consumption | 18.8 MB 11.2 MB 25.1 MB 2.6 MB 2.2 MB out. The layout consisted of three text
Install size Ll il 40.1 MB GG 226 MB | 20.5MB columns, one coloured block with images
and text on it and a company logo in a
Auto Processing u] 0 o 0 u]
Self Explanatory Icons 0 O 0 O O custom font.
Menu Navigation (Scale of 5) | 4 2 4 3 4
Wizards (Scale of 5) 4 3 4 0 4 — Eeka Illnug:mm R
Help and Documentation 5 3 4 3 5 Rovirscgs it VG Eour
(Scale of 5)
Online Help O O 0 O O
Accuracy (%)
Inkjet Printout 99.05 98.11 99.29 92.92 97.88
Photocopy 95.75 49.76 92.92 39.15 62.73
Dot Matrix Printout 95.28 23.82 91.03 34.9 79.48
Type-written Document 86.25 47.32 95.99 29 29
Fax Document 97.16 77.83 95.75 83.72 72.87
Excel Spreadsheet 94.47 31.49 90.1 0 62.08
Newspaper Clipping 96.88 87.15 97.27 84.43 96.49 @ ot
Magazine Page 99.86 88.1 96.21 88.64 92.21 P T
Combi Document 96.77 69 76.53 81.23 84.75 e gt oot @ et e e
Formatting (Scale of 5) il il . =
Inkjet Printout 4.26 1.42 2.84 1.42 4.26
Photocopy 3.32 0 4.15 1.66 0
Dot Matrix Printout 2.49 0 2.49 1.66 1.66 .
Type-written Document 4.75 2 4.5 0 5 Magazine page
Fax Document 1.66 0 2.49 1.66 0 . . .
Excel Spreadsheet 3.75 o 3.75 o 0 Since the magazine page was on high
Newspaper Clipping 3.55 0 2.13 0 0 quality paper, most OCR software scored
Magazine Page 4.98 0.83 3.32 249 3.32 over 80 per cent accuracy, but logged
Combi Document 2.5 0 0 0 0 poor scores in retaining formatting.
ABBYY FineReader 6.0 CE clearly proved
Performance (50%) 41.52 19.75 38.42 20.32 27.16 its supremacy over other OCR software,
Features (20%) 18.5 9.67 16 1 17.5 scoring 99.86 per cent accuracy and an
Ease of Use (10%) 9.2 5.4 7.8 3.8 9.2 almost perfect 4.98 out of 5 for format-
Value for Money (20%) 6.86 13.04 6.21 18.07 18.05 ting. It retained the layout as well as the
Overall Product Score 76.08 47.86 68.43 53.19 71.91 1 s
Overall Grade o @ © o o reverse fonts with images and the exact
Vendor Netspider | Cognitive | ScanSoft XMLCities | Irislink company logo. .
Technologies Closely following it was once again
Contact sales@netspi- | sales@cogni- | vanessarichter | sales@xmici-| sales@iris- OmniPage Pro 11 scoring 96.21 per cent
derindia.com | tive.ru @ scansoft.com| ties.com link.com 1n accuracy.
Web site www.abbyy | www.cgntv | www.scan- | www.page- | www.irislink
-com .com soft.com genie.com | .com Type-written document: Type-writ-
Price (Rs) 25,000 6,450 25,000 4,950 7,068 ten sheets usually contain a lot of letters
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Corporate/Government/

You are a
Educational Institution

SoHo/Home User

You need to OCR

Faxed/photocopied/type-written
documents/newspapers and maga-
zines/contracts/tenders with text
and tables, with high levels of

Documents containing text and
tables with basic formatting,
occasional newspaper and maga-
zine clippings, with average

accuracy accuracy

Our pick OmniPage Pro 11, ABBYY PageGenie Pro 4.0, Readiris Pro 7
FineReader 6.0 CE

Price Rs 10,000 and above Up to Rs 10,000

that are misaligned or even not clearly
formed. It therefore becomes difficult for
the OCR engine to recognise the charac-
ters and it has to guess the correct letter
or number.

OmniPage Pro 11 scored the highest
here, returning an amazing 95.99 per
cent accuracy. This score was way ahead
of that logged by FineReader 6.0 CE,
which managed only 86.25 per cent
accuracy. OmniPage Pro 11 also man-
aged to retain the layout fairly accurate-
ly, with only two bullet points missing
out of 10.

Readiris Pro 7 was the best at retain-
ing format and layout here—it retained
the layout with 100 per cent accuracy. But
it returned a paltry 29 per cent accuracy
in reading the text.

What it all leads to...

It was a tough fight between ABBYY
FineReader 6.0 CE and OmniPage Pro 11
all through the test. Both are priced at
Rs 25,000 and score well all across the
board. Nonetheless, ABBYY FineReader
6.0 CE edges ahead purely because of its
ability to retain layouts and formatting

across a wide range of media types.

The area where ABBYY FineReader 6.0
CE really shows its mettle is in the
combi document—it was the
only software to retain all
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If you can afford it, FineReader 6.0 CE is the
best OCR software bar none!

the formatting and styling elements
along with an accuracy score of over 96
per cent!f

HATIM KANTAWALLA and ALIASGAR PARDAWALA
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Intel Pentium 4 2.53 GHz

Speed demon

f you crave for nothing

but the best, then this
processor is for you. This
speed demon demolished
every benchmark we threw
at it. It runs at a super-fast
speed of 2.53 GHz, scream-
ing along at a quad-
pumped FSB of 533 MHz.
This P4 is based on the
Northwood  core—thus
featuring 512 KB of full
speed L2 cache, resulting
in faster gameplay and
multimedia. It zoomed
past all our previous
records and screamed into
our hall of fame as the first
one to shatter the 400 fps
barrier in the normal qual-
ity mode in Quake III.

It also scored a massive
115.8 in Content Creation
Winstone 2001 and scored
an equally impressive 106.2
in Business Winstone 2001.

Price: Rs 38,220

Contact: Nebula Technologies
Phone: 022-6730567

Fax: 022-6730566

E-mail: pradip@nebulatech.com
Web site: www.intel.com

To put things in perspec-
tive, a Celeron 400 would
score only 19.3 in Content
Creation and 17.7 in Busi-
ness Winstone 2001.

Its ability to crunch
numbers depends on the
system bandwidth, which
can only be satisfied by an
RDRAM-based board and a
top-of-the-line  graphics
card. This processor is rec-
ommended only for users
with stout hearts and deep
pockets.

SPECIFICATIONS

Pentium 4 2.53 GHz, 512 KB of
L2 cache, SSE2, 533 MHz FSB,
0.13 micron fabrication

Intel Pentium 4 2.53 GHz
Performance AR
Build quality NN
Value for money » » » K »
Features AN
OVERALL [

Philips Fisio 820 cell phone

L=

We test the latest and the best hardware and software products available in the market

received calls and 10 missed
calls. Through the menu you
can change  wallpapers,
screensavers or screen themes
according to your choice. It
also has a feature called quick
settings, through which pre-
defined settings such as car,
silent and meeting can be
quickly applied. The buttons
of the phone are quite well
placed but they feel a bit tacky
and need some getting used
to. However, the voice recep-
tion, both inside and out-

Price: Rs 21,995

Contact: Philips India Ltd
Phone: 011-3731046

E-mail: rishi.goyal@philips.com
Web site: www.phillips.com

doors was dissapointing.
Strangely, the handset that we
received would switch off
whenever we tried to read an
SMS message. All in all, a
very expensive phone for the
performance it offers.

SPECIFICATIONS

Dual band (GSM 900/1800),
256-colour display, 5 hours 30
minute talk time, 1.21 WAP-
browser, GPRS-enabled
Dimension: 98x47x21 mm,
85gm

Philips Fisio 820 e
Performance  » » » » »
Build quality RS
Value for money » » » » »
Features > bbb
OVERALL [ A

SoftWriting CharacTell 3.2

Small, sleek and ready for the future

’I‘he Philips Fisio 820

sports a contoured [.
body, weighing only 85
grams and features a
colour display screen (256 '»
colour, 120x130 pixels
with 9 lines). You can

adjust different settings
such as contrast and back-

FIEM 82

light. It features an e-mail
client with picture attach-
ments, along with voice
' || dial and voice memo. It
/| also supports WAP 1.21,
/| Bluetooth and GPRS.

| It lets you store up to
| 500 numbers in the phone
book, 10 dialled calls, 10

ICR this!

CR software go0es a .u i

step beyond OCR—it .z &
not only recognises
print characters, but
also handwriting and
converts them into
editable documents.
During our tests with
SoftWriting CharacTell

3.2 using simple hand- &g

writing samples (the

characters were separated
from each other and capi-
talised) it showed an accura-
cy of 96.97 per cent. But the
software still has a long way
to go to make it useful as its
accuracy for recognising run-
ning handwriting is not so
reliable as we discovered

Price: Rs 9,980

Contact: Questa Software Systems
Pvt. Ltd “Netspider”

Phone: 022-8633514

E-mail: sales@netspiderindia.com

Web site: www.netspiderindia.com

_——-~ when we tested the

software with freestyle
handwriting—its
accuracy dropped
\ down to a lowly 10 per
cent! On a positive
note, the product can
; learn as it is used more
~ often—this is a time-
consuming task, worth its
while if you want the soft-
ware to operate with reason-
able accuracy.

SPECIFICATIONS

Supported languages: English,
Spanish and German

System Requirements: Windows
95/98/Me/2000/NT 4.0, Intel
486 or faster processor,

20 MB disk space, 32 MB RAM

SoftWriting CharacTell 0

Performance bbb
Ease of use SN
Value for money » » » » »
Features b rr
OVERALL L
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IBM Deskstar 120GXP hard disk

For all your data storage needs

BM ruled the performance

segment with its 75GXP
series and now its 120GXP
promises to take that legacy to
new heights. This is a 120 GB
drive (40 GB per platter) main-
ly targeted at high-end desktop
systems and entry-level work-
stations. The drive was tested
using HDTach 2.61 on a
Pentium 4 2.4 GHz powered
machine along with 256 MB
RDRAM. Its scores were aver-
age, with a sequential read
score of 38 Mbps and 24 Mbps
for sequential write speed. The
sequential write speed is fairly
low and we were quite disap-
pointed with the effort—an
average 7,200-rpm drive scores
over 35 Mbps for sequential
read/write scores. The CPU
utilisation for the drive when
tested with the high-end disk
Winmark 99 was 9.58 per cent,

which is again a little on the
higher side for drives of this
class. The average access time
of the drive was also higher at
12.1 ms, which is 4 ms higher
than the rated 8.5 ms. The

drive gets very hot while in
operation and it would be
advised not to cram it in an
overcrowded cabinet without
adequate cooling as it could
damage the drive due to exces-
sive heat.

SPECIFICATIONS
T20 GB, ATAJT00 7,200-rpm

drive, 2 MB buffer

IBM Deskstar 120GXP
Price: Rs 16,500

Perf
Contact: Wales Technology Biilngjer]i(t:e » : > > i
Phone: 022-3828100 quality L >
E-mail: Value for money » » » » »
sales@walestechnology.com Features P E P>
Web site: www.ibm.com OVERALL NN

Stepup 1.6

Data migration

cable. The migration process
is Wizard-driven where you
will have to select the type of
connection you are using and
the components you want to
migrate. This soft-
ware gives you two
migration options:
Mass Migration and
Selective Migration.
The Mass Migration
option allows you to
migrate all the com-

’I'his software from Techno
Pundits promises a fast and
reliable way of migrating data,
applications and settings
between PCs.

This program is ideal for
users who can't
remember  or
redo all of those
complicated
settings or use
floppies to
move data. In

order to transfer ponents, i.e. sup-
the data, you ported and unsup-
will require a o tleStone . ported applications,
parallel  port from the source PC

to the destination
PC. Hence, it is very likely
that some of the migrated
applications not supported by
this version may not function

with a parallel cable or an

Ethernet card with a direct
crossover cable. Unfortunate-
ly, this version cannot trans-
fer data with a USB crossover

FICM 84

as desired. On the other
hand, Selective Migration
gives the user the flexibility of
selecting the components to
be migrated. For ease of use,
the settings are organised
into four groups: desktop,
network settings, applications
and data explorer.

Overall, the software is
easy to use and is invaluable
to those who frequently
change setups or to system

Price:Rs 1,223

Contact: Techno Pundits Systems
Private Ltd

Phone: 044-6524327/28

E-mail: vanitha_gopalan@
technopundits.com

Web site: www.technopundits.com

administrators who want to
replicate system settings across
a network. However, this pro-
gram has certain limitations
such as the absence of support
for Mac machines or DOS-
based applications.

SPECIFICATIONS

System Requirements: A P-I|
processor or above, 64 MB
RAM or more, 45 MB of hard
disk space, parallel port or net-
work card with UTP interface

StepUp 1.6 @
Performance [ SN
Ease of use [
Value formoney » » » » »
Features [ SN
OVERALL L i o

ADCOM DG-300 TOY-CAM

Just point and click

e DG-300 TOY-
CAM has a radical
shape and supports a
maximum resolution |,
of 640x480. It sports 8 -
MB of memory with a
USB 1.1 interface,
which makes connect-
ing it to the PC easy
and fast. The cap-
tured image is
around 225 KB in
size, and 36 images
can be stored on aver-
age. Strangely, the camera
allowed only 26 images to be
clicked in one go when we
tested it! We could not get past
this limitation despite trying to
use a lower resolution of
320x240. The image appeared
grainy when uploaded on the
PC using the bundled software.
ZLink Photo123 allows the user
to add effects to the image such
as distort image, pentagon fil-
ter and cubic photo. The shape,
however, is very awkward,
which makes taking pictures a

/

@ ! tad difficult for users

. /' with big hands and
) - |

§

the button placement
makes it difficult to
keep your hands stable
while clicking. The camera
runs on two AAA batteries
when detached, and when
connected to the PC, it
draws the power
irectly from the
USB interface. It's
capable of capturing
video at five different
settings (640x480, 352x288,
320x240, 176x144 and
160x120 pixels). The rubber
stand provided with the cam-
era doesn’t provide enough
grip and causes the camera to
drift when the cable is
stretched. The camera is good
for younger users and makes
for a fun birthday gift.

SPECIFICATIONS

300 K pixel CMOS sensor, 8 MB
built-in memory, USB 1.1 com-
pliant, maximum resolution of
640x480

Price: Rs 4,600

Contact: Advantage Computers
India Pvt Ltd

Phone: 022-8260215

Fax: 022-8258335

E-mail: advantagetime@vsnl.net
Web site: www.advantagetime.com

ADCOM DG-300 e
Performance A b p
Build quality P r P
Value for money » » » » »
Features .
OVERALL o S o o
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Sony CRX85U CD-RW/DVD-ROM

combi drive

Write said Fred!

he Sony CRX85U

combi drive can
write data on CD-RW at
speeds of 20x and read
DVDs at a maximum
speed of 8x. The drive
has support for the USB
2.0 interface and comes
bundled with a rather
unusual interface cable—
basically a USB to ATAPI con-
version cable. The drive is
powered by an external power
source, which makes it cum-
bersome to carry around. The
drive is very slim and light,
and the lid can be opened
only when it is powered. In an
un-powered state, the lid can
be opened by using the man-
ual eject switch located
underneath the drive.

The drive took 9 minutes
14 seconds to burn a 700 MB
CD-R with assorted data. This
is slower than an internal IDE
16x CD-Writer. It’s equipped
with an 8 MB buffer, which is
sufficient to eliminate errors

Price: Rs 30,000

Contact: Rashi Peripherals P Ltd
Phone: 022-8260256/59

Fax: 022-8221012

E-mail: ho@rptechindia.com
Web site: www.sony.com

Click’N Design 3D

while burning at speeds as
high as 20x.

The CRX85U comes bun-
dled with B’s Recorder Gold
that makes the task of burning
CDs very easy, even for new
users. The package also con-
tains B’s Clip for simple file
copy operations along with
Videolmpression and Photo-
Base for video and image edit-
ing. Sony has also bundled
Retrospect backup software,
which lets you backup your
hard disk data onto a CD.

SPECIFICATIONS

20x CD-R, 8x CD-RW, 8x DVD-
ROM, 24x CD-ROM, 8 MB
onboard buffer, USB 2.0

Sony CRX85U

Performance P
Build quality NS
Value for money » » » » »
Features PP
OVERALL L

Design-yer label

lick’N Design 3D is a

comprehensive CD label
and jewel case label
designer. It allows
you to create and g
design professional v_%
looking CD labels =
and jewel case labels 3
with minimal effort. =
This application has
built-in, ready-to-use
images and you
can create 3D text
with different colous
effects. You can also

FICM 86

add different effects such as
Emboss and Oily to the 55 dif-
ferent images
bundled in
addition to cus-
tom images. An
important
functionality
that is built
into this soft-
ware is its abili-
ty to create bar-
codes  using
different stan-
dards  predefined

within the software—just type
the text and the barcode will
be generated automatically!
The software has a very sim-
ple and intuitive interface,
with self-explanatory icons.
Click’N Design 3D is a good
choice for CD authoring hous-
es and software developers

Price: Rs 2,250

Contact: Microware Computer
Services

Phone: 022-8729725

Fax no: 022-8727446

E-mail: sales@mwcdrom.com
Web site: www.stompinc.com

MONARCH FX Creator

who create different CD/
DVDs and other such storage
media.

SPECIFICATIONS

System Requirements: Windows
95/98/Me/2000/XP, Pentium
200 MHz or faster processor, 32
MB RAM (64 MB recommend-
ed), 25 MB free disk space

Click’N Design 3D @
Performance P> >
Ease of use NS
Value formoney » » » » »
Features NN
OVERALL [ O 2

The FX effect

he FX Creator is an audio-

video mixer, developed in
India by Monarch Video
Vision. It works flawlessly
and comes complete with
both the hardware and soft-
ware required for real time
audio and video mixing. The
package allows you to per-
form complete audio and
video editing and mixing just
like any electronic audio-
video mixer. The software is
fairly easy to operate and
comes with a very informa-
tive demo that demonstrates
the software’s  working.
Surprisingly, these demos are
in Hindi and are narrated
well, with every aspect of the
software explained in com-
plete detail.

FX Creator comes with
four video inputs (two each
for composite video and
S-Video), you also have four
stereo audio mixers with one
mike input and two stereo
outputs for online audio mix-
ers. It can output at a broad-
cast quality resolution of
720x576 with a  two-
channel digital timebase
corrector that enables faithful

Price: Rs 78,000

Contact: Monarch Video Vision
Phone: 022-2619022/2705555
Fax: 022-2618706

E-mail: viren@bom2.vsnl.net.in

Web site: www.monarchvision.com

copying of video
data.

FX Creator is extremely
useful for videographers and
post-production studios. It is
rated to run on a system with
a Pentium 133 MHz or higher
processor, 128 MB RAM and a
minimum of 10 GB hard drive
space. We found this reference
system slow for its applica-
tions but it ran well when we
used a 1.5 GHz processor with
256 MB RAM. The product
also comes with a one-year
replacement warranty.

SPECIFICATIONS

4 video inputs, 4 channel
stereo audio mixer, 2 graphic
inputs, 2 video outputs, 2
channel digital video mixer
with 2 full frame TBCs and 2
channel video processor for
brightness, contrast and satu-
ration

MONARCH FX Creator @
Performance PP
Build quality P r
Value for money » » » » »
Features SN
OVERALL [ S o
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Blue Eye USB 2.0 portable

hard drive

All that you can’t leave behind

r I Ye Blue Eye portable hard
drive is a USB 2.0 compli-

ant drive that fits into your
shirt pocket. It draws
power from the
USB interface
and is virtu-
ally silent
while operating.
The drive specifica-
tions clearly state that it
is a USB 2.0 compliant device;
yet it failed to operate on a
variety of motherboards sup-
porting this standard.

The drive was consistently
detected as a generic USB 1.1
drive and the scores for data
transfers were quite abysmal.
When a single 711 MB data
file was transferred, it took
about 11 minutes 57 seconds,
equating to a data transfer
rate just under an MB per sec-
ond. The drive is available in
5, 10, 20, 30 and 40 GB capac-

Price: Rs 16,500 (for 30 GB)
Contact: Wales Technologies
Phone: 022-382 8100

E-mail:
sales@walestechnologies.com
Web site: www.ibm.com

Since the drive is
available in
larger capac-
ities, the USB
2.0 func-
tionality
becomes all
the more critical
when working with
large files. You may
want to wait for newer
drivers that enable the USB
2.0 compliance before pur-
chasing the drive.

Apart from this limitation,
it is a good portable solution
and will lend itself well to
users who have to transfer
files from place to place on a
daily basis in a rugged and
compact form factor.

ities.

SPECIFICATIONS

CD in your CD-ROM drive
and load the drivers. Having
done that, you have full con-
trol over the keyboard’s vari-
ous buttons.

A nifty joystick type of
cursor controller 1is also
offered, which substitutes the
functions of arrow keys but
takes some time getting used
to. However, the keyboard
poses a disadvantage for typ-

USB 2.0 compliant, available in
5,10, 20, 30 and 40 GB
capacities

Blue Eye USB 2.0 B
Performance »

}
Build quality > >
Value for money » »
}
»
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Frontech Gold JIL-7050 Smart

Office keyboard

Keyway to the Web

rontech Gold Smart Office

keyboard is the next step in
the natural evolution of a
peripheral that is central to
computing. It provides addi-
tional keys for Internet brows-
ing and Microsoft Office appli-
cations. A user can perform
standard browsing functions
such as refreshing a page and
navigating forward and back-
ward between Web pages with
the special keys provided on
the keyboard. For the music
maniacs, this keyboard pro-
vides buttons for complete
volume controls as well as
mute functions right above

FEM 87

the numeric keypad. It also
has keys for the standard audio
functions such as play, stop,
next track and pervious track
and works well with Winamp.

Installation of the key-
board is simple. Just attach
the keyboard to your
machine, put the installation

Price: Rs 1,700

Contact: Jupiter Infosys Ltd
Phone: 022-2001211

Fax: 022-2001214

E-mail: frontech@bom?2.vsnl
.net.in

Web site: www.frontechgold.com

2XExplorer 1.3.1

ists who are used to hitting
the [Spacebar] right in the
middle—the middle section
of the [Spacebar] is thin (this
is where the joystick is locat-
ed), making it a little
awkward. Other than these
minor nags, this is a very
utilitarian keyboard and
is relatively well priced.

SPECIFICATIONS
PS/2 keyboard

Frontech Gold JIL-7050 o
Performance P h P
Build quality > P b > >
Value for money » » » » »
Features P r P
OVERALL [
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Replacement file man

xExplorer is a file

ager

L

hn mask de e sy oo ef

manager that com-
bines the ease of the

sk

standard Windows
explorer with the func-
tionality and speed of
an old school dual-
pane file manager.
2xExplorer scores over
Windows Explorer with its
more sophisticated viewing
filters and a beefed up file
search tool. It has an in-built
viewer that works with many
popular graphics formats as
well as HTML and Office doc-
uments and a file and folder
shredder that ensures the
complete destruction of any
file you wish to delete.
Another feature that we
found very useful is its ability
to print listings of folder
contents.

However, getting the
hang of all these features
does take some time. Users
will need to memorise the
many shortcut combinations
before they can really benefit
from this package. Configur-
ing the toolbars takes a while
initially, but is definitely
worth the time spent. What

i

1l

Price: Freeware
Web site: www.netez.com
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really makes this software
special is the fact that most
tasks are just a shortcut away,
boosting the speed at which
the work is done. It provides
support for bookmarks and
Internet-style back/next fold-
er navigation, as well as
auto-completion for paths
and other frequently typed
information.

It is a good choice for
power users and those who
are just looking for simplicity.
Plus it’s completely free and
takes up very little system
resources, making it definite-
ly worth the install.

SPECIFICATIONS
Windows 95/98/Me/2000/XP

2xExplorer 1.3.1.12 @
Performance SN
Ease of use P r bR
Value for money » » » » »
Features YN ES
OVERALL S
AUGUST 2002



test drive »

m reviews

SUMOKU Alpha-1 desktop speaker

Vibrant music

UMOKU Alpha-1 desktop

speaker from Palesha elec-
tronics is a relatively new
name in the speaker market.
This desktop speaker looks dis-
tinctly different from the gen-
eral lot of speakers. Its body is
made of wood with sharp
edges. The front cover is dark
blue with hardly any design
appeal. The set comes with a

produced by the speaker was
pretty decent with good treble
and midrange reproduction.
Bass reproduction was average
and this could be attributed to
the fact that it has no sub-
woofer and employed full
range satellites to reproduce
the entire audio frequency
range. There was a perceptible
distortion when heard at full

simple stereo setup (right and
left satellites and a separate
amplifier). The speaker can be
plugged to the amplifier unit,
which is a bit heavy.

This unit has a simplistic
front panel comprising of a
power button, power LED, vol-
ume and bass controls on the
front panel. The sound quality

Price: Rs 950

Contact: Palesha Electronic
Industries

Phone: 9120-6355702

Fax: 9120-6353861

E-mail: palesha@vsnl.com

volume, especially with high
frequency sounds. The speaker
is recommended if you want
a desktop audio solution
with decent sound at a very
affordable price.

SPECIFICATIONS

7.5 cms paper cone, 5 watts
RMS and frequency response of
50 Hz to 15 KHz

SUMOKU Alpha-1 @
Performance NS
Build quality N
Value for money » » » » »
Features |
OVERALL N S

Browser Lock 7.30 Home Edition

Safety Net
Internet

With usage
spreading so widely

among corporate and educa-
tional institutes, it becomes

imperative to keep a check
on Internet activities. Brows-
er Lock is a solution that pro-
vides a combination of both
a personal Internet
| portal (you can create

Tigm
Swner Tenlepl o | dn B

personal maps for users
to navigate the Inter-
net) and a Web access
filter, thereby allowing
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users to block access to
unacceptable content.

i L 9 | rl.-r-.-c.-ql rl.-un.-ulql n.-1.-|.-.|-||

This software works on

= the basis of a ‘White

List’ of acceptable content.
You will only be able to
browse to those sites that are
mentioned in the list and in
order to add or remove the
contents from the list, you
will have to supply the right
password. It already comes
with a list of over 7,000 sites
categorised as business, edu-
cation, computing, sports,
etc. For auditing purposes,
one can set time limits for
users to surf the Net and
log usage. The developers
provide free regular updates
of acceptable URLs, which

Price: Rs 2,498
Web site: www.browserlock.com

CorrezZone 2.0

allow the users to update
their ‘White List’.

This software is highly
recommended for schools,
colleges and corporate insti-
tutions which would like to
monitor and restrict Internet
access.

SPECIFICATIONS

System Requirements:
Windows 95/98/Me/2000/XP,
Pentium processor and 32 MB
RAM, 10 MB free disk space

Browser Lock 7.30 B
Performance L
Ease of use NS
Value for money p » » » »
Features > r >
OVERALL [ O o

Correspondence zone

orreZone is a correspon-

dence management soft-
ware designed especially for
users who have to draft a
number of mails and

letters on a daily — ————

basis. It comes @
along with a hard-
ware lock, which
has to be installed
for it to work. The N
hardware lock is
attached to the par-
allel port, but at the
same time provides
another parallel port
for alternative uses.

CorreZone allows you to
classify your correspondence
in various customised or pre-
defined categories (customer
correspondence, bank corre-
spondence, business corre-
spondence, etc). The package
also has bulk mailing func-
tionality  integrated—with
one single operation you can
print/fax/mail the same letter
to multiple recipients.

The software supports

Price: Rs 9,500

Contact: Durga Infotech

Phone: 044-6440414

Fax: 044-8727446

E-mail: support@correzone.com
Web site: www.correzone.com

CO”Zane

Microsoft Access, Microsoft
SQL Server, Oracle and
MSCDE databases, and uses
them as its backend for
archiving and retrieving data.
Other features include
inter-office memos,
letter drafting func-
tionalities, phone
diallers and an
interoffice chat client.
The software is
easy to use with a
function-driven
menu structure. It also
comes with a detailed manu-
al and a step-by-step ‘install
and use’ guide. Coordinators,
PR managers and executive
secretaries will find it very
useful. A single user license is
available for Rs 9,500, which
does seem a tad expensive, if
you don’t use it on a regular
basis.

|

SPECIFICATIONS

Windows 95/98/Me/2000/XP,
Pentium 166 MHz, 32 MB RAM
75 MB hard disk space

CorreZone 2.0

Performance .
Ease of use PP
Value for money » » » » »
Features NS
OVERALL [ L
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y quest for a new keyboard and
Mmouse began with a coffee
mishap, a fatal accident involv-

ing the unscheduled merger of hot sug-
ary liquids and the deep crevices
inside my keyboard. For the next
two days I had the most frustrat-
ing and embarrassing chat ses-
sions with my friends. Then my
mouse died on me in the middle o
of a gaming session. Thus began |b
Mission: Input Devices.

Even the smallest hard-
ware store in my suburb had
a variety of cheap keyboards
and mice. There’s a glut of
brandless Chinese and Tai-
wanese mice available
for as low as Rs 120. I
personally hate these
cheap Chinese makes.
They aren’t ergonomic,
have no scroll features, and the
buttons feel tacky.

The basic Samsung and Acer key-
boards were rated ‘sasta and
tikau' by a dealer in And-
heri, Mumbai, and were
among the most afford-
able keyboards I came
across. While these
keyboards did not
have any extra fea-
tures such as additional shortcut keys, at
Rs 500 and 300 respectively, I didn't
expect anything more. Iliked the way the
keys felt soft and responsive and they did-
n’t make too much noise—that’s all I
wanted from a keyboard.

A dealer in Borivili, Mumbai, had a
stack of iBall mice in different colours. I
liked the iBall mouse—it’s a good buy for

400 bucks and it can scroll vertically
and horizontally with acceptable

precision. The PS/2 Logitech

T

%
SHOPPING

A I!'j = Do not buy the mouse if the

mouse ball is hollow and light; it
translates into poor movement.
= Consider yourself to be the Joe Satriani of
touch typing? If you never look at the key-
board while you type, you qualify. Buy
yourself a natural keyboard, where the keys
are divided from the centre at an ergonom-
ic angle to make touch typing easier.
= Optical mice are more expensive than
PS/2 mice, but they are very durable since
they have no moving parts. Plus they are
more accurate.

it}

Agent 001 scours the streets in search for a keyboard and mouse

scroll mouse, selling at Rs 650, was rated
a hot item according to him. It’s versatile,
durable, accurate and ergonomic. I high-
ly recommend it for its price.

If you want a multimedia keyboard
with shortcuts to the Internet and multi-
media applications, try the Maple Internet
Media keyboard—it features a good layout
and includes 15 programmable keys along
with eight exclusive function keys—all for
a cheap Rs 775. I also took a liking to
Logitech’s Deluxe Access 104 keyboard for

= Buy a keyboard with wrist support—it
will help you during extended typing
sessions.

= Suffer from calloused wrists? Buy a
trackball mouse, you will never have to
move your hands again—just your fingers!
= Infrared or radio frequency cordless
mice are ideal if you yearn for an unclut-
tered desktop.

= PS/2 mice are more responsive than
serial mice as you can tweak them to
operate at a higher refresh rate and are
definitely recommended for gaming.

@J{&'
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Rs 730. With quick access buttons for
Internet-related tasks, an ergonomic
styling and a palm rest that helps during
extended typing sessions, this keyboard
looked like a good buy. If you are
a touch typist who doesn’t look
at the keyboard, try the EKB804
from Maple—the keys are divided
in two halves for easier access by
each hand.
A little later I came across a
dealer who only stocked A4-
tech mice—double scroll
mice, five-button mice,
trackball mice, infrared
trackball mice with scroll
buttons, radio frequency
wireless trackball mice—he
had them all at under Rs
1,000. The WWT 5E trackball

(___-':} mouse with two scroll wheels

and a programmable third but-
ton looked tempting at Rs 800.
There were prettier versions of the
same mice too, with a translucent
iMac-like design for Rs 100 extra.
While optical mice are more
expensive than conventional mice,

and can be used on any

surface. Their prices

have fallen over the
last few years—the Logitech White Optical
was only Rs 1,200, while the WOP35 from
Maple was available for Rs 1,100. And if
you go in for a keyboard and optical mouse
combo, you could get them both for less
than Rs 2,000—a steal if you ask me.

The Cordless Freedom Optical key-
board and mouse combo from Logitech
is the ultimate combination. There are no
cords, the keyboard has Internet and mul-
timedia keys that allow you to connect to
the Net and control MP3s, DVDs and
CDs, and the optical mouse is ergonomi-
cally designed (although it’s more suited
to right-handers). However, at Rs 8,000,
this combination is certainly not for
everyone. I drooled over the trackball
mice from Logitech—it’s the lazy man’s
pointing device that needs only the twid-
dling of the fingers with no wrist work
and is very comfortable to use once you
get used to it. But it’s expensive at
Rs 5,000.

After doing the rounds of the mar-
ketplace, I looked in my wallet, and final-
ly settled for the Samsung keyboard and
the iBall mouse for Rs 800—after a little
bargaining, of course.
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Of the many wireless technologies mushrooming around us,
GPRS may be the most important for wireless communications

rom cordless phones to mobile
phones, wireless communication
has seeped transparently into our
daily lives. Wireless technologies
have far reaching applications but have
gained popularity and acceptance only in
the field of voice communication.
Wireless data access such as sending
memos, exchanging e-mail, scheduling
appointments, etc is still not widespread,
largely due to very slow connection
speeds. Even the development of the
Wireless Application Protocol (WAP)
hasn’t helped much—you cannot browse
existing Web sites or access your data until
they are converted to the WAP format.
General Packet Radio Service (GPRS) is

diditk*)]

the first wireless service that addresses the
need to access any information at all times.
It provides an always-on connection to the
Internet and works with existing Internet
standards, tremendously increasing its
applications. GPRS works over the existing
Global System for Mobile Communications
(GSM) networks, making it easy and inex-
pensive to set up, since this is used by most
mobile service providers today.

Other mobile service providers use a
standard called Time Division Multiple
Access (TDMA). They are also tilting
towards GPRS with a wireless technology
called Enhanced Data Rates for Global
Evolution (EDGE). EDGE and GPRS are
both based on similar infrastructure and

protocols, except that EDGE uses a more
sophisticated radio interface.

The family tree

Cellular technologies have come a long
way since their birth, evolving in phases
called Generations (G). Each generation
takes the technology a step further,
providing exponentially higher data rates
and better bandwidth efficiency, and
allows the possibility of more mobile
applications.

Second generation (2G) protocols
include GSM, TDMA and CDMA (Code
Division Multiple Access), and use digital
encoding. The 2G network protocols
support voice and some limited data
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communications such as fax and SMS, and
offer different levels of encryption and
security. These protocols are primarily
used for voice communication over
mobile phones.

GPRS marks the transition into 2.5G.
GPRS is a radio technology for GSM net-
works that adds packet-switching proto-
cols and the possibility for billing by the
amount of data sent, rather than connec-
tion time. Packet switching is a technique
whereby the voice or data is broken up
into small chunks of data, which are then
routed by the network. EDGE will also be
a significant contributor to 2.5G. It is an
enhanced modulation technique designed
to increase network capacity and data
rates. GPRS supports flexible data trans-
mission rates as well as continuous con-
nection to the network, thus making it the
most significant step towards 3G.

3G, the Third Generation protocol, is
a new network technology being devel-
oped for mobile operators. The Universal
Mobile Telecommunications System
(UMTS) will support much higher data
rates, allowing true broadband on mobile
devices. 3G networks are already emerg-
ing in Japan (NTT DoCoMo is the first 3G
network) and some parts of Europe.

2G networks provide about 9.6 Kbps
throughput and 2.5G networks increase it
to around 56 Kbps. 3G technologies prom-
ise upwards of 100-300 Kbps initially, and
aim to shoot up to 4 Mbps over time,
allowing a range of high-bandwidth
multimedia services on mobile devices.

Why GPRS tops

GPRS is built over existing standards, both
wired (the Internet) and wireless (mobile
communications). Hence, its applications
are many and implementation is easy. It’s
fast, secure, packet-based, and has Quali-
ty of Service (QoS) features.

So far, most voice communication
happens over circuit-switched networks.
Because of this, users have to set up a ded-
icated connection before they can com-

-
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The Good and the Bad

Wireless Technology Advantage

Disadvantage

GSM

Widespread; devices easily
available and economical

Limited applications; maximum
bandwidth 9.6 Kbps

GPRS Easy to upgrade from GSM; Devices expensive; not many
many aplications available yet

EDGE Easy to upgrade from GPRS; Devices not readily available; limit-
maximum bandwidth 384 Kbps ed bandwidth currently available

UMTS Data rates up to 2 Mbps; can Service not widespread; still under

grow to 4 Mbps

municate any information. Hence, when
you make a phone call from a landline, a
single channel is allocated entirely
between you and the receiver. Though this
is taken care of by the service providers
and is completely transparent, it means a
huge waste of resources—the channel is
locked between two people even when no
data is being transferred. With a packet-
based service, more users can be support-
ed over the same channel. The most pop-
ular packet-based service is the Internet.

Just like dial-up Internet connections,
mobile devices will have an IP address,
either static or dynamic. IP packets can
originate and travel along the entire net-
work, for example, from your PDA to your
e-mail service provider. When you send
information over the available channel,
the packet contains details such as who it
is from and who it is meant for. Thus, sev-
eral packets can travel on the same chan-
nel without getting mixed up and reduce
the amount of total bandwidth that is
required to support multiple users.

There are several speeds at which
GPRS is available. The service providers,
depending on how much they invest on
the infrastructure, can control this.
Theoretically, the maximum rate is
around 114 Kbps, though initially we
would see much lesser speeds.

QoS, another standard network pro-
tocol, can be enabled on GPRS and turns
out to be extremely advantageous at low
speeds. QoS allows priority allocation to
certain types of data packets over

e

development

others. Thus, applications can define the
importance of the data and take up only
limited bandwidth, freeing up bandwidth
for other applications. For example, you
can set e-mail to be received at low speeds
and use the rest of the bandwidth for
videoconferencing.

GPRS is also being evolved into much
faster standards such as Wideband Code
Division Multiple Access (W-CDMA), a 3G
wireless standard.

How GPRS works
GPRS works over existing GSM networks.
Two devices, the Serving GPRS Support
Node (SGSN) and Gateway GPRS Support
Node (GGSN) convert the circuit-switched
network to a packet-switched one. When
connecting to the Net, either from the
phone, laptop or handheld, the phone
sends out signals to the nearest base sta-
tion. The base station relays the data to
the base station controller that communi-
cates with the Mobile Switching Centre.
The Mobile Switching Centre connects to
the GPRS devices via a Home Locator Reg-
ister, which tells your account profile to
the network. The SGSN tracks your loca-
tion so that it can keep the communica-
tion alive. It also compresses and encrypts
the data. The GGSN assigns an IP address
to the cell phone and maintains your
account logs. It can connect you to other
mobile networks just like the roaming
service on a cellular phone (see infograph-
ic: The GPRS Network).

GPRS networks use 200 KHz radio

of Wireless Technologies
E Y 4 ¥ r T
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channels, with each channel divided into
eight slots, each of which can support
a throughput of 13 Kbps. Theoretically, a
user can use all eight slots simultaneous-
ly, but service providers are likely to limit
the number of download slots to four or
less, and upload slots to one, to allow
more concurrent users.

Putting it to use

Surfing on a cell phone may not be fun,
given the display area, but you can use it
to check your e-mail, news and even
sports scores. For heavy-duty tasks, you
can connect the phone to a handheld or
a laptop and use it as a modem, giving
you complete access to the Net.

With more bandwidth, broadband
applications such as Voice over IP (VoIP)
and videoconferencing will be possible.
As the service becomes inexpensive, these
options will become more viable and may

Security Concerns

Security over GPRS is at various levels.
The user must have a Subscriber Identi-
fication Module (SIM) card to use the
service. The network can request a
password using common password
protocols. GPRS also encrypts the link.
Over external networks, carriers can
optionally employ the IPSec protocol.
Finally, since communication is based
on IP, any security architecture used
over IP, such as Virtual Private Networks
(VPN), can also be used with GPRS.
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even save on communication costs—you
can use an IM or VolIP instead of STD and
ISD. GPRS phones already allow you to
send SMS messages over the Internet
instead of the GSM network, thus cir-
cumventing the charge for the SMS.

GPRS tools

GPRS devices are of three kinds: Class A
devices can handle voice and data simul-
taneously—you can receive a voice call
even while IP data is being transferred.
Class B devices can handle voice and
data sequentially. The network will noti-
fy you of an incoming call, but you will
have to suspend the data session to
accept it. Class C devices can handle
only data.

To use GPRS, you need a GPRS-enabled
phone that can be connected to a laptop or
a handheld and used as a modem as well
as a browser. Some of the GPRS-enabled
phones available in India are:

Sony Ericsson T68i: This slick phone
has an impressive colour display. It
supports GPRS, Bluetooth, High-speed
Circuit-Switched Data (HSCSD), Triple-
band GSM (900/1800/1900), Enhanced
Messaging Service (EMS) and WAP 2.0.
SyncML synchronises the online calendar
and contacts, and the Wireless Transport
Layer Security (WTLS) class 3 provides
security during mobile commerce
transactions.

Siemens $45: It has 360 KB of onboard
memory and its internal data formats are
compatible with traditional PC formats
such as wave, MIDI, text, etc. The S45’s
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high-resolution screen, though mono-
chrome, can accommodate up to seven
lines of text and is a boon for browsing
on the phone.

Nokia 8310: This is Nokia's first GPRS
model, but the five-line display may not
be the best for surfing. It also has an FM
receiver, but supports only mono audio.
Philips Fisio 820: The colour display
makes for better browsing—the phone
supports GSM 900 and 1800, GPRS, WAP
and Bluetooth.

Footnotes

Wireless technologies are fast developing
to keep up with the ever-growing needs of
mobile users. GPRS can currently give
theoretical rates of up to 114 Kbps and this
is being pushed to 160 Kbps. EDGE offers
far better performance, with a maximum
theoretical throughput of 384 Kbps.

The next generation of GPRS, Wide-
band CDMA, also referred to as the Uni-
versal Mobile Telephone System (UMTS),
is one of the standards approved as a 3G
cellular technology. It provides data rates
of 144 Kbps when mobile, 384 Kbps out-
doors at pedestrian speeds and 2 Mbps
indoors. It uses an entirely new radio
technology based on 5 MHz channels, but
retains the GPRS architecture and uses the
SGSN and GGSN nodes.

The GPRS infrastructure can actually
become the core network for 3G systems,
supporting a variety of multimedia
services including voice, text, digital
images and video on mobile devices. d|
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multimedia PC

ovies are probably the most
engrossing and popular of
all communications and
entertainment media. A well
made movie is one that enchants all the
five senses, suspending reality for a brief
period of time. Remember how your heart
skipped a beat when the T-Rex thumped
onto the screen in Jurassic Park? Or the
prickly feeling you got while watching Evil
Dead? The numbness you experienced
when the girl screamed away in The Blair
Witch Project? Once the domain of a hand-
ful of professionals, advances in comput-
ing have evolved to such an extent that
almost anyone can now make videos on
their desktop.

The toughest hurdles in making
movies have always been the expensive
equipment and complicated software
involved. We don’t need either for mak-
ing personal videos. With low-end digital
video (DV) cameras and Web cams becom-
ing very affordable, making movies is a
hobby that can now be enjoyed by almost
anyone. Software too is very abundant
and easily available. So all you need to
do is plug in the camera, install the
software and shoot away to your
first video. Home video no longer
needs to be shaky with poor picture
quality—very powerful tools help
create the perfect picture and add a
lot of cool effects. Transitions, fade

effects, sound effects, freeze-
frames—all these and more are
possible with basic tools.

The biggest advantage that
digital video has over the old
analogue way is the introduc-
tion of non-linear editing—you
can cut, copy, paste, delete, add

Movie making is no longer just a Bollywood business. You
don’t need professional tools to make magic, just a basic

and merge chunks of video just as you
would edit a Word document. Also, you
don’t need to manage piles of video tape.
You can preview the video as you capture
it and re-take it as many times as you want
without worrying about wasting reels of
film. Mixing and matching the good parts
of all the clips is a breeze.

Your baby boy’s first steps or your
daughter’s third birthday—you can cap-
ture these precious moments, burn them
onto CDs and cherish them forever, with-
out worrying about dust, fungus, or mois-
ture damaging the video. You can even use
video for making presentations and sales
pitches—a concept video will certainly
make a bigger impact than a slideshow of
projection graphs.

Filmy fundas

Knowing the basics of digital video is the
key to creating smooth, error-free and
good quality movies. Here are some things
you should keep in mind.

Resolution: Resolution not only deter-
mines the height and width of the movie,
it also directly affects the movie quality
and the file size. Also, at higher frame
sizes, more processing power is used, so if
the video seems jerky, you should lower
this setting. Generally 320x240 is good
enough, but you may want to capture at
640x480 if your system allows it.

Frame rate: The frame rate determines
the number of frames that make up one
second of the video. Thus, higher frame
rates mean a better quality video. The
human eye perceives smooth motion at a
minimum rate of 24 frames per second, so
a frame rate of 30 is ideal—it will look
smooth and allow for a few dropped
frames.
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For capturing video we will use Virtual -
Dub with a Web cam. VirtualDub is a very
powerful freeware and allows better con-
trol over the capture process than most
bundled software. Launch VirtualDub and
click File > Capture AVI to switch to capture
mode. You should set the resolution from
Video > Format before you start captur-
ing. Also, unless you are recording an
interview, disable Capture audio from
Capture > Settings. We will capture audio
separately and merge it into the movie.
Here you can also specify the capture
frame rate. Align the camera to set the

Dropped frames: If your PC is slow, it
may not process every frame sent by the
capture device. To keep up with the incom-
ing video, it simply drops the unprocessed
frame and fills it with the preceding frame
instead. This appears as jerks in the video.
When capturing video, keep an eye on the
number of frames dropped to see how
smooth or jerky the video will be.

Sound settings: When recording sound
separately from the video, you should use
high quality settings—record 16-bit stereo
sound at 44,100 Hz. Unlike with video,
computers today have no problem pro-
cessing high-quality sound. For the final
video, though, scale it down to 8-bit stereo
at 22,050 Hz. The sound will still be clear
and the files will be much smaller.

Interlacing: Interlacing increases the vis-
ible resolution of a video, since two frames
interleave to make one image. Interlaced
capture with low-end equipment can result
in a hazy picture, especially when record-
ing movement. The camera sends two
frames sequentially, so the two images that

On the Editing Table

After the shoot, you will want to edit the
video to remove all the unwanted parts and
resample the image resolution and quality.
VirtualDub displays two panes, one for the
source video and the other for the same
with filters applied. To cut unwanted frames
out from the video, press the [Home] key
where you want to start cutting the video
and the [End] key where this ends. Hit
[Delete] to cut out the marked area.
VirtualDub has a lot of filters to cleanup
the video too (see table, ‘VirtualDub Filters’).
Select the portion of the video you want to
clean up by clicking Video > Select range.

digitl-y/

Lights, Camera, Action!
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Open Video > Compression to choose a codec
to compress the captured video

frame you want to shoot and start cap-
turing by clicking Capture > Capture
Video. Hit [Esc] to stop recording.

make up one frame on the output may not
match. Also, the computer needs to process
more frames when capturing interlaced
video. Besides, computer-generated graph-
ics are non-interlaced and when merged
with an interlaced video, may not render
well. Hence, it is a better idea to always use
a non-interlaced video.

Special effects: Video editing software
such as VirtualDub (www.virtualdub.org)
allows you to add some
basic effects to the video.
With a few combinations
of filters, you can produce
some really interesting
effects. Apart from the
bundled filters (see table,
'VirtualDub Filters”), you
can also download a lot
of filters from the Inter-
net—www.virtualdub.org
itself has a huge list you
can choose from. It is best
to apply effects filters
after you've cleaned up

Filters in VirtualDub are applied in the order
in which they are listed. Rearranging the
order may yield totally different effects and
also affects the processing time

You can add filters to process the video from
Video > Filters . Click Add to add and config-
ure the filters. Each filter will bring up its dia-
log box where you can configure it. Most of

Let there be Light

SoundForge 6.0, Virtual-
Dub 1.4.10, Avi Assem-
bler 1.2, DivX 5.02 Codec
Find them in Software >

Multimedia on the Mindware CD. Plus,
video clips in Surge > Samples on the
Playware CD for you to experiment with

the video or at the last stage when you are
generating the final video. The more fil-
ters you add, the slower will be the pro-
cessing, though.

Video compression: Video compression
codecs are not perfect—they cannot out-
put exactly the same image as the origi-
nal. The codec tries to estimate what
differences would be invisible to the eye
and removes them. The advantage is you
can control how big the video file gets by
changing its visible quality. Compression
artefacts (noise in the video) result from
high compression and the amount of
noise varies across algorithms.

DivX is the best compression format
available. It compresses video to ridicu-
lously small sizes without too much loss
in quality. DivX 5, the latest version, uses
Variable Bitrate (VBR),
ensuring the smallest
possible size with the
highest possible quality
for each frame. Several
people have been devel-
oping the DivX codec for
a while now and it is
actually available in
many different flavours.
The codec can be down-
loaded from www.divx.com.
(For more information on
DivX, refer to Digit, March
2002.)

them allow you to preview the effect of the
filter on the fly. With each filter you add, the
preview will include effects of all preceding
filters. You can rearrange the order of the fil-
ters once you have added them.

You can also crop the video by clicking
the Cropping button. VirtualDub does not
allow you to crop a video without a filter, but
you can use the Null Transform filter, which
does not affect the video at all, but just pro-
vides an interface to allow cropping. Once
you have set up all filters, click Video > Full
processing mode—the filters will not be
applied without this—and save the video.
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Mic Testing

Capturing audio is probably the easiest
part of the movie-making process. All you
need is a microphone, WAV recording soft-
ware like SoundForge and a good voice.

Adjust the microphone level from the
volume controller until the sound is clear
and there is no background noise affect-
ing it. You
can also
record a
clip with
variations
in pitch
and play it
back to
ensure that
it is clear.
Launch
SoundForge and click Special > Record to
bring up the recording options. Click the
Record button to begin recording.

To delete parts of the captured audio,
simply select the range and press
[Delete]. The Process menu has some
very useful options to enhance the
sound. Normalise, Smooth/Enhance,
Time Compress/Expand and Volume will
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Set up SoundForge for
recording
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Create a wave file of the same length as
the video

be the ones you'll use most often when
editing sound for video. Of these, the
most useful one is Time Compress/
Expand. Ideally, it is best to have a wave
file of the exact same length as the video
for perfect synchronisation. Once you
have finished editing the sound and kept
only the parts you require, use this func-
tion to expand or compress the length of
the track to match the length of the video.
You can get the length of the video from
VirtualDub.

For accurate audio-video synchronisa-
tion, it is best to have a single final wave
file. You can work with multiple audio
samples, but once you finalise them,
merge them all in sequence into a single
track. Merging audio files is as simple as a
copy-paste operation.

diditE°}:]

Great Stills

You can add still images, photographs
and computer-generated graphics such
as graphs or transitions to your video
too. For this, we will use a tool called AVI
Assembler. Start AVI Assembler and click
Add Images.
You can select
any BMP, |PG
- : or GIF files

e and add them
to the list. Set
the FPS, width
and height to
the same

Create video from a set
of bitmaps

Creating VCDs: For burning VCDs, you
will have to encode the video in MPEG-1
format. Though not as good as DivX,
VCDs are more widespread and can be
viewed on conventional VCD players. The
only other way is to create a completely
uncompressed video file, which is not
only unwieldy, but may also be impossi-
ble—just a 10 minute video can take up
to 8 GB of disk space!

Going online: If you are looking to host
your video on the Internet, do everything
you can to get the file size down to the
minimum possible. It would also be a
good idea to provide videos of different
resolutions and quality so that the viewer
may choose depending on his bandwidth.
Streaming is a totally different ball game.
You would need to install a streaming
server and encode the files specifically for
streaming. Windows XP comes bundled
with Windows Media Tools that allow you
to create streaming files. PlayStream

frame rate, width and height of the cap-
tured video (say, 30, 320 and 240).
Images of different sizes will be automat-
ically scaled to this size. In the box for
‘This frame should appear... times’, set
how many frames each image should
span across and click ‘Input # times’.
Multiply the number of seconds the
image should be displayed by the FPS to
calculate this value. Click AVI Operations
> AVI Parameters and set the Pixel For-
mat to 24-bit for best video quality. Click
Create AVI and choose where the video
should be saved.

(www.playstream.com) has an impressive set
of services for streaming. They can con-
vert and stream video in several formats
and though the service is not free, you can
get a free trial for 15 days.

Your hammer and nails

You can use various hardware and soft-
ware to capture and work with digital
video. Though digital video (DV) cameras
have been around for many years, they
have always been unimaginably expensive
and used only by professionals. Their
prices have reduced over the years, but
most are still beyond the reach of amateur
enthusiasts. Many digital cameras today
provide the added functionality of cap-
turing motion picture. DV cameras afford
the best quality and highest amount of
control over the capture when shooting a
video, but to connect it to your comput-
er, you will also need to invest in an
IEEE1394 addon card.

VirtualDub Filters

Filter Purpose

Deinterlace Outputs a non-interlaced video from an interlaced one

Brightness/Contrast Adjusts brightness and contrast of the video

Levels Adjusts colour levels of the video

Resize Re-samples the image resolution (height and width)

Sharpen Gives more distinct edges to the picture

Smoother Smoothens out the image and can remove noise from the video

Box Blur Adds blurring effects in increasing gradations from the centre to the
periphery of the frame

Emboss Creates a 3D embossed image

Flip Horizontally
and Flip Vertically

Flips the image horizontally or vertically

Rotate Rotates the picture by 90, 180 or 270 degrees

Rotate2 Rotates a video by any specified angle. Areas emptied due to the rota-
tion are filled with a solid colour

Invert Creates a negative of the image

Motion Blur Adds a motion effect by blurring successive images together
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Putting it all Together

You have video clips, sound and stills ready
for the final movie. It’s time to bring it all
together.
Batch convert: If you have several raw
video clips and those made from still
images, you need to join them to make the
final video. To be able to do this, you will
have to ensure that they are all at the same
resolution, frame rate and compression. If
you need to convert the videos to a single
format, you can set up a batch conversion
process in VirtualDub.

Set up the video settings and select File
> Save as AVI. Select the box next to ‘Add
operation to job list and defer processing’.

FosboaFog

Set up batch processing in VirtualDub

One of the first video capturing hard-
ware to reach the masses was the TV Tuner
card with capture functionality. On many
TV Tuner cards, the capture is software
driven. So, even if the software bundled
with the card does not allow you to cap-
ture the video, other tools should be able
to do so. Then there are capture cards,
which interface to various video input
sources. For example, these take TV or
VCR signals as input, which means you
can record your favourite shows on tele-
vision or convert your old tapes to digital
format. TV Tuner and capture cards can
only convert an incoming video stream
and cannot be used to shoot a live video.

One of the best options for amateurs
is the Web cam—they are very affordable
and have multiple applications such as
video and still capture, videoconferencing
and some can even be set up as surveil-
lance systems. Web cams do have some
drawbacks, though. They generally do not
grab good quality images. Also, the entire
processing of the video happens on the
computer, not the camera, hence, if the
system is slow, the video quality is further
affected. Again, a Web cam is useful only
for live video capture.

A powerful machine with a fast proces-
sor, loads of RAM and gigabytes of hard
disk space will yield a much smoother
movie authoring process, but even a Pen-

FM99

Repeat the same for every file you want to
convert. VirtualDub will create a batch file
for every job added this way. Open File >
Job controlto bring up the list of jobs. You
can delete or postpone jobs from here, or
simply click Start to begin converting.

Join video clips: This is the simplest
process. Open the first video file in the
sequence, then click File > Append AVI seg-
ment. Select the next file and repeat—you
can run the entire video as a single file. You
can edit it and apply filters the same way as
you would to individual files. If you are not
editing it, select Video > Direct stream copy.
VirtualDub will simply copy all the frames
from the video clips to the output file, and
not process each one. This is extremely
fast. You can save the video here or jump
to the next step of merging the sound.
Integrating sound: Once you have the
wave file of the same length as the movie,
in VirtualDub click Audio > WAV Audio to
select the sound source for the video. Click
Audio > Full processing mode and open

tium 200 system with 128 MB of RAM will
do. What you compromise on the power
of the system, you have to make up for
with patience.

For software, you can use the propri-
etary software bundled with the hardware,
or freeware such as VirtualDub. Pinnacle
Studio 7 (www.pinnaclesys.com) provides a
complete capturing and editing suite. It is
especially useful for professional effects
and is yet simple enough for anyone to
use. It can take input from several sources
and output it to a CD or even DVD. Simi-
larly, for audio capture and editing you
can use software bundled with the
soundcard, or tools like SoundForge
(www.sonicfoundry.com) or Cool Edit Pro
(www.syntrillium.com). These are all very
easy to use, unlike some of the more pro-
fessional software.

As a rule of thumb, unless you're mak-
ing video on the spot, have a script ready
before you begin shooting. Knowing how
you want the video to progress helps
tremendously and you won’t have any
missing elements when you are editing the
video clips.

Looking ahead

With the power of video on your desktop,
you can wave your magic mouse and just
let your imagination run wild. Convert
your old marriage tapes into digital video,

P
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Compress audio when integrating with the
video to reduce file size

Audio > Compression . You can select any
audio codec to compress the sound, but
MP3 is the best as it gives the best quality
sound and the highest compression.

You can also adjust the volume level of
the audio from Audio > Volume, though it
would be much better to do this in a
sound-editing application like SoundForge.
When you save the AV, it will have the
sound integrated into it.

add captions to all the funny moments,
burn them to VCDs or even DVDs, or
impress your friends with your own ver-
sion of The Matrix.

With broadband slowly encroaching
upon us, soon you will be hosting your
videos on the Web. The possibilities are
endless. You may also be able to share a
‘live telecast’ of your son’s birthday bash
in India with his grandmother in the US.
Or stream a conference from your head
office in Delhi to regional offices across
the world. TV channels should also start
telecasting shows on the Internet. Initial-
ly they would only telecast select items
like cricket matches, but one day they may
choose to run the entire channel online.

The digital video scene is only going
to get better. Expect far more powertul,
cheaper products and much easier tools in
the near future. Some motherboards
already integrate capture capabilities
onboard. Processors themselves are evolv-
ing at break-neck speed. Even with the
products available today, you can capture
at DVD resolutions. Encoding Dolby Dig-
ital sound on the desktop was not possible
until very recently—it is now.

The tools of today allow professional
quality multimedia authoring. The tools of
tomorrow promise to be even better. This
is not magic. This is reality.ﬂ

VEER KOTHARI
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here was a time when producing a high-

quality recording of your own music

would only be possible in a recording

studio, under the expertise of a sound

engineering wizard who could work all those

intimidating sliders, buttons and knobs. How-

ever, today, technology makes it possible to

build your own home recording studio,

at a fraction of the cost of professional
equipment.

If you've acquired a multimedia PC
system in the last few years, you already have
the core setup upon which you can build your
recording studio. There’s a multitude of software,
from sequencers to samplers to drum machines,
and even full-fledged effect generators, all capable
of emulating hardware audio equipment with
quality. Since all editing has moved to the digital
realm, you can process sound, add effects, mix and
edit dozens of times without any loss in quality.

Digital music isn’t a new development; musi-
cians have used computers ever since the band
Kraftwerk made its brand of techno music using
synthesizers way back in the 1970s. Today, in our
own country, Indi-rock musicians such as Demon-
ic Resurrection, Pin Drop Violence and Reptilian
Death use the PC to record their music demos. So
not only can you use your PC to produce crystal-
clear recordings of your own music, but also to
put your demos on CDs, distribute them online
and make good money from the airplay!

y

Tools of the trade

The kind of recording setup you need depends
on the kind of music you are interested in mak-
ing, and the instruments (if any) you will be
working with. As for the right platform, there
isn’t a huge difference between the Mac and
the PC for audio applications and you could
go with either one. While some experimental
synthesis tools are tailored specifically for the
Mac, today’s PC is more than up to the task of

meeting your audio recording needs.
Your PC-based recording studio can be as
basic or as sophisticated as you wish, depend-
ing upon your budget and target application. The
good news is that even a minimal PC recording

Unleash the budding musician in you—make your own music and
play it to the online world!

setup can yield superior results than the analogue
setup that used to be considered ‘cutting edge’ not
too long ago. In your base computer, a 7,200-rpm
ATA-100 drive is fast enough to handle the cre-
ation of WAV files that are critical to your audio
recording process. Obviously, the larger the hard
disk, the greater will be the number of recordings
you can store on it. Lots of RAM (256 MB at least),
and a fast CPU (over 1 GHz) will boost the per-
formance and speed, especially during the editing
stage. Sequencing software need to display a lot of
information on screen, so a 17-inch monitor run-
ning at a high resolution (at least 1024x768 at 75
Hz) is desirable. A CD-Writer is a must-have and
writeable CDs have become downright cheap—
you can expect to pay less than Rs 20 a disk.
Though this is not a required component when
you start off, you’ll soon want one to store and
distribute your music demos.

For a basic recording setup, you would have to
invest in a good soundcard such as the Sound-
Blaster Live! Value, a microphone and powered
speakers, all of which will cost you between Rs
10,000 to 15,000 (see box, ‘Professional Hardware’).
Warren Mendonsa, the lead guitarist of Zero, uses
an M-Audio Audiophile 2496 soundcard, M-Audio
Audio Buddy mic preamp and a Shure SMS58
microphone to record his guitar solos. You will
also need an outboard mixer if you plan to work
with multiple microphones, since the number of
microphone inputs on conventional soundcards is
limited to one.

The recording process
The actual process of recording depends upon the
equipment and the type of music being recorded.

SoundForge 6.0, FruityLoops
3.5, Wavelab 3.03a, BBE Sonic
Maximizer, Cakewalk SONAR
2.0 Demo, ReBirth RB-338
2.0.1, Reason 2.0

Find them in Software > Multimedia on

the Mindware CD. Plus, sound clips in Surge >
Samples on the Playware CD for you to experi-
ment with
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M-Audio Audiophile 2496 Soundcard:
While the SoundBlaster series from Creative is
heralded as a high-end soundcard series, its
features and functions appeal mainly to the
gamer. M-Audio is a professional audio com-
pany that has built a reputation among musi-
cians looking for professional-grade digital
audio. The Audiophile 2496 features full
24-bit and 96 KHz audio support, aimed at
multi-track recording. The card is fitted with
two analog inputs and outputs (one stereo
pair each) and also features dig- ~==,
ital inputs and outputs. Like e
most pro-level soundcards, it
supports full duplex and has
multi-client
support,

which means
that more

than one pro-
gram can access
the soundcard simultaneously.

! g U
SN i

Here are some possible scenarios, depend-
ing on the kind of gear accessible and
whether you want to record your music all
at once or each instrument individually. If
you have a sequencing software, you can
individually record parts of the instru-
mental and vocal sections and arrange and
edit them later. This is especially useful if
you are just getting into audio recording
and are not a ‘one-take’ musician.

Scenario 1: Spontaneous sounds This
is the most rudimentary method of record-
ing audio. Here, your band plays as if deliv-
ering a live performance and all the vocal
mics, drum mics, guitars, bass, and other
instruments are fed into a single sound-
board from where you can control the

Jargon

Full duplex:The ability to simultaneously
record and playback through the same audio
hardware. Older soundcards (Half duplex)
could either record or playback and were
unsuitable for professional applications.
MIDI: An acronym for Musical Instrument
Digital Interface, this format uses codes to
define the type of sound a musical note
plays. MIDI has no audio properties; it’s just
a set of instructions that are decoded by the
audio hardware (soundcard, synthesizer,
etc). Since actual sound data is not cap-
tured by this format, MIDI files are far
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Professional Hardware

Shure SM58 Microphone: The Shure
SM58 dynamic microphone is per-
fect for all kinds of vocal appli
cations, making it a
favourite among vocal-
ists and sound profes-
sionals. This mic boasts of

excellent sound feedback and extended fre-
quency response from 50 to 16,000 Hz. Its
rugged construction with a hardened steel
mesh makes it an investment that will last
you for a long time.

ATI 8MX2 Mic Preamp/Mixer: If you plan
on recording from more than one sound
source at a time, you need a mixer which
ensures that everything gets to the sound-
card at a proper line level, while allowing
you to leave multiple sources plugged in
simultaneously. The 8MX2 is an impressive
digital multi-track system that offers eight
mic preamps and a stereo mix bus with
good monitoring capabilities.

volume and equalisations of each instru-
ment. All these audio inputs are finally
downmixed into a conventional stereo
output which the soundcard records as a
stereo file. You can control the levels of the
musical instruments and vocals only dur-
ing the recording and not afterwards.
Once you have a line level signal from
the soundboard going into your sound-
card, fire up the audio recording software,
say SoundForge. At this point, you are
basically using the computer as a simple
digital tape recorder. You’'ll end up with a
single stereo mix of the entire band,
which is more or less a finished product.
The only editing you can do is to equalise
it, add basic effects such as Echo and
Reverb or eliminate noise in the audio file.

smaller than WAV files.

Patch: A MIDI term that describes the type
of musical instrument being played by the
MIDI synthesizer such as a tuba or a bass
horn or a snare drum.

Polyphony: A term for the number of
simultaneous voices or instruments that a
synthesizer can play.

Soundboard: Also known as a mixer, it com-
bines a number of input sources, allowing
you to add effects and equalisation before
sending the total mix to one or more outputs.
WAV: This format stores digital audio by a

Studiophile Monitors: ‘Monitors’ is a term
used for the speakers that let musicians hear
what they play while they play it. You can
have the best gear in the world and still have
no idea how it's really going to sound unless
you have monitors that let you listen to your
tracks with faithful reproduction. With M-
Audio’s Studiophile line of studio monitors,
even the gentlest nuances reache your ears.
The most popular from this line are the SP-8B
speakers with 8-inch woofer or the smaller,
bookshelf-sized SP-5B with 5-inch woofer.

Add the optional SP-8S subwoofer to either
model and you have all the bass you would
need during your recordings.

You can’t re-record just the rhythm guitar
or replace the bass with a piano. This type
of setup is suited to recording just the
vocal track of a song or in cases where you
essentially want to only change the audio
characteristics of the recording such as
volume, equalisation and noise filtering.
The advantage is that the cost of equip-
ment is relatively lower than setting up a
multi-channel recording station.
Accessories you need: A full duplex sound-
card; a rudimentary soundboard or mixer
(M-Audio Audiobuddy; Price: $160/approx
Rs 8,000)

Scenario 2: Total control over indi-
vidual tracks Here you record each
instrument individually and do all the

process called sampling. Here, the audio sig-
nal is encoded by grabbing segments of it
and encoding it in a time-based manner. For
example, for CD quality audio, WAV files are
captured at a frequency of 44.1 KHz in 16-bit
samples.

Wavetable: A table of digitised samples of
actual recorded sound that is stored in read-
only memory (ROM) on a soundcard chip
or in the main memory of a computer. This
method is implemented in MIDI audio.
Wavetable is much higher in fidelity and
authenticity compared to FM synthesis.

AUGUST 2002



insight = workshop

mixing and production later. It requires a
full duplex soundcard and software that
allows multi-track audio recording such
as Acid, Cakewalk Sonar or
Cool Edit Pro. Once you have
set up your gear, you should
start by laying down a click
track (a track with a simple
rhythmic beat). Everyone
records his or her individual
part separately to the cue of
the beat. The advantage of
recording this way is that

Warren Mendonsa

Scenario 3: The best of both worlds
This combines scenarios 1 and 2, and
comes closest to how recordings are done

everything is on its own sepa-
rate track, so you can alter the
volume and equaliser settings
and pan any individual part,
or re-record it until you get it
right, or even get rid of it altogether,
without affecting any of the other record-
ed tracks. The downside is that it’s hard-
er for your band to groove together and
throw in improvisational bits, but it does
ensure that everybody stays on the
rhythm.

Accessories you need: A full duplex sound-
card and a mixer (the M-Audio Audiobuddy;
Price: $160/approx Rs 8,000)

Let’s step through the process of setting
up and recording your first track using
Cakewalk SONAR 2.0.
[§id3 Configuring Cakewalk SONAR 2.0:
Start by setting up your MIDI ports
(see box ‘Jargon Buster’). Go to Options >
MIDI Devices and choose the ports you want
to use for your MIDI input and output. Here
the MIDI input port is the port through
which SONAR receives MIDI information if
you have a musical keyboard. The MIDI out-
put is the port to which the MIDI audio sig-
nal is directed. Choose the Wavetable port
for output as this results in much higher
fidelity MIDI sounds.

Configure the MIDI input and output ports

113 Preparing a track: Before you feed
in the notes into a track, you need

to set certain parameters to it. Right-click on
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LEAD GUITARIST, ZERO

a mixer, you're better
off recording track
by track

in a professional studio. Each instrument
can be recorded individually, or all togeth-
er at one time. You'll need an ATI 8MX2
Mic Preamp/Mixer and a soundcard with
multiple ins, such as the M-Audio 2496.
The difference is that you are using an out-
board mixer with separate outputs on
each channel (instead of just a single
stereo line out), which is hooked into a
recording device with multiple ins. This

Recording with Cakewalk SONAR 2.0
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Choose the instrument from the Patch menu

the first track in the Track view and set the
Channel number. As a rule, set it to the
same number as the track you are working
on. Then select the instrument you would
like the track to play from the Patch drop-
down box. You can choose from a wide
variety of instruments such as the acoustic
grand piano, violin, etc.

3§33 Feeding in notes: If you are well-
n versed in musical notation, the Staff
view is where you should feed in notes. If
you have no formal training in music but
posses a good ear, choose the Piano Roll

Unless you have a
professional soundcard
with multiple inputs and
outputs, and separate
microphone presets or

means the whole band can play together,
but everything gets recorded on its own
track. You can derive the benefits of sce-
nario 1 (live/spontaneous sound),
as well as of scenario 2 (total con-
trol over each individual track).
This kind of setup costs much
more since the recording system
needs to be multi-track all the way,
but it provides you more flexibili-
ty to record that perfect song.
Accessories you need: A full duplex
soundcard; a soundboard/ mixer with
multiple ins (Mackie 1202-VLZ Pro;
Price: $399/approx Rs 20,000, ATI
Preamp Mixer; Price: $2,995/approx
Rs 1,50,000, Shure SM58 Micro-
phone; Price: $69/approx Rs 3,500)

Choosing the software

For purely techno or dance music, you can
start off by using a fully featured multi-
media PC loaded with a software synthe-
sizer such as Reason or Rebirth, or a
sampler such as eJay. No musical skills are
required—all you need to do is play
around with the sound samples and inter-
face controls, and before you know it, you

view—you can click and create notes in this
panel in the form of bars.

The most efficient way to feed notes is
through a MIDI-capable musical keyboard. In
the main Staff view, simply press the ‘R’ but-
ton on the track to which you want to feed in
notes—this arms the track. Then click on the
Record button on the bar and play away.
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Feed in notes in Piano Roll view

[Fi3 Fine tuning: Finally, when it all comes

: together, you can configure the vol-
ume for each track, and add the chorus and
the reverb effects through the Console view.
Playback: After you've created all

<1 your tracks, go back to the begin-
ning of the song, and hit the Play button (or
the [Spacebar]) and you have your first MIDI
recording!
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SoundForge can be used for editing, filter-
ing, adding fade in and fade out effects,
tweaking the frequency characteristics of
the song, etc. We've used SoundForge 6.0
to illustrate the process of creating and
working with a WAV file.

SoundForge: the Photoshop of audio editing

[3§3:} Setting up SoundForge 6.0: First,
see if the recording attributes are

set to 44,100 Hz, 16-bit, Stereo for CD-
quality recordings. If not, click on the
Record button in the toolbar. You could

will be able to produce sounds
and rhythms good enough to
record!

You will also need a multi-
track editing software that can
record several tracks and mix dif-
ferent recordings together. Look
out for the number of tracks you

can edit simultaneously—entry- ahil
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Editing with SoundForge 6.0

choose to record at higher frequencies and
then downsample the final output. Choose
the recording device in the Preferences
menu. Next to Mode, select Automatic
Retake (automatically rewind). Check the
Monitor box so that you can monitor the
sound input levels.

Recording: Click on Prepare in the

Record window. When the word
‘Prepared’ starts flashing, click on the Record
button. The file will start recording. Click on
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Set the Recording frequency to 44,100 Hz

programming

level programs limit you to eight
tracks, which could cause you to
lose interest rather quickly. Good
editing software also support plugins and
editing features. Most importantly, the
layout of the software should be user-
friendly. Cakewalk SONAR is one such
software that is not only powerful, but
also feature-packed and easy to navigate.
There are plenty of other software you can
choose from to record and sequence your
music such as Cubase, Cool Edit Pro,
Vegas, Nuendo and SoundForge.

Distributing your music

Creating your music is only half the job.
A lot depends on how well you make your
sound heard. Marketing music usually
involves marketing professionals, music
companies and lots of funds. That leaves
most of us searching for alternative means
to spread the music. Techno savvy bands
are increasingly using the Internet as a
means of worldwide promotion of their

FM103

FRONTMAN, DEMONIC
RESSURECTION

talent. The best avenue for all artists is
MP3.com, which has a Pay-for-Play program
that can earn you some money if you get
a good number of hits.

Take the example of Demonic Resurrec-
tion, an extreme metal band known only
in small circles in India. With the help of
the Internet, the band has reached out to a
considerably wider audience than they
would have through conventional meth-
ods. They have been nominated for the best
extreme metal act at MP3.com and are now
being signed on by record labels from Brazil,
Malaysia and Indonesia. “The Net has
helped people across the world hear us. We
have the maximum downloads compared
to any Indian rock and metal act. We've
received some 8,000 plus hits on MP3.com
alone and some 2,000 downloads on Audio-
galaxy,” says Sahil alias Demonstealer,
founder of Demonic Resurrection.

| Use either Nuendo,
Cool Edit or N-track
for recording; Fruity-
Loops is good for

drum and keyboard

the Stop button when you’ve finished
recording.
Note: If the word ‘Clip’ appears above either
of the meters, it means that the recording
level was set too high and you will need to
start over and re-digitise the file.
Editing: You can edit your audio
track by using the Pencil tool.
Here, you can ‘carve’ the response of your
audio by simply drawing around the
recorded wave file—play around with this
|| ' ‘Draw’ with
i [, o the Pencil
s g .]lqlhlrljﬁ.rﬁltinmm too! to edit
| the wave file

and see the results. You can also use the
noise gate from the Effects menu to filter
out signals below the threshold you’ve
defined. Voila! You've recorded your first
WAV file! Now you can directly convert
your track to an MP3 file or burn it onto
an Audio CD.

Midival Punditz, an ambient
fusion group with Asian Under-
ground roots, use their official
site and MP3.com to popularise

their music. Even classical
musicians like Chandrakant
Sardeshmukh and Veena

Sahasrabuddhe have garnered a
huge fan following at MP3.com
with 75,000 and 1,40,000 plays
respectively. Bands like Parikra-
ma have had over 500,000 views
on their homepage, and provide their
MP3s free for download. Encode your
music in MP3 format and let it be
swapped around in the file sharing pro-
grams. Once viral marketing takes over
and the popularity of your songs increas-
es, the sky is the limit!

With all the ingredients for cooking
the tastiest of digital audio tracks at your
disposal, today it is easier than ever to cre-
ate, fine-tune and distribute your opus—
right from your home. “Technology has
empowered the musician, helped him
refine his skills, but it cannot make you a
better musician,” says Rohit, the bassist of
Pin Drop Violence. “Well, it can hide your
flaws to some extent, but the basic thing
is if you don’t know how to cook, the best
utensils won’t make the food tastier.”
Need we say more? d|

SRIRAM SHARMA
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Share your pictures, send photo greeting cards and even get T-shirts and ancillary merchandise with
your picture on it—all through online photo album services

ired of hauling out all those

heavy albums each time you

want to walk down memory

lane? Sick of obliging all your rel-

atives by ordering mass reprints of wed-

ding snaps? Then maybe it’s time you

posted your pictures online. Online

albums make it easier for you to share

your pictures with friends and family, and

you can use the Internet to do it for free.

And confess it—don’t many of you have

old pictures that sit in dusty photo

albums for years on end or even in the

plastic envelopes they came in, without
you casting a second glance at them?

“It never occurred to me to use a

FEM 104

photo gallery, until my brother had a
baby and we wanted to send pictures out
to friends and relatives all over the
world,” says Reshma, who has a nine-
album photo gallery at photos.yahoo.com.
“Besides, after I received a few death
threats because of the bloated attach-
ments I used to send,” she adds, “I decid-
ed it would be safer to host them online!”
Having an online photo album has the
implicit advantage of not clogging other
people’s mailboxes with bloated photos—
since they’re in a central repository
on the Internet, they can be accessed
from anywhere by any person with the
right access.

Go digital
If you have a digital camera, it becomes
easier to create an online album. The idea
of spending a small fortune on a digital
camera, when there exist an abundance
of cheap disposable cameras, might seem
a bit odd, but digital cameras are getting
cheaper and easier to use and there are
savings to be made with them in the long
term. The problem with an old fashioned
camera is that film costs money. And
there’s always the worry of wasting a shot,
or ending up with a bunch of boring pic-
tures when you finally see the developed
photos a few days later.

Digital cameras are matching up to
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their conventional counterparts in terms
of imaging capabilities and ease of use,
and the day isn’t far when all photogra-
phy will be completely digital. Digital
photography has fewer limitations: you
can take loads of pictures without the fear
of running out of film or getting stuck
with a dud. And you get to check the
quality of your picture instantly—
whether it is worth keeping or whether
you'd be better off deleting it and shoot-
ing again. And the photographs can be
uploaded and distributed on the Net
within minutes.

Alternatively, you could also invest in
a flatbed scanner. Available today in a
variety of price ranges and features, they
are the cheapest way to digitise your
existing photographs. But there’s always
the cost of printing your photographs
first, which makes it a solution only if
you plan to work with a small number.
If you regularly scan every print that
comes back from the developers, you
should seriously think about getting a
digital camera.

Vanity fair
If you have your own Web space, you can
post your digital images online for other
people to view and also experiment with
Web design. You can register a domain and
rent some server space or use a free host
ing site such as Yahoo!, Geocitiesand Tripod.
Get a Web site authoring tool like Front
page or VisualSite 3.0 www.futuretrend-
soft.com). Frontpage 2002 even offers a
cool ‘Photo gallery creation’ feature that
can make an online photo album for you.
“l picked up some source code from
gallery.sourceforge.net to create my own photo
gallery. It was pretty easy to set up, and
there are no restrictions against linking my
images to www.hotornot.com or at forums,”
says Sacs, who created his own photo
gallery containing 400 odd photographs.

The best way to present pictures
online, especially if there are lots of them,
is to make thumbnails—small copies of
the larger images—that people can use as
an index. This saves on bandwidth and
lets viewers choose the images. They can
browse through the thumbnails and view
actual sizes of only the pictures they want
to see. Building a thumbnail index is not
very difficult if you have some knowledge
of HTML and software packages such as
Web Thumbnailer www.freedownloads-
center.com) make it easier for you.

An online album lets you upload as
many photos as you like. You can cate-
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gorise them by creating albums for every
vacation you take, each birthday party or
special event. While most online sites
offer storage space that would satisfy even
the most trigger-happy shutterbug, some
make additional storage space available
for a small fee.

Choosing the right showcase

The intent of most photo album sites is to
allow consumers to upload pictures,
invite friends to view them, or send
photo greeting cards, while they try and
sell you ancillary merchandise and serv-
ices. Most sites offer storage, uploading,
and photo-sharing tools as their basic
services but they vary in terms of the pre-
mium services offered as well as the price.
Which one suits you best depends on
how you use your virtual gallery.

The quality of service that you can get
out of these sites is completely depend-
ent on which side of the world you live
in. While you can use any of the servic-
es provided in the table ‘Photo Finish’, to
upload and view images, ordering prints
can prove to be an entirely different
proposition. Most online album sites
have no base in India, and you would
have to tolerate delays with the post
office and international mail for getting
your prints. These would be irrelevant to
your relatives in the US, though. The
only Photo album site with a photo lab
based in India is www.photojagat.com.
They have an alliance with Speedpost
and DTDC, which ensures quick delivery
of photos to virtually any part of the
country.

DotPhoto: If you are a heavy
digital camera user who sends greeting
cards and pictures to friends and family
on a regular basis, this site is for you. It
offers several subscription plans, which
will reduce printing costs. Join
dotphoto.comfor a $60 bulk photo account
(approx Rs 3,000) and you get 372 pho-
tos. At $1.99 (approx Rs 100) per order,
shipping is cheap. This is the only site
where you can add sound clips to your
digital photos. If you would like to sell
prints of your photos, DotPhoto lets you
specify royalty rates, so it’s a site for pro-
fessional photographers too.
www.dotphoto.com

Hedsre ol  Kodak Picture
Center: This site is more focused
towards developing prints rather than
viewing them online. Loading images is

Creating your own Photo
Gallery

Here's a step-by-step guide on creating
an online photo gallery.

Step 1: Digitising your photos

If you have developed pictures, scan
them in either GIF or JPG format. If you
have a digital camera, use the bundled
software to connect to your PC and
transfer the images.

Step 2: Editing and resizing

You can upload the images either
unedited, or after you’ve made
changes using an image editing
software. The resolution of the images
depends on your needs—whether
they are for Web viewing or printing.
It’s best to upload the largest file size
that your Internet connection can
afford; this gives your viewers the
choice to obtain high quality prints.
Step 3: Registering with a photo
album service

There are several sites to choose from
(refer table, ‘Photo Finish’). Find a service
where you can

display them free == rix
of cost—users of BT
Yahoo! and Hot- e
mail are entitled

to a free online
photo album. ' T
Decide on a particular site to host your
images depending on the total amount
of space you want and whether you
would like to avail of printing services.
Step 4: Uploading

Most sites have an easy upload proce-
dure, similar to adding an attachment

to your mail.
Some provide
desktop utili-
ties, for oth-
ers you have
to use Web-
based forms.
Step 5: Separating into albums

You can segregate your pictures in
different categories pertaining to an
event, like you would do in a proper
album, instead of having all your
images in one page.

Step 6: Inviting family and friends
Send invitations and links to friends
and relatives in your address book and
allow them to leave comments at your
gallery. Most online album sites provide
this service.
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Online Photo Album Services at a Glance

Service Storage Size Photo Scan-  Direct Links Cost Per Print Pros and Cons Overall
ning Services to Albums Rating
DotPhoto Unlimited Yes Yes 4x6 inch: $0.29 (~ Rs 14) + Order 30 free prints! Bulk prints are really cheap CJOOO0

5x7 inch: $0.95 (~ Rs 47)
8x10 inch: $2.95 (~ Rs 147)
12x18 inch: $9.99 (~ Rs 500)

- Slow upload speeds, cumbersome navigation

Kodak Picture Center Free hosting ~ Yes

Yes 4x6 inch: $0.24 (~ Rs 12)

+ Ties up with retail photo processing giants

gooooo

for 200 photos 5x7 inch: $0.89 (~ Rs 44) worldwide
for 6 months 8x10 inch: $2.59 (~ Rs 130) - Images are viewable only as thumbnails
MSN Communities 30 MB No Yes No Printing Facility + No registration required, ties with MSN services OO0
- No facility for printing photos
Ofoto Unlimited Yes Yes 4x6 inch: $0.49 (~ Rs 24) + Easy to use and quick uploading ooooo
5x7 inch: $0.99 (~ Rs 50) - Expensive shipping rates
8x10 inch: $3.99 (~ Rs 200)
Photo Jagat Unlimited No No 4x6 inch: $0.35 (~ Rs 17) + Provides printing services in India oooood
- A tad on the expensive side
Shutterfly NA Yes Yes 4x6 inch: $0.49 (~ Rs 24) + Easy to use, 15 free prints 0ooooo
5x7 inch: $0.99 (~ Rs 50) - Expensive shipping rates
8x10 inch: $3.99 (~ Rs 200)
Yahoo! Photos 30 MB Yes No Prints developed at Shutterfly + Very convenient, easy to use and maintain 0oooo

cumbersome and only one can be
uploaded at a time. The gallery interface
only lets you see small samples of the
image. This service ties up with many
retail photo development giants around
the world, which provide professional
scanning and delivery services.
www.picturecenter.kodak.com

msn MSN Groups: Microsoft’s
community Web site, MSN Groups,
allows you to start your own e-group
where you can share up to 30 MB of
images. This service is only oriented
towards viewing and sharing your pic-
tures, and ties up well with a host of
other MSN services like the chat and e-
mail clients.
www.communities.msn.com

Goid
awancomery - OfOL0: This site has a drag-and-
drop desktop software called Ofotonow
that makes uploading photos extremely
easy. It automatically transfers photos
from your camera, allows for photo edit-
ing and lets you order prints through
a single click. You can frame photos,
create cards and more. Ofoto sends the
prints to anywhere in the world through
Federal Express shipments. The prices of
the prints are reasonable, but the cost of
shipping will pinch your wallet. They
charge $0.98 (approx Rs 49) for two
4x6 photos and $4.99 (approx Rs 250)
for shipping them! Payments can be
made only by international credit cards
such as Visa, Mastercard, American
Express, etc.
www.ofoto.com
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at the same price

- Outhouse processing, ordering prints is

cumbersome

“ Photo Jagat: This site has all the
required features and a helpful support
and FAQ section. It recommends the best
size for prints depending on the quality of
your images. It has a client called PC
Uploader that allows bulk uploading of
images directly from your desktop. The
main advantage with Photo Jagat is that
it allows you to send prints within India
using Speedpost and DTDC. It still
requires an international credit card and
at 35 cents a print (approx Rs 17), isn’t
the cheapest service around.
www.photojagat.com

shutterly . Shutterfly: Shutterfly allows
you to add, enhance, share and order
prints online, and promises film-quality
prints delivered to your doorstep. It also
provides services for film processing from
analogue cameras and uploading them
online, and has features to create greet-
ing cards from your photos. Shutterfly
has a picture upload plugin that makes it
easy to transfer pictures to your photo
gallery from your desktop. The first 15
prints are provided free of cost, which
means that you only have to pay for the
shipping.

www.shutterfly.com

WreioCIFHITNE 5= Yahoo! Photos: This
is a totally free service provided by Yahoo!
for all its users. All you need is a Yahoo!
account and you're set. Uploading is
manual and the site is fully functional in
a no-frills kind of way. You can order
prints, mugs, T-shirts and greeting cards
customised with your photos, and the site

ties in with other Yahoo! community serv-
ices pretty well. It doesn’t offer print pro-
cessing, but redirects you to Shutterfly
instead, where you can order prints.
The main disadvantage here is that the site
does not list India for photo print delivery.
http://photos.yahoo.com

Photo finish

Using an online photo album opens up
your personal life to the entire world.
Sharing your pictures for everyone to see
on the World Wide Web just might
turn into an open invitation for stalkers,
spammers and the like. It’s a better idea to
create password-protected albums. Most
photo album sites have an option for
keeping the albums either public or
password protected.

Although there is no dearth of Web
sites offering free online photo albums,
there is a wide variation in their reliabil -
ity and the features offered. Some seem
to offer you everything—full size images,
nice thumbnails, good design, etc—and
then they shut down, leaving you tear-
ing your hair out: ecircles.comand zing.com
were one of the first of such services but
now no longer exist. Therefore, it would
make sense to keep backups of your pic-
tures on your PC and not rely on these
services alone. Yet, with the functional -
ity and universal appeal that these serv-
ices provide, they are the best choice for
shutterbugs who need a platform for
displaying snapshots of their memories.
So go ahead and use the Web as your
photo gallery. d

SRIRAM SHARMA
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Recover deleted files

so convenient, even secure, to perma-

nently delete files. Surprisingly, most
of us don’t use the Recycle Bin’s setting
to permanently delete files. [Shift] +
[Delete] is the vice. But moments later we
realise that from the whole group, there
was one file that is required. Or, a couple
of days later, a client sends a mail saying
that the project isn’t complete and he'll
need some files for cross-reference. Fortu
nately, there are ways to recover deleted
files. All you need is the right tools. And
a lot of luck.

It's a habit that’s hard to break. It seems

Hard disk anatomy

A hard disk allows random data access,
i.e. any file stored anywhere on it can be
accessed at any time, as against a tape
drive, where the tape would have to be
wound to the particular location where
the file is stored. Hard disks store data in
sectors and clusters. The bytes of a file are
allocated to each cluster, which are pop-
ulated as required. Think of sectors and
clusters as a hotel with floors and rooms
where the files are guests. The guest list is
stored at the reception and anyone
behind the desk will be able to tell you
which room a particular guest is in. Hard
disks store information about each file in
a similar way. The ‘address’ of each file is
stored in a separate area of the hard disk
that is not accessible with common tools.
When a file is requested, the disk looks
up this ‘register’, locates the file and pass-
es it on. On FAT and FAT32 partitions,
this entry is stored in the FAT (File Allo-
cation Table).

When a file is permanently deleted,
only its entry from the ‘register’ is
removed. The actual file is still stored on
the disk until some program requires

oOutiook Express Folders

If you have deleted a mail folder in
Outlook Express, do not despair. Out-
look Express stores folders as separate
files. Look for files with your mailbox
folder name and a DBX extension.
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space. Thus, it may still be possible to
recover the file until another overwrites it.

Stop!

The moment you realise that you need to
recover a deleted file, stop doing whatever
you are doing on the PC. Do not close pro-
grams, shut down Windows, hit [Ctrl] + [S]
or even chat, especially if you haven’t
defined a permanent swap file size in Win-
dows. Any request for space, and the disk
might just give up those precious clusters
where the file may still be stored.

Plan out exactly how you want to go
about recovering the file. Usually, there is
no room for experimenting and, if any,
there is only one chance. If the fileis on a
partition other than the Windows drive,
you might have a much better chance of
retrieving it.

Recover

It is advisable to have some recovery soft-
ware already installed on the PC. Also
make sure to install one on a drive other
than the one running on Windows, as it
may still write to the registry.

File Rescue: File Rescue (www.soft-
wareshelf.com) from Software Shelf is a
small but useful tool for recovering files
but the demo edition recovers only two
files. It works with FAT, FAT32 and NTFS
drives. When you launch File Rescue, it
asks for the drives that are to be scanned
and the kind of files to look for. Make
your selections and click OK. It scans the
disk quite fast and shows a list of files that
it finds on the disk, but not in the FAT. It
lists the file names, the folder from which
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File Rescue displays a list of deleted files with
details on their condition
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File Rescue 2.7
Recover4all Professional

Find them in Software >
System on the Mindware CD

they were deleted, their sizes, modifica-
tion dates, prognosis and the file address
on the disk.

The most important thing here is the
prognosis. If it says ‘Poor’, then some parts
of the file have been overwritten by other
data and the file probably won’t recover
correctly. If the condition is ‘Good’, then
in most cases, the file will be recovered
completely.

Select the files you want to recover and
click Undelete. When recovering the files,
choose a drive other than the one you are
recovering from—you don’t want any
data to be written to the drive until you
finish recovering.

Recover4all: Another utility, Recover4all
(www.recover4all.com) is available in two
editions—both support FAT and FAT32,
but the professional version also supports
NTES. Launch the program and select the
drive you want to scan for deleted files. It
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Recover4all displays the deleted file in an
Explorer-like view

displays deleted files in an Explorer-like
view, making it easier to navigate. This
software also shows you the condition of
the file and the possibility of recovering it
correctly. Just select the files and click
Recover.

Recovering files is simple and possible,
but it doesn’t always work. So the next
time you use the [Shift] + [Delete] combi-
nation, be afraid. Be very afraid. dl

VEER KOTHARI
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Disobedient desktops, feverish processors, dirty recycle bins and partitioning
blues—we have a remedy for all of them

DNS on Linux

Q. | have problems resolving
the names of Web sites on
Linux. Thus, | am unable to
browse the Net with Netscape
unless | provide the actual IP
address of the site, which can
be found using nslookup. The
same version of Netscape in
my previous installation of
Linux worked fine. Why is it
giving me trouble now?
Pradeep Shankar

Via e-mail

M The problem is not with
Netscape. The DNS is not
configured or isn’t working
correctly on your installation
of Linux. To cure this you'll
have to enter the IP addresses
for the domain name servers
into the /etc/resolv.conf file
(one address is usually good
enough, but it’s better to add
two). The file must have per-
missions as -rw-r—r—--and
root ownership. You can get
this information from your
ISP. For example, if you are
connected to a VSNL connec-
tion, the file after editing
should look like this:
nameserver 202.54.4.24
nameserver 202.54.1.18

You should also check that
your /etc/host.conf file is
correctly set up for name
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resolution to look up the
host’s file before the DNS
server. It should look like:
order hosts, bind

multi on

Once this is done, you should
be able to surf the Internet
with domain names.

Rude desktop

Q, My computer was running
fine until recently, but now
when | start it only a few icons
are displayed on the desktop.
These icons and Start menu
do not respond to the left

Overheating Athlon

Q. | have a PC with an AMD Athlon 1.4 GHz

Turn off Active Desktop to disable
Web content

mouse button. Right-clicking
results in the error message:
‘Your current settings prohibit

running ActiveX controls on
this page. As a result, the
page may not display correct-
ly.” I am unable to work on
the computer. Please help me.
Sanjay Dobhal

Via e-mail

/A This might be a prank
someone is playing on you.
A static page could have been
set as the desktop wallpaper,
causing it to not respond.
Use the key-combination
[Win] + [E] to launch
Windows Explorer. Open

/A Inadequate contact between the proces-

processor, running on Windows Me. The CPU

temperature often crosses 72°C and the sys- 1 H(

tem hangs. But if | leave it idle for around . j_/"’
an hour, it works normally. I've tried
keeping the cabinet open and have

changed the jumper on the
motherboard to 100 MHz
FSB from 133. Now the
processor runs at 1050 MHz
and the maximum CPU
temperature is around
64°C. However, | want the
full speed of the processor.
How can | use the processor

at 1.4 GHz without overheating it?

Bhalasubramaniyan
Via e-mail

ILLUSTRATIONS: Mahesh Benkar

sor and the heat sink can cause the

processor to overheat.
To avoid this, apply a
thin layer of ther-
mal paste between
the heat sink
A~ and processor.
: You should
espect the
average tem-
<l .~ perature of this

S e

2 G,_J_f,.:“:if : processor to be
!. I:E H 1‘.‘5”# around 55°C,
gl

which can go to
a maximum of 60°C

under heavy load. A larger, qood quality

copper heatsink may also help.
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Control Panel > Desktop and dis-
able View my Active Desktop
as a web page. This should
solve the problem.

Sharp CMYK graphs

. | have a problem while
creating pie, line and bar
graphs for CMYK printing
using PageMaker. | use Excel
for preparing the charts, but it
uses only RGB and the lines
are jagged. | import this graph
in CoreDRAW and edit it to
smoothen out the lines and
convert it to CMYK, which
takes a lot of time. Illustrator
does not have enough fea-
tures for making graphs. In
your magazine, you use charts
and graphs with shadows.
Please let me know what you
use and the best procedure to
draw a graph in CMYK for
print processing.
Ramesh N.
Via e-mail

/A We create charts and
graphs in Macromedia
Freehand. These are then
imported to Photoshop
where effects such as shad-
ows and bevels are added.
There’s not much you can do
about either of your prob-
lems with Excel, so working
in Freehand and Corel is your
next best option.

Partitioning blues

Q. | tried partitioning my
hard disk using the partition-
ing software on the June 2002
CD. It is now showing two
drives, one (C) of 16 GB and
another (D) of 19.6 GB. Drive
C uses a FAT file system and D
uses FAT32. However, when |
try to load any operating

Auo o | | S AL

Your computer has a disk larger than 512 HB. This version of Windows
includes improved support for large disks, resulting in mere efficie

use of disk
formatted as a single drive.

IMPORTANT: If you e:ahl; large disk support and create any new drive
e

isk, you will no
earlier versions of Windows and MS-|

to work with this disk.

Do you wish to enable large disk support (¥/H......

Enable support for large disks in FDisk to create

FAT32 partitions
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space on large drives, and allowing disks over 2 GB to b

able to access the new drive(s) using other op
systems, including some versions of Windows 95 and Windows HT, as we
. In addition, disk utilities

were not designed explicitly for the FAT3? file system will not be al
i i you need to access this disk with ether o

systems or older disk utilities, do not enable large drive support.

""" A this, you can

system on C, it gives a mes-
sage that there is insufficient
space. It gets installed correct-
ly on D though. How do |
correct this?

Anil Kumar

Via e-mail

/\ The drive does not seem
to have been partitioned cor-
rectly—any partition over

2 GB cannot have a FAT file
system. You have not men-
tioned what operating system
you use; the process for fix-
ing this will differ slightly
across different versions of
Windows. Boot to DOS and
run FDISK. Hit [Y] when it
asks you whether you want
to enable support for large
disks. You can delete the pri-
mary partition (C) and recre-
ate it. If D has been created
as a logical partition, you will
have to delete this first. If
you don’t want to delete it
and have Windows 98, try
converting C to FAT32 using
the FAT32 converter available
with the OS. If you have
Windows 2000 or later, you
can simply use Disk Manager
to do the job.

CMOS battery

Q, | want to know how to
turn off the CMOS battery. If a
user is not using the PC for a
long time, does the battery
get drained? Is there anything
we can do about this? Will the
removal of battery cause any
adverse effect?

Santosh Ambekar

Via e-mail

M\ The purpose of the CMOS
battery is to retain the CMOS
configuration while the PC is
off. You don’t real-
ly need to disable
it unless you are
planning to not
use the PC for
around a year.
However, if you
still want to do

remove the battery
from the mother-

board. The next time you boot
the PC, the CMOS will default
to the factory settings and any
configuration changes made
to it will be lost.

DOS conventional memory
Q, | have a Cyrix processor
with 32 MB RAM. When | try
playing any DOS game on it,
it says that the conventional
memory is not sufficient. What
will I have to do to run my
games in DOS?

Ravi Kishore

Vishakhapatnam

Check the amount of free memory in DOS

/A This is a very old problem
with a crude workaround
solution. While in DOS, type
mem to check the amount of
unused memory. Don't get
boggled by the numbers—it
might not show the amount
of RAM on your PC accurately.
You are interested only in the
value of Free Conventional
Memory. Open c:\config.sys
for editing. Type the follow-
ing lines at the top:
DEVICE=C:\WINDOWS\HIMEM.S
YS /testmem:off
DEVICE=C:\WINDOWS\EMM386.
EXE RAM

DOS=HIGH

DOS=UMB

Save the file and restart the
PC in DOS. Check the
amount of free memory,
which should have increased
substantially now. If the
games still don’t run, the
soundcard or the mouse driv-
ers are probably taking up
some memory. Check if the
game can run without either
of these and unload the
unnecessary one. If you need

both, try preceding their load
commands in the
autoexec.bat with LH:

LH C:\DRIVERS\MOUSE.COM
This will load the drivers in
the upper memory area and
free up some more conven-
tional memory for you to run
your game.

Selective MP3 player

Q. bought a Samsung MCD-
SM60 portable MP3-CD play-
er. It plays most of the CDs
and MP3 CDs. However, when
| try to play MP3 CDs created
with Adaptec Easy
CD Creator, the play-
er recognises only
some files out of the
100 or so on it. Do |
need any special soft-
ware for burning the
CcD?

Sumit

Via e-mail

/A since the player
recognises some files
and not others, it
probably negates a lot of pos-
sible errors such as the
media, burning errors and so
on. This seems to be more of
a file error. Check the bitrate
at which the MP3s are encod-
ed. Avoid using extremely
high bitrates; 96 or 128 Kbps
should be enough. Also avoid
variable bitrates (VBR). If
these fail, try burning the CD
at a lower speed.

Compress video with DivX
Q. | have read a lot about
DivX in the past couple of
months in your magazine.
Though | have visited numer-
ous sites, | could not get an
answer to my query. | want to
convert my VCDs to DivX for-
mat to save space. How can |
do that?

Amit

Via e-mail

M\ To convert video formats
to DivX, you will have to use
a software that can encode
with this codec. You can use
freeware such as VirtualDub
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Plagued by a virus

Q.| use the Internet frequently and have
McAfee anti-virus installed on my PC. | think
my machine is infected with some virus.
Whenever | connect to the Net, approximately

created in each folder with a zero-byte attach-
ment (ATT00004.txt). The Internet is shared by
six other PCs and they all seem to be infected.

Vikram Bhatia
Via e-mail

/A Your PCs seem to be infected by the
Nimda virus. To remove it, update your anti-
virus software from www.nai.com. You can also
find a McAfee anti-virus update on the
Mindware CD under Software > Essentials. If
this does not
help, you'll
have to remove
it manually.
First, disconnect
the machine
from the net-
work, disable all
network shares
and turn off all
file sharing.
Now delete all
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Use msconfig to edit your
system.ini file

to encode files with the DivX
codec. This software can take
most video formats (includ-
ing MPEG 1 and MPEG 1.2
DAT files) for input and any
installed codec for encoding.
(For a step-by-step procedure,
check the digital video work-
shop on page 96.) For more
information, check www.mydk
vx.com.
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Select the DivX codec in VirtualDub

New graphics card

Q. | have a PC with a
Pentium Il 600 MHz proces-
sor and 128 MB RAM at

133 MHz. | just installed a
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CD-RW drive and an nVidia
graphics card. | set the CD-
RW drive to master and the
CD-ROM drive to slave on the
same channel. When | restart-
ed the computer, it showed
me an error that read
‘C:\>C:\ESSAUDIO-BLASTER
Primary Codec Error’. |
removed the CD-RW drive,
but | still get the error. The
CD-ROM drive is still kept as
slave. | cannot play audio and
video files. How do | solve the
problem?

Deepak

Via e-mail

/\ The CD-RW and CD-
ROM drives don’t have any-
thing to do with this prob-
lem. The graphics card is
probably the culprit.
However, it could just as
easily be due to the sound-
card’s drivers. Your system
seems to be loading the
drivers in DOS, though this
is not required. Open

.eml and .nws files of 78 or 79 KB size, dated
later than September 18, 2001. You can use
Windows Find to locate all files with these

extensions. Delete all instances of readme.exe
and load.exe. If you are running Windows
2000 or XP, delete any instances of mmc.exe,
admin.dll and riched20.dll dated September
18, 2001 or later, sized 58 or 59 KB. You may
have to reinstall or repair Windows or Office
after doing so.

If you are running Windows 98, run
msconfig and expand [boot] under the Sys-
tem.ini tab. You will find a line that reads
shell=explorer.exe If there is anything else on
the line, change it to shell=explorer.exe

After rebooting the machine you can
restore the network and enable file sharing.

c:\autoexec.bat in Notepad
and add REM before all the
lines that refer to ESSAudio.
For example, if the line
reads C:\ESSAUDIO.COM,
change it to REM C:
\ESSAUDIO.COM. If the
soundcard does not work in
Windows, then you will
have to download the latest
version of its drivers and
install them from
http://www.esstech.com/tech-
supp/drivers.shtm.

If the problem still per-
sists, then the soundcard is
probably conflicting with
the graphics card. Try down-
loading the latest nVidia
Detonator drivers for the
graphics card from
www.nvidia.com. If this does
not help either, change the
soundcard slot if it is not an
onboard card. You can also
check the AGP aperture size
set in the BIOS. Set it to
twice the amount of RAM
you have, i.e., 256 MB.

Dirty Recycle Bin

Q. On Windows 98, whenev-
er | try to empty the Recycle
Bin, | get the following mes-
sage: ‘The Recycle Bin format
is invalid. Do you want to
empty the Recycle Bin?’ If |
click Yes, the system hangs,
and if | click on No, nothing
happens. However, | can
delete files from DOS. Please
give me a solution.

Shyam

Via e-mail

/A Windows 98 emulates a
Recycle Bin from a folder
named Recycled—one folder
for every drive. One or all of
these folders is probably cor-
rupted on your system. Start
the PC in DOS mode by
holding down the [Ctrl] key
while the PC is booting to
bring up the Windows 98
Startup menu and choose
Command Prompt Only. At
the command prompt, type
attrib -s -h recycled to remove
the system and hidden
attributes of the folder.
Unless this is done, DOS will
not allow you to delete the
folder. Then type deltree /y
recycled to delete the folder.
Repeat this for every drive.
Note that all items in the
Recycle Bin will be deleted.
Now, restart to Windows and
run a thorough Scandisk on
all drives to check for errors.
The folders will be recreated
by Windows as required.

Office XP SP1

Q. | have Windows 98 SE and
Office XP installed on my PC.
| recently tried to update
Office XP with Service Pack 1
(SP1) from the February Digit
CD. During installation, | got
an error message that reads:
‘Error 1328: Error applying
patch to file. C:\Config.msi\
PTAOAO.TMP. It has probably
been updated by other means
and can no longer be modi-
fied by this patch.” What can
be wrong?

Nishant Sangar

Via e-mail
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Mysterious file

Q.| have a 15 GB hard disk.
On my drive C, there is a file
named win386.swp that
takes 60 MB of space. | want
to delete this file, but when-
ever | try deleting it, | get an
error message. | even tried
deleting it by starting the PC
in DOS and in the Safe
Mode. Although it gets delet-
ed then, it reappears when
Windows starts. Please tell
me what to do.

Varun Kumar Arya

Via e-mail

/\ This is the Windows
swap file. Windows uses
this file to temporarily
hold data when it finds the
RAM to be insufficient.
With the kind of
applications we run on our
computers everyday, it

/\ This is quite a common
problem that occurs with an
updated version of Windows
Installer, the tool Microsoft
introduced for software
installation and mainte-
nance. A complete uninstall
and re-install of Office will
help. One Microsoft article
suggests that you may be
using a beta or unlicensed
version of Office XP that
cannot be upgraded to SP1—
you might need to purchase
an authentic box packed
version.

Web server setup

Q.| am a freelance software
developer. My current project
is a Web-based application
using ASP/|SP. | plan to use
Linux and MySQL in the near
future and | expect approxi-
mately 10,000 transactions
per day with 300 concurrent
users. Is MySQL stable
enough for this requirement?
What can it scale to? Which is
the best Linux flavour for this?
Is ASP supported on Linux?
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Turn off Virtual Memory in
Windows 98

would be virtually
impossible for your PC to
run smoothly without this.
The file is always opened
by Windows for reading
and writing, thus you
cannot delete it. Though
you could disable virtual
memory from Control Panel
> System > Performance >
Virtual Memory and remove
the file, this is not
recommended.

What is the ideal hardware
configuration for the server
and clients?

Selvakumaran

Via e-mail

/A MySQL should hold up to
your specifications, but
whether it really does and
what it scales to depends
entirely on the database
design, the number of tables,
the number of fields, the
types of queries, the joins
used, etc. Without such
information, any estimate on
reliability would be vague.
Debian is a very stable Linux
distribution, but Red Hat is
the most popular flavour for
the Internet and also has
more support. You can
deploy ASP applications
using the Apache, iPlanet or
Zeus Web servers with Sun
ChililSoft ASP found at
www.chilisoft.com. However,
there is no deployment solu-
tion for ASP better than IIS
(Internet Information
Server)—you may lose out on

Hard disk not detected

2. 1 have an ASUS P2B moth-

erboard with a Pentium Il 400

MHz processor and 128 MB

RAM. | changed the hard disk

to a Seagate 40 GB 7200 rpm.

Now the BIOS does not

recognise the hard disk, but it

works well on other systems.
Please help me solve the

problem.

Arul

Via e-mail

/A Your motherboard is
quite old and you will have
to update its BIOS for it to
detect any hard disk upwards
of 37 GB. You can download
the BIOS update utility from
ftp://ftp.asuscom.de/pub/ASUSC
OM/BIOS/BIOS_FLASH_UTILS/afl
ash206.zipand the BIOS
patch from
ftp://ftp.asuscom.de/pub/ASUSCO

performance and even miss a
few methods and functions
while working with third-
party tools such as these. You
can use any standard server
configuration; a 700 MHz
processor with 256 MB RAM
should work, though you
should consider throwing in
as much RAM as your budget
will allow.

System File Checker

Q, My PC runs on Windows
98. Whenever | start System
File Checker, | get the mes-
sage: ‘SFC cannot check the
following folder because the
volume is locked: c:\win-
dows\system\macromed\sho
ck7. Close all other programs
and click Retry to check this
folder again. Click Cancel to
stop checking files.” How do |
remedy this?

Rohit

Via e-mail

Nerul-400 706

M/BIOS/Slot_I/INTEL_Chipset/i440
BX/P2B/with_Hardwaremonitor/10
14_02.zip. Remember to take
a backup of the BIOS before
updating it. (For more
instructions, refer to Digit, June
2002 issue.)

CD-RW maintenance

@1 recently purchased a
Sony CD-Writer (24x-10x-
40x) and want to know if the
lens for reading and writing
is the same. | am told that if |
use the drive for reading, it
shortens its life. Is this true?
Manish Katiyar

Via e-mail

/% Yes, the same lens is used
for reading and writing on
this drive. There is no need
to worry though; this will
not affect the expected life
of your writer.

/A Close all programs before
running SFC—press [Ctrl] +
[Alt] + [Del] to bring up
the task list. End all tasks
except Explorer and Systray.
If the error still shows,
browse to the folder in

the error message from
Windows Explorer and
check its properties. All
attributes should be
unchecked. If it’s already
so, reboot the machine

and hold down the [Ctrl]
key while booting. Choose
Command Prompt Only
from the Startup menu.
Run a thorough scandisk
on drive C and fix all
errors.

If the problem still
persists, move the Shock?
folder outside the Windows
folder. You can re-install
the latest version of
Shockwave from www.macro-
media.com.

Send your problems to sos@jasubhai.com
or write to Digit, D-222/2, Om Sagar, MIDC,
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VIDEO EDITING
Video authoring on your PC is very simple and
there are some cool things you can do with the
right tools. Here are some secrets to capture,
edit and process video on your PC

Enhancing video quality
Picture and sound quality is
what makes one video
stand apart from another.
Effects, animations and
other gizmos will mnever
make up for a hazy image or
hissing sound. The video
quality is most affected by
the quality of capture. Here
are a few things to look out
for when creating videos

t4Resolution for quality

For maintaining the video
quality, you can optimise the
frame resolution and frame
rate. Unless your system is
good enough to support
both at maximum, you will

have to prioritise between
the two. Most hobby videos
are captured at 320x240, at
10, 15 or 30 fps. For editing
though, it is better to capture
it at as high a resolution as
possible and scale it down
later. If the resolution can-
not be pushed up much,
increase the frame rate if the
capture is smooth.

Edimage levels

Use brightness and contrast
settings to tweak the input
video. Pick a scene with
plenty of dark and bright
areas and adjust the settings
accordingly. Unless you use
a well-calibrated monitor, do

not rely on it to check the
darkness; if black areas look
grey, its brightness needs to
be lowered, but monitors
often show dark greys as
black so use a software
instead.

t4Avoid dropped frames
If the system is slow, it may
not write some frames to the
disk and dropped frames will
occur. The result is a null
frame that takes up virtually
no space and simply mimics
the last frame. More dropped
frames result in a jerkier
video and are more apparent
at low frame rates. Dropped
frames wusually come in
bursts, thus the video will
have large jerks instead of
slight jitters. If you are com-
pressing the video in real-
time, dropped frames occur
when the data rate is the
highest—when the most
action occurs, which is the
worst time for a jerky video.
To  avoid  dropped
frames, you can try decreas-
ing the frame rate or the
video resolution. Also, opti-
mise the hard disk and close
all open applications while
capturing. If you still don’t
get a smooth video, turn off
preview while capturing if
possible. You can also try
reducing any  real-time
effects the capture software
may be applying to the
video. If you have a good
processor but a slow hard
disk, increase the compres-
sion quality so that smaller

chunks of data are written to
the disk.

Ldinterlaced video
Interlacing increases the vis-
ible resolution of a video. A
frame is split into two fields,
which are sent back-to-back.
Both fields interleave with
each other to form a com-
plete picture with twice the
vertical resolution. Frame
sizes with 288 lines or less of
vertical resolution usually
cause non-interlaced cap-
tures. The problem with
interlaced capture is that the
two fields don’t have to cor-
respond to the same frame.
Instead of capturing 25
frames per second and
encoding them into field
pairs, cameras actually send
alternating fields of 50 dif-
ferent pictures. Any standard
video compressor used with
this video, except for MPEG-
2 and MJPEG, will mistake
this interlacing for fine
detail. As a result, other parts
of the picture will suffer or
the file will be larger than
expected.

kdKeyframes

Many codecs compress video
with keyframes. One frame
(the keyframe) stores the
entire image with the colour
information of every pixel.
For subsequent frames (delta
frames), only the differences
between those and the
preceding frame are stored.
To get to a frame, the
decompressor will first get
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information  about the
keyframe, then all subse-
quent frames to build the
final image. More keyframes
mean larger files, but lesser
seek time. Also, frames fur-
ther away from the keyframe
are more susceptible to low
quality, since each time only
an approximate difference is
stored. Thus, you should keep
the keyframe interval to as
low as possible.

kdAvoid outdated formats

Microsoft Video 1, Radius
Cinepak, and Indeo 3.2 are all
outdated formats. Video 1
cannot always render perfect
frames, since it can assign only
eight colours to every 16 pix-
els. Radius Cinepak drastically
affects the picture quality with
its motion prediction function
and also creates very large files.
Indeo 3.2 can cause colour
bleeding and  dithering.
Though Indeo 5 is much bet-
ter than Indeo 4, the latter is a
good codec for AVI files if you
plan to distribute the video to
a wide audience; Indeo 5 can-
not be decoded on a Macin-
tosh. Also, avoid proprietary
formats such as MJPEG, VCR1,
VCR2, ASV1, and WNV1—
codecs for these are not easy to
find and are not free.

kdRecording sound

If your hardware allows it,
plan = beforehand whether
you want to record sound
along with the video itself or
from an external source. An
external  source usually

means much better quality,
but can also prove to be slug-
gish and is a hassle.

Since one audio file is cre-
ated for every video, you have
to keep track of double the
number of files in post-pro-
duction. Also, synchronising
audio and video involves
more time and has to be done
perfectly. However, if you
capture video and audio
simultaneously and the sys-
tem is slow, it may be suscep-
tible to dropping frames as it
has to process the video and
the audio at the same time.

kd Audio levels

The capture volume should be
high enough for clear sound.
Softer is preferable over louder,
as long as the sound is audible.
16-bit audio is better for cap-
turing, since it has much more
precision than 8-bit.

Editing with speed
Capturing and editing video
is much better with loads of
computing power and disk
space, but even on the best
machines, processing video is
a very slow process. Here are
a few things you can do to
speed it up

tdEnable DMA for IDE

If you have Windows 98 or
later, enable DMA for the
hard disk. Open Control Panel
> System > Device Manager and
double-click each disk under
Disk Drives. Check the DMA
box under Settings and click
OK. Older drives may not

support DMA, so the next
time you reboot, some of
these  boxes may be
unchecked.
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Enable DMA for your hard disk

for faster access

LdWindows 98 or better
Windows 98 has a much more
efficient disk subsystem than
Windows 95, which allows
better writing to the hard disk.
This can significantly improve
capture quality and editing
speed. Windows 2000 is pre-
ferred over any other Win-
dows version. Windows 95,
98 and Me will not allow AVI
files over 2 GB. If you use
Windows 2000 or XP, there is
no such limitation, but do
turn off some of the operating
system’s  memory-hogging
features if you use XP.

dyse faster partitions
Files stored at the start of a
disk are faster to access. Make
sure that the video is cap-
tured to a partition which is
at the start of the disk and
which is not already too full.
Note that the position of

the actual data matters, not
the size or position of the par-
tition. For a disk split in half,
data at the end of the first par-
tition (when the drive is near-
ly full) will be read at the same
speed as data at the start of the
second.

k4dsum of all parts

When editing a large video
file, it may be a good idea to
break the file into smaller
bits. You will probably be
applying filters and recom-
pressing the video after edit-
ing. Once you finish cleaning
up each bit, you can join
them together again and
recompress and apply the fil-
ters at the same time.
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VirtualDub can automatically cut
video into smaller parts

LdMixing filters

If you are applying multiple
effects to the video, arrange
them in the best possible
order if the software allows
you to do so. Doing so can cut
the conversion process by
half or even more. For exam-
ple, if you apply a filter to
smoothen out the video and
another one to resize it, place
the resize filter first—the
smoothening filter will have
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VirtualDub lets you apply filters
in any sequence

to work on a smaller image
and also, you would want the
smoothening to work on the
resized image for best quality.

Cut video down to size
The size of the video file
matters tremendously dur-
ing post-production as well
as for distribution. The larg -
er the file, the longer it will
take to process. Also, the
video should be small
enough to be burnt on a CD
or DVD or even published to
the Internet, depending on
how you want to share it
with your friends

kdDead space

If the video has a solid boz-
der around it, cut it away.
Though black bars compress
extremely well and may even
take no space at all, the sharp
edge between the picture
and black area takes a lot of
space. Video compression

|

Cut out unnecessary bands from
the video

m tips and tricks

algorithms are meant to opti-
mise the smooth edges in
video, not perfectly horizon-
tal or vertical artificial breaks.
Normally, compressors break
the image into 8x8 or 16x16
blocks and the borders will
not affect much if they con-
form to these boundaries.
However, if they don't, the
compressor will either use a
lot of space for forming those
perfect edges, or smear them.

td1mage ratio

If you intend to compress the
video with DivX, the final
movie size should be in mul-
tiples of 16 pixels. Sometimes
it can be in multiples of 8
and, very rarely, 32. Thus, a
320x240 video will compress
well with DivX, but 321x240
will not.

tdManageably large

When capturing video, pick a
frame size close to the final
output. If you're going to make
a 320x240 video, it doesn’t
make much sense to capture at
640x480, since it takes four
times the space to do so. Ordi-
narily, do not set the frame rate
higher than 30 fps.

k4 Compress audio

AVI files with CD-quality
audio (176 Kbps) are quite a
waste of space, especially for
home videos. For distribution,
8-bit audio at 44 KHz is good
enough. Also, compress the
audio with a codec. This will
reduce the size of the audio to
between half and a quarter of

its original size with very little f,:"‘ﬁﬁf\"-.

loss in quality. MP3 is the best ',

codec to encode audio. How-
ever, on slow machines it can
cause synchronisation prob-
lems in the video.

Choose an audio compression
codec in VirtualDub

EANix Intros and Trailers
Use computer-generated
graphics  sparingly  with
video. Video compressors are
adapted to natural images
and do not perform optimal-
ly on saturated colours and
sharp edges. Depending on
the codec, title screens and
overlay items can adversely
affect video quality, especial-
ly at low bitrates.

If you must include
them, make openings and
trailers independent—don’t
use transitions to blend them
with the video and have
them start and end on
keyframe boundaries. Align
the position and size of over-
lay items to 8x8 or 16x16
pixel boundaries and make
them opaque. Transparent
regions on the logo will be
translated as a complex tile
by the codec and will take up
a lot of space. If the logo is
opaque, the codec will ignore

ﬁ&\ﬂ Video@Home

The Blair Witch Project
proved that great video is
possible with low-end
equipment. This movie
was shot on Hi-8, a low
level video format with a
camera that had a one-
colour chip instead of the
usual three on professional
equipment. Only a simple
camera-mounted light was
used.

it between keyframes, saving
a lot of overheads.

t4pon't pack video

There is no use compressing
video files to ZIP, RAR, etc.
Compression greater than 2
per cent means the video itself
is not constructed correctly.
You will need three times the
space of the video to pack it
and so will the person view-
ing the video. Also, viewing
partial downloads becomes
impossible. If the video is dis-
tributed as it is, depending on
the codec, a partial download
can be viewed or repaired.

tdpivx

DivX is the latest in video
compression technology. It
affords very high quality
video in very small files using
MPEG4 compression. This is
the best codec to use, espe-
cially for distributing video.
DivX 5, the latest version,
uses variable bitrates (VBR)
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and is especially efficient. It
detects the best setting for
the video, so even if you set
a very high encoding bitrate,

it will not go beyond what is
required, giving you high
quality and maintaining the
file size optimally.

AUDIO EDITING

Covered here are some of the best software for
digital audio creation and tips to help you get
started and become more familiar with them

Cakewalk SONAR

This MIDI and digital audio
software is used by profes -
sionals for producing CDs,
soundtracks, live perform -
ances and Internet content.
SONAR is the perfect avenue
for enthusiasts to enter into
the world of digital audio
and MIDI-based recording

EdTemplates

If you plan to use Cakewalk
for your music projects, it
makes sense to have a tem-
plate ready to define your
musical ensemble, say, a pop
track or a jazz quartet or a par-
ticular studio configuration

(MIDI ' instruments, audio
outputs, and so on). Tem-
plates make it fast and easy to
create and configure new
projects.

To create a template, cre-
ate a new file. Add tracks,
select the track properties and
the instruments you want in
your template. Now adjust
the parameters and click File
> Save As and select Template
from the Save as Type list.
Enter a name and click Save.

kdLayouts

You can save the current
workspace layout (menus,
panels, palettes, etc) or load

any saved layout and apply it
to the current project. You
might want to create a layout
so you can easily arrange the
items in a convenient size
and position on the screen.
This is also useful if you cre-
ate different genres of music
ranging from Jazz to Pop to
Classical, where you would
want different workspaces to
be shown depending on what
you are comfortable with.

tdshortcuts

Learn the basic shortcuts.
The [Spacebar] starts and
stops playback and the [W]
key takes you to the start of
the track. Use key bindings to
associate commands with
keys on your MIDI or com-
puter keyboard. You can bind
a key sequence like [Ctrl] +
[M] to drop markers, or [Ctrl]
+ [A] to stop recording and
return to the beginning of
the song and so on. Select
Options > Key Bindings to dis-
play the Key Bindings dialog
box. You can even map out
keys on your MIDI keyboard
to act as triggers for events.
For example, if you want [C]
+ [4] on your keyboard to
activate your graphic EQ, you
can map it as such using key
binding in SONAR.

tdstudioware panels

One of the most useful fea-
tures introduced in the
recent versions of Cakewalk
isthe implementation of Stu-
dioware panels. Simply put,
Studioware = panels  are

onscreen representations of
your outboard hardware such
as FX units, mixers and so
on. For example, if you have
a Yamaha 03D, which is a 26-
channel digital mixer, you
can control its MIDI aspects
onscreen through the use of
a custom Studioware Panel
that emulates its control
panel. With a few simple
mouse clicks you can control
the device’s faders, pan pots,
effect sends and channel
on/off functions through the
graphic representation of its
control panel.

There are always new
panels available for down-
load on the Cakewalk Web

site. To open a new Stu-
dioware panel click File > Open
and choose the file type as
Studioware.

You can build your own front
panels in SONAR

tdUndo and redo
Cakewalk supports up to 128
levels of Undo. Use the
Undo and Redo functions in
the Edit menu to step back
and forth through recent
edits. You can also jump
directly to one of the previ-
ous 128 edits by selecting
Edit > History and then select-
ing the edit point you’d like
to return to.
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kdMarkers made easy
Add Markers in real-time dur-

ing playback by pressing
[F11]. Rename them after-
wards by right-clicking on
them. This dialogue also lets
you adjust their position pre-
cisely by creating them at
specified time locations.

SONAR markers divide your song
into vocals, chorus, verse, etc

£4Using the Drum Grid
pane

SONAR'’s Drum Grid pane
makes editing drum tracks
and patterns a snap. MIDI
drum tracks usually sound
unrealistic, unless you use
timing and velocity informa-
tion—SONAR makes it easy
to edit these parameters in a
single window. Use the Drum
Grid Pane to add or delete
notes, paint them in with the
new Pattern Brush, and mod-
ify any note property.

To display tracks in the
Drum Grid, create or load a
drum map by selecting
Options > Drum Map Manager.
If you want to create a total-
ly new drum map, click the
Create New Drum Map but-
ton in the Current Project
field. Change the focus to the
Track view. Select the tracks
you want to view in the
Drum Grid Editor and select
View > Piano Roll. The Piano
Roll view appears with the
selected track’s data in the
Drum Grid Editor. Use the

m tips and tricks

Pattern Brush tool to produce
a series of notes in the Drum
Grid pane. The type of notes
that appear in the Drum Grid
depends on the settings you
make in the Pattern Brush
tool’s dropdown menu. To
open the Pattern Brush tool’s
dropdown menu, click the
arrow on the tool’s icon.

SoundForge

This is an excellent WAYV file
recording, editing and filter -
ing tool. SoundForge lets you
non-destructively cut and
paste audio without any
headaches and also allows
you to add effects processing
that was previously only pos-
sible with a large rack of
expensive studio gear

tdRemoving pops and
hisses

Sounds that you've put
together don’t always come
out squeaky clean. Many
times you’ll have noticeable
pops or hisses that weren't
intended to be a part of the
ensemble. This mostly occurs
when the sound has been
recorded at too high a level or
if the input source audio is of
low quality. To remedy this,
you can either reduce the vol-
ume and re-record it at a cor-
rect level, or normalise the
audio by bringing it to the
correct level. Click Process >
Normalize and specify a vol-
ume level (in per cent) lower
than that of the original
sample—it should be 80 per
cent of the original sample.

This will help get rid of any
crackling and hissing present
in the source file.

td speed up your
SoundForge sessions

This tip works especially well
if you're working with a very
large audio file. There is a
way to speed up the process-
ing of SoundForge, but it’s
not useful in all situations
because it involves disabling
the Undo function. Be wary
though; without the Undo
function, there is no way for
you to reverse any of the pro-
cessing that you apply to
your audio data. At the very
least, you should make a
backup copy of your original
audio file before you attempt
to do any editing.

To disable the Undo func-
tion click Options > Preferences
to open the Preferences dialog
box. Click on the Editing tab.
Activate the Limit Number Of
Undo Buffers To option and
enter a value of 0. Click OK,
and exit SoundForge.

Now any processing you
do in your files will be
permanent, but it will be
completed much faster. You
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Set the number of Undo and
Redo buffers to 0

can use the time you save to
make even more music!

£4The chipmunk effect

The chipmunk effect can be
achieved by simply changing
the vocal pitch to a higher
frequency. The trick is in
keeping the part the same
length, because when you
increase the pitch of audio,
you normally shorten the
length of the recording.
Here’s how to get around this
problem: Select the audio
data. Select Effects > Pitch > Shift
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Create cool vocal effects with the
Pitch Shift effect

Set the Semitones parameter
to 7, and leave the Cents
parameter at 0. Activate the
Apply An Anti-Alias option.
Activate the Preserve Dura-
tion option. Select Speech 3 in
the Mode list. Click OK. Click
on the Preview button to
check out the changes before
you apply them.

LdThe Darth Vader effect

You can also use pitch
changes to achieve the oppo-
site of the chipmunk effect.
Instead of the light and
cheery sound, you can lower
the pitch of your vocals to get
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il st s s Keyboard Shortcuts in SoundForge
vocal effect, like that of

Darth Vader. Try doing this Cursor movement

to a plain speech recording. [End]

Here’s how: Select your [Home]

recorded audio data. Select [Ctrl] + [End]

Effects > Pitch > Shift. Set the [Ctrl] + [Home]
Semitones parameter to -7, Navigation and playback
and leave the Cents parame- [Up Arrow]

ter at 0. Activate the Preserve [Down Arrow]

Duration option. Choose [Shift] + [Up Arrow]
Speech 3 in the Mode drop- [Shift] + [Down Arrow]
down list. Click OK. [Ctrl] + [Up Arrow]

The last sample visible in the waveform display
The first sample visible in the waveform display
The last sample in the data window
The first sample in the data window

Increases time magnification (zooms in closer to data)
Decreases time magnification (zooms out farther from data)
Increases level magnification

Decreases level magnification

Zooms selection if a selection exists, zooms fully if no selection
Zoom:s to default zoom ratio set in Preferences

[Ctrl] + [Down Arrow]

To spice it up, try apply-
ing some reverb to achieve
an ‘evil laugh’ effect. Select
Effects > Reverb, and then
choose the Cathedral preset.
Click OK. The effect should
send a chill down your spine!

tdFades, amplitude and
envelope editing
In this tip, we explore many
of the powerful tools that
SoundForge provides. Load
the ‘ROB DOGG - A3.wav’
file provided in the Surge
section of the Playware CD
into SoundForge. Adjust the
zoom until your screen looks
like the one shown here.
We can simulate the
drums gradually fading in
and out as if they are passing

el elel el
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Fade in the first three seconds of
the track

us by. Select the starting por-
tion of the sound sample
and then select the Fade
option under the Process
menu. A menu will pop up
on the side showing three
options: Graphic, In, and
Out. Pick Fade In for now.

Selecting the Fade In
option will automatically
adjust the amplitude from
the beginning to the end of
the selection area you have
marked in the sound sam-
ple. The computer will now
process the sound sample
and reduce the amplitude of
the selection starting very
low at the beginning and
ending with no change.

Do the same to create a
Fade Out starting about two-
thirds of the way through
the sound sample and con-
tinuing to the end of the
sample. The Fade Out option
is right under the Fade In
option in the Process menu.

To change the amplitude
of the entire song, select All

from the Edit menu, and
select the Volume option
from the Process menu.

To achieve an envelope
effect, where the sound fades
in and out quickly, select the
Fade option, and then select
Fade Graphic from the
popup menu. A large dialog
box will appear with a graph
representing the selection
you made from the sound
sample. There is a straight
line across the top with han-
dles on it. Click on a point
(open square box) on the
line and pull it down to
shape the envelope. If you
find that you need to add a
point, click on the line and a
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Use the envelope effect to make
sound fade in and out quickly

new box will appear. Make
your graph look like the one
shown. When you are done,
click on the OK button in
the upper, right-hand corner
to process the sound.

FruityLoops

As its name implies, this
software is suited to creating
loop-based electronic music
from audio samples. Many
people use FruityLoops for
rhythm creation, since the
layout is very similar to that
of Roland drum machines

t4dKnob adjustments

Use the [Ctrl] key to fine-
tune your Kknob adjust-
ments. If you think you
messed up an adjustment,
hold down the [Alt] key and
click the knob to set it back
to its default position.

kd organising files

When you have completed a
song, use the Collect Samples
feature in the File menu to
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insight =

copy all of the associated sam-
ples into one directory and
save a copy of the *.flp file as
well. That way you will be
able to work on the song days,
weeks, or even months later
without having to relocate all
of your samples. Backup your
*flp files often, so that you
can track changes and modi-
fications to subsequent ver-
sions of the file.

Enter useful information
about the song (ideas for
changes, etc) into the Song
Info dialog box (found in the
Options menu).

Add effects, twist sounds and
layer the samples in FruityLoops

tdsynchronising loops

If you need to synchronise
loops of different tempos,
you'll have to stretch some of
them. Divide the tempo of
the one you're stretching by
the target tempo to get the
ratio by which you need to
change the length of the
loop.

tdUsing multiple tracks

Another interesting thing you
can do with multiple tracks is
grabbing a couple of identical
drum loops and triggering
them at exactly the same

m tips and tricks

point. Often, this will add a
slight metallic quality to the
sound and give it a bit more
edge. Even better, try detun-
ing one of the loops slightly;
the bigger the detune, the
more out of time the loops
get. This will produce some
interesting flanging effects.

ReBirth

ReBirth is an excellent soft-
ware for emulation of drum
and bass patterns. It is a
software reincarnation of
classic analogue hardware
synthesizers. The panel looks
like two Roland TB-303
bassline synthesizers and
the Roland TR-808 and TR-
909 rhythm machines

44 PCF: The heart of ReBirth
Pattern Controlled Filter
(PCF) is basically a filter mod-
ule consisting of 54 preset
patterns, a two-pole filter and
four control parameters. This
is the unit that generates the
basic sound loop upon which
you can add effects and
change various parameters
that decide what the eventu-
al loop sounds like. What this
effectively means is that you
have a little bag of tricks that
can transform a dated syn-
thesizer into a more sophisti-
cated animal. Along with the
PCF, the sound can be altered
using the distortion and
delay FX in ReBirth.

Here’s how you can use
the PCF filter to create your
own track in ReBirth:

Step 1: To create a single note

on one of the panels in pat-
tern mode, click on one of
the keys in this panel.

Step 2: Set the Tune knob on
the 303 panel to the 12
o’clock position. For a rich
bass sound set Cutoff to the 7
o’clock position, Resonance
to the 4 o’clock position and
Envelope Modulation to 3
o’clock. Decay should be set
high so that the note charac-
teristics don’t fade too quick-
ly. Play around with these set-
tings for different effects.
Step 3: Press Play and listen
to your one-bar bass note.
Press the PCF button on the
303 panel. The green light
will come on and you will
notice a change in the sound.
Lower the tempo so that you
can hear the notes clearly.
Step 4:Flick through the var-
ious preset patterns by press-
ing the up and down Kkeys
next to the number on the
PCF panel. With ReBirth play-
ing, add some delay to your
sound by turning the Delay
knob on the 303 panel to 2
o’clock. You can edit the

Tuning knobs

PCF

303 panels

Drum machine

effect on the delay panel if
you want.

Step 5:Audition some of the
sweeping PCF patterns (12-
17) and listen to how far your
one-note ReBirth pattern has
come. It’s incredible what you
can do with the synthesizer.
Step 6: Toggle to Song Mode
and set a loop of eight bars
beginning at bar 1. Choose
Initialize Loop From Pattern
Mode on the Edit menu.
Make sure the loop is
switched on and playing. You
will now hear an eight-bar
loop of the sound you created
in Pattern Mode.

Step 7: By selecting the
Record button and pressing
Play, you can record the
changes you make to the PCF
parameters in real time into
your track. Move the PCF
sliders around to create your
own filter patterns on top of
the PCF presets.

Feel free to play around
with all the knobs, now that
you know the basics. You
never know what you can
come up with. d
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RLUSTRATONE RAT

Watch the boundries blur between
what is real and what is virtual as

games get more immersive

ohn was cornered. Chased down by

the monster, he had taken desper-

ate refuge in the wrecked boiler

room, which was quickly filling up
with steam. He had killed some of them,
but this particular one had a very nasty
habit of turning invisible.

He had two bullets left. Sweat stung
his eyes and his wounds throbbed with
pain, but he dared not blink. Then, out of
the corner of his eyes, he thought he saw
the steam move. Not sure. And again, no
doubt this time—a shot from his hip was
answered by an unearthly scream. John
grimaced. He knew he had got the crea-
ture, but only a bullet to the head would
kill it for good. One bullet left. He wait-
ed. The steam swirled, the creature was
stirring. Wait. Slow, deliberate steps
brought the swirling white ever closer to
John. Wait. The thing picked up pace,
and the haze wrapped itself around the
invisible form, granting it a grotesque
shape and rendering it visible. Wait. The
very air seemed to pounce, vapour
danced and twisted to reveal jaws from
hell. Wait. The figure was now inches
away from John, he could smell its foul
breath... BANG! Slowly, hesitantly, he
opened his eyes to a sight of relief—a life-
less abomination lay at John'’s feet. He
had lived to tell the tale.

Thanks to the advances in technolo-
gy, the adventures of John are no longer
confined to some twisted plot in a book,
or some cheesy scene in a movie, but are
brought kicking and screaming to digital
life and on your computer screen.
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Prettier than a picture

Every industry under the sky is in search of
its Holy Grail, something that will define
the zenith of achievement for that sector.
For the gaming business the goal has
always been providing an experience so
life-like, that the line between real and vir-
tual is not just blurred, but is completely
erased. Immersion and interactivity have
been greatly blessed by the continual evo-
lution of hardware. CPUs are faster and
sound has moved from the era of the PC
speaker to the realm of six-channel Dolby
Digital surround audio. The greatest change
though has been in the video card industry.
Heralded by nVidia, video cards are becom-
ing increasingly programmable and thanks
to the collective efforts of both the hard-

ware and the developer segments, graphics
standards such as DirectX and OpenGL are
moving towards becoming higher-level

Greater immersion in games has been
successfully achieved by upping the polygon

count and adding lighting effects, as seen here

in DOOM Il (above) and Morrowind (right)

languages, providing greater freedom and
compatibility to game developers. These
technological advances have brought the
industry within striking distance of its goal.

Just how will this immersion be
achieved? The first step is to pump up the
basic building block of any game—the poly-
gons. Greater the polygon count, the more
detailed the world and everything in it.
Polygon counts are no longer restricted to a
few thousand, as the latest video cards are
more than capable of handling a scene with
30 to 50 thousand polygons on the screen.
Developers of The Elder Scrolls III: Morrowind,
the third part in a series of role-playing
games by Bethesda Softworks, have used
this fact to create a highly detailed envi-
ronment for the game. The on-screen char-
acters are three-dimensional, created with
high polygon counts and are clothed with
multiple texture maps to make them look
much more believable and life-like.
A character can thus be shown in
meticulous armour, and the armour
can either have a realistic metallic
shine, or a rusty worn-out look.
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arcade . games

With better hardware, it is now possible to simulate smoke, dust storms and other particle effects

Moreover, weather changes such as fog,rain,
dust-storms and day and night time cycles
make the world of Morrowind much more
believable and immersive.

Particle by particle
But Morrowind is just the herald of things
to come. Particle effects are coming of age,
adding realism to what was hitherto a very
drab environment. Mark Rein, Vice-Presi-
dent of Epic Games Inc talks about the
Unreal Engine: “A dynamic particle system
is used to simulate dusty areas illuminated
by light beaming through windows; and
the dust moves around the air realistically
as it gets disturbed by moving objects.”
Westka Interactive’s The Y Project (a game
combining action-adventure with role-
playing elements, based in a science fic-
tion/fantasy setting) uses this system to
allow for impressive looking fires, sparks,
smoke and foaming water. The particles are
all tracked by the engine and since they
react to objects passing through them,
“when you fire a missile into a cloud of
smoke, the smoke realistically dissipates”,
or if an invisible monster runs across a
room filled with smoke, you will be able
to see where it is by watching the smoke
swirl as the creature moves through it.
Mark adds, “Another stunning effect
is projective textures. They are used to
create, among other things, soft-edge,
ultra-detailed, real-time shadows, that
cast on the world as well as the objects
and characters within it. The intricate
shadows not only render over the char-
acters and the environments but also over
the particles; as those particles are blown
around by things flying through the air!”
Immersive and interactive, isn’t that what
a game is all about?

In The Y Project, 30 per cent of the
game occurs outdoors, where the particle
system adds its magic touch. Clouds mov-
ing across the sky send real-time shadows
creeping across the ground. The same sys-
tem is used to create ripples and waves in
water as you wade through it.
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Regardless of the type of game, special
effects are making a big difference in cre-
ating believable fantasies. A treat for F1
fans everywhere is Electronic Arts’ FI
2002—realistic cars, accurately modelled
real-world tracks, and anatomically cor-
rect models. These are just a few of the
details that put you inside the world of
F1 racing. The real treat though, is the
simulation of weather, with rain batting
down on your car, while raindrops settle
on the windscreen and refract your view
of the world, or the burned rubber that
swirls from screeching tyres and dissipates
languidly into the air.

But does creating a world in detail
ensure immersion? Take a look around
you and you will see the huge impact
light has on our world. Even its absence
adds a layer to realism. Just like the devel-
opers of the Unreal Engine, this truth has-
n't escaped the guys behind DOOM III.
For starters, all models will ‘self-shadow’,
which is just programmer-speak for say-
ing that parts of your body will cast shad-
ows on other parts of your body. It does-
n’t sound like a lot, but it all adds up in

War Games

Bohemia Interactive Studios’ Operation Flash-
point seems to have attracted the attention
of the US Army. The developers are building
a ‘Military Grade Program’ based on Opera-
tion Flashpoint technology called VBS1 (Vir-
tual Battlefield System 1). The system will
initially be used to train US marines, and has
attracted other military organisations across
the world for the purpose of training their
troops.

While the VBS1 system is top-secret
stuff, another project in the works is public
domain. America’s Army: Operations and its
companion game, America’s Army: Soldiers,
are both being developed by the US Army
in the hope of persuading the youth to join
the forces. Using the latest Unreal Engine,
AA: Operations will be an online shooter

the end. Secondly, models will cast shad-
ows on other objects in their surround-
ing, so you might see a large shadow
envelope everything in your sight before
seeing the monster that is attached to it.

It's in the details

You must have experienced moments in a
game when you knew something didn’t
feel right, but you could not be sure what.
“Gee, isn’t that guy I just shot supposed to
fall down the stairs?” or maybe even “he
sure looks funny with his pants on fire”.
You have been a victim of physicsitis. It is
a disease that is transmitted to gamers
when the game programmers have taken
shortcuts to building their physics engine.
Thanks largely to faster processors, game
developers now have the power to go all
the way with physics. People will fall down
stairs realistically when shot and pants will
look dandy when on fire!

Mark Rein, Epic Games, says, “Karma is
arigid-body physics engine that has been
integrated into the Unreal Engine and [is]
available to [appropriate] Unreal Engine
licensees. It allows you to simulate solid
objects such as crates, tires or bones, as
well as different joints, motors or springs
between objects. Using these simple build-
ing blocks, complicated systems can be
easily built that will behave according to
the laws of physics. This can be anything
from the classic stack of crates, to swing-
ing lights or doors that can be shot off
their hinges, up to 18-wheeler trucks, or
characters falling down stairs like a rag-
doll when they die.” So you can shoot at
overhead lights, which will make them

Putting the latest Unreal Engine through its
paces is the US Army with its upcoming games
America’s Army: Operations and America’s
Army: Soldiers

along the lines of Counter-Strike, while, AA:
Soldierswill be more of a shooter-cum-RPG
experience, charting your progress through
the army.
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swing and the swinging light will cast real-
istic, moving shadows all over the place. It
all comes together to form a more immer-
sive picture...

...Which brings us back to DOOM III,
where realistic physics is part of the pack-
age—you can interact with everything in-
game, knock boxes over and break stuff.
And the same kind of interactivity extends
to the bad guys as well. As John Carmack
puts it in an MSNBC.COM interview:
“That’s one of the things that will give this
game fear. If you were backed up to a cer-
tain kind of wall in the old games, you
knew that nothing was going to happen
because the wall was obviously part of the
environment. That level of security is not
going to be there [with Doom III] because
the entire world can change and you will
not be in command of your environ-
ment.” So monsters can break through
walls, glass windows and even doors to
come and get you. Where you gonna hide?
Why behind the barrel of my gun, of
course! Since a bullet is also simulated by
the physics engine, it will have a specific
effect based on where you hit an enemy—
if you shoot him in the shoulder, he will
start spinning or turning backwards or if
you decide to aim at his legs, he'll flip over.

But the game that has everyone jump-
ing in joy is the racing phenomenon,
Gran Turismo 3 for Sony’s Playstation 2
console. Not only does it feature cars and
tracks that look like their real world coun-
terparts, but it handles the physics side so
well that race car drivers have been
known to use the game to improve their
racing skills!

Doing it with intelligence
Physics, pretty graphics and cool lighting

Current technology has
allowed developers to offload
graphics processing to the
video cards, allowing for
better simulation of physics
in games such as IL-2:
Sturmovik (right) and Halo
(above)
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Unreal Engine as an Architectural Tool

A major challenge faced by architects is
that of presenting their creations to
prospective clients. More often than not,
2D sketches are insufficient for communi-
cating the architects’ vision, and they have
to rely on physical modelling tools or CAD
walkthroughs. Both these methods are
time-consuming and do not offer ease of
modification. Modern 3D game engines
have come to the rescue, the fore-runner
being Epic Games’ Unreal Engine. The
engine offers a great tool to developers of
gaming and non-gaming products alike in
the form of a mouse-driven level editor—
UnrealEd. Architects use the tool to create
a high polygonal version of their design,
apply photo-realistic textures, and use the
generated content to present a real-time

effects are all well and good, but when
you see an in-game character walk right
into a wall or unrealistically overtake you
in his inferior car, you are immediately
reminded that you are inside the make
believe world of games. Well, Al (Artifi-
cial Intelligence), as it is called, is perhaps
the biggest misnomer in the gaming
industry. Things might seem impressive
when the soldier that you are shooting at
ducks behind a crate and lobs a grenade
at you, or as you are crawling through a
pipe someone opens the hatch door and
drops in an explosive, but when the same
sequence is repeated time and again, you
know that this isn’t some advanced pro-
gramming magic but some basic (albeit,
clever) scripting.

Lionhead Studio’s Black and White
made an honest attempt to rectify the sit-
uation. Casting you as a God in an
unspoiled Eden, you could control one of
several creatures that would observe every-
thing you did, learn, remember and even-
tually form a personality closely mirroring
your actions. Lionhead and its affiliate stu-
dios plan to take the technology further in
games such as Project Ego and Dimitri.

Another title to
watch is Elixir Studio’s
Republic: The Revolution.
Revolutionary Al tech-
niques will allow ‘live’
citizens to inhabit the
dozens of towns and
cities in the in-game
country of Novistrana.
Each person will have
detailed daily routines

3D walkthrough to their clients. Given the
networking capabilities of the engine, the
client can be on the other side of the
country. And modifications can also hap-
pen in real-time, since the tool is just a
front-end for the game engine, which
concurrently updates changes.

that range from going to work, to collect-
ing their kids from school, shopping and
voting in an election. Each individual will
also have their own set of beliefs, emotions,
skills and loyalties that govern behaviour,
producing consistent and realistic reactions
to situations that arise in the game.

Are we there yet?

A while back, nVidia demonstrated the
power of its then-latest baby (the GeForce
3 video card) by rendering the computer
generated movie Final Fantasy: The Spirits
Within, in real-time. “Time has come”,
they said, “the power to deliver a movie-
quality game is here.” Apparently, devel-
opers were listening. At E3, held in Los
Angeles in May 2002, a recurring ques-
tion that was asked at the DOOM Il booth
was: “Why are you rendering this [DOOM
1I1?”, only to be answered by, “We’re not
rendering it... that’s the game.”

A few years ago, a director used
UnrealEd (then shipping with Unreal
Tournament) to generate 3D versions of
the sets for his movie, granting him the
ability to preview camera moves by fly-
ing through a real-time version of the
virtual set. This gave him a pretty good
idea of what the set was going to look
like before physically building it for the
actual shoot. The director was Steven
Spielberg, working on the epic A.L
(Artificial Intelligence). That was then.
The tools are better now, so is the tech-
nology and the hardware driving it.
Maybe next time Spielberg will not need
the real sets.f]

AHMED SHAIKH
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Hack-n-slash monster-stomping goodness!

lizzard’s new sequel revisits the
Bwar-torn world of Azeroth a

generation after the end of the sec-
ond war between the Orcs and the
Humans. The fragile peace that had settled
over the land is on the verge of being shat-
tered at the hands of a dark power. Two
new races, the Undead and the Night
Elves have been added to the game and
players follow a single storyline through
four successive campaigns. This time
around, the game plays in 3D, features
online multiplayer support and provides
design tools to make your own maps.

Going over the races...
Every race in Warcraft III has its own
strength and weakness—to know which
tactic will be most effective against your
opponent’s race can prove extremely use-
ful. Each race has a large number of pos-
sible strategies, but there are only a couple
of them that are the best in a given
situation.
Humans: The Human alliance is a con-
glomeration of Humans, Elves and
. . Dwarves. They have the most
;W, versatile army in Warcraft 1],
/gt‘;\ with very good ground and
S air troops, excellent siege
capability and powerful spellcasters.

Cheats Galore

While playing the game, press [Enter],
type the code below, and press [Enter]
again.

iseedeadpeople: Removes Fog of War

(so you can see the map)

thereisnospoon: Unlimited mana
allyourbasearebelongtous: Instant victory
whosyourdaddy: Invincible units
somebodysetupusthebomb: Instant defeat
(for you)

greedisgood: 500 extra gold and wood
warpten: Fast build

locainePowder: Fast death

keysersoze [amount]: Gold (i.e. ‘keysersoze
50000’ will give you 50,000 gold). The
default is 500
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The Undead: The
Undead have some
good higher-level units,
like Necromancers,
Abominations and Meat
Wagons. The Undead

; Scourge is
a well-bal-
anced fac-
tion that
flelds persistent ground
forces and powerful air
units. Their Spellcasters
possess a variety of
powerful magic, includ-
ing the dreaded ability
to raise fallen allies and
foes alike into an army
of the walking dead.
Orcs: These green-skinned dudes can do
a good job, especially if mixed with long-
range attacks from Head Hunters. Orcs
can work wonders with
strategies involving blood-
lust. The Orcish horde has
modest air troops and ranged
attack capabilities, but their true strength
lies in their brute force and raw melee
power.

your horde

%r F"i%\

& -(‘»
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Use the [Tab] button to select and manage sub-groups within

Night Elves: The last stage in the single

player campaign, the Night Elves are a

mighty race that emphasise mobility,

. ranged firepower and spell-

= craft. They don’t have the

brute strength of other races,

but their skills with the bow

and magic more than compensate for
this deficiency.g

SRIRAM SHARMA

Focus Fire

Focus Fire is arguably the easiest and most
powerful aspect of micromanagement in
Warcraft Ill. The concept is simple—all of
your units attack just one enemy unit at a
time. Instead, if you attack your enemies in
general (Blind Fire), you will take a lot of
extra damage. A perfect Focus Fire vs Blind
Fire enjoys a 4 to 1 effectiveness ratio, mak-
ing a huge difference.

Expand

Expand your base to a wide breadth across
the map. Every time you see a gold mine,
take it and secure it with towers—these are
a must. As long as you have a strike force to
take out the enemy’s siege, the towers will

Micromanagement Basics

shoot arrows at the enemies, giving good
long-range defence. Thus, the more towers
you have, the better.

Unit obstruction

Unit obstruction is the process of using your
units as a shield to prevent your opponent
from moving ahead. Using your units as a
shield is pretty easy—just keep your melee
units in front of your ranged units, or in
front of a chokepoint or a narrow path.
Behind enemy lines

Send peasants early in the game to build
guard towers right outside the enemy base.
This is an annoying tactic for the enemy
because he can’t get out of the base with-
out getting severely hit.
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WARCRAFT Il

It's finally out and it's worth the wait

ne of the most anticipated games,

from one of the most revered game
development units, is the epic Warcraft I1I.
Developer Blizzard has crafted this game
with amazing production values, boasting
totally rendered 3D graphics, a new game
system and four playable races.

Warcraft Il reminds one a little of Dia-
blo with its role playing elements like
quests, experience points and character
development. The campaigns are well laid
out—you'll progress from controlling the
Humans, to the Undead, to the Orcs and
finally the Night Elves as you save the
world from the hands of the Burning
Legion. The single player missions have a
lot of variety in them, with hack-n-slash
gameplay, to search and rescue missions.

The game cashes in on its production
values. All the races are unique in the way

their function and personality is stylised.
The story is pushed forward through cut-
scenes; both rendered and in-game, and
a compelling storyline that keeps you up
till the wee hours. The voice acting and
soundtrack is top-notch too, and lend
well to the pace of the game.

The game wins over its fan base with
the multiplayer option—players can con-
nect to Battle.net and play against others
from across the globe, or just have a LAN
skirmish. You can even record the multi-
player game and view it later, a feature
that is going to make for some crazy RTS
strategies and counter strategies. Anoth-
er winning feature is the world editor,
which allows you to make your own maps
and in-game cut scenes.

At Rs 1,499, it's a little expensive,
though each pack comes with a poster, an

Shelf |

ACTION! In-game cinematics and cutscenes
such as these will keep you hooked to
Warcraft Il

extensive manual and mini books. War-
craft Ill is a finely tuned game with loads
of polish and presentation, something
you simply cannot afford to miss.

Genre: Real Time Strategy = Developer: Blizzard = Distributor: Worldwide CD Roms= Phone: 022-6973994/95
Web site: www.blizzard.com/warlll = Price: Rs 1,499 = []1[1[][][]

BHAGAT SINGH THE GAME
Inquilab [Ctrl] + [Alt] + [Del]

he package says ‘For the Hardcore

Indian’. If being a patriot includes the
ability to stand tedious gameplay, poor
graphics, bad AI, bugs, boring level
design, and an intrinsically flawed
weapons and health system, then this
game is really hardcore!

The storyline is based on incidents
from Bhagat Singh’s life, such as his
assassination of General Saunders. It's a
first-time effort and the inexperience
shows in every aspect of the game. Play-
ing the game is a dizzying ordeal. The
keyboard settings are un-configurable—

GOT A MATCH? Poor lighting makes this
game an exercise in tedium

the strafe keys are on one side of the key-
board and the direction keys on another.

The gameplay moves at one-third the
speed of a normal FPS and is compound-
ed with bad voice acting, poor lighting
and level design that leaves you fumbling
in the dark, guided by a voice that says
“Bhagat, main Durgadevi bol rahi hoon,
upar aa jaoo.” Enemy Al is non-existent;
the enemies just stand and shoot at you
aimlessly, while mouthing catchphrases.
The health system consists of killing
white enemies and walking over them.
We'’d say that all the love for your
country wouldn’t make you complete
this game.

Genre: First Person Shooter = Developer: Mitashi Edutainment = Distributor: Mitashi Edutainments= Phone: 022-5006661
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NEVERWINTER NIGHTS
Role-playing was never this fun

ith a development cycle that’s been

longer than four years, Neverwinter
Nights (NWN) was planned as a major
milestone in the role-playing genre of
computer games. The final product comes
very close to delivering its promise.

MEET NEW PEOPLE...THEN CRUSH THEM: The game
pits you against beasties of all kinds and make

Based on the third edition of Dun-
geons and Dragons rule-set, NWN comes
packaged in three CDs, complete with a
cloth map for reference and a hefty 218
page manual. With over 22 pre-made
characters running the gamut from
Halfling monks, to Elven wizards and
swashbuckling rogues, the game packs
enough personalities to suit your fancy

and to get you up and running with just
a few clicks. NWN uses the brand-spank-
ing-new Aurora engine to immerse you
into an interactive 3D world. The idio-
syncrasies of camera-control and the RPG
concepts of inventory management and
leveling up are succinctly
explained via a useful tutorial,
masquerading as the prologue to
an epic story.

The animations are top-
notch—your  character will
swing, block, parry and duck
enemy attacks, adding an amaz-
ing layer of realism and immer-
sion. Lighting effects bring day
and night cycles and real shad-
ows. All these ingredients are
brought together in locations
ranging from foggy hilltops, to
water-filled caverns that are
swamped with monsters big and small,
with attitudes to match.

The game tells a winding story that
takes you on a voyage across cities and
towns, both in and out of this world. You
can pair up with one computer-controlled
character that the game terms as a hench-
man. Moreover, you can summon and
command creatures and if your created

character allows for it, choose a familiar
(a character) to be part of your adventur-
ing party. Fans of previous BioWare games
such as Baldurs’ Gate I and Il might be dis-
appointed with the limited number of
party members, or by the reduced level of
interaction amongst them. Other pitfalls
include some minor hiccups with path
finding and other AI routines, and some
not-so-minor ones that involve your game
crashing to the desktop. Patches are com-
ing in fast and hopefully these problems
will soon be resolved.

The visuals are very well supported
by excellent sound effects that include
cries of pain and taunts to incite your
enemies. The music rendered by indus-
try veteran Jeremy Soule provides an
excellent bridge between hectic battles
and the tending to wounds that follow.
Add to this the ability to play co-opera-
tively with friends over a LAN, or on the
Net and the fact that you can create your
own adventures, it becomes obvious that
the game offers an excellent package to
play with.

Although not without its flaws, it
does not take too long to appreciate NWN
for what it is—an excellent role-playing
experience.

Genre: Role Playing = Developer: BioWare = Distributor: Milestone Interactives Phone: 022-8381614

Web site: www.bioware.com = Price: NA= [J ][] [] ]

ALFRED HITCHCOCK: THE FINAL CUT

Cut it out!

Ifred  Hitchcock’s
sycho may have

sent a chill down your
spine but The Final Cut
leaves a lot to be desired.
You enter the plot as
Joseph Shamley, a pri-
vate detective hired by a
young and beautiful
mute, Alicia, niece of the
pharmaceutical tycoon
Robert Marvin Jordan.
You have to uncover the
mysterious  overnight
disappearance of your client’s uncle and

HELLO DUMMY: Joseph gets his first
shooting lesson while filming a scene

his entire film
crew while shoot-
ing a Hitchcock
film.

Aside from a
seemingly unre-
alistic plot, the
game also suffers
from irritating
shifts in camera
angles as you
move  around.
Surprisingly, as
you get into the
first chapter of the game, there is a vast

e

environment to explore, but moving your
character around is a pain, as you can only
do so using the arrow keys.

The environments are well designed
and look quite appealing, although the
same cannot be said for the character
models, and Joseph’s conversations with
other characters are mostly monosyllabic
and rigid. The game does have its
moments though, such as the part where
you're exploring the family burial ground
which is accompanied by some eerie
music. All in all, what you would really
need to enjoy this game, is a whole lot of
patience.

Genre: Adventures Developer: Arxel Tribe = Distributor: Alladin Multimedia = Phone: 022-7895085/7903959
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Web site: www.arxel.com = Price: Rs 999 [ ][] [][]
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Circle of Life

Of dark nights, eerie sounds, high nerves, pizzas and ice creams

t was a dark, stormy night. Lightening

rattled the window panes while the

slashing rain washed the pale-faced

building that stood as the solitary
spectator of a sulking moor. Within the
edifice lurked creatures with deep circles
under their eyes and an eerie chant of
“Issue closing, final proofs, comparison
table validation...” hung like thick
smoke in the air.

Issue Closing—two words that
we have learned to associate with
pandemonium and loss of hair.
We come to work and buzz like
busy bees at our monitors and
keyboards all day. But the late night
sessions, which are an omen of the
approaching closing date, bring
out the dark side that hides with-
in us all. Nerves are high-strung;
energy levels are low and the \ =
well-hidden quirks of every Dig- 2%
ster surfaces from behind their
mask of calm demeanour.

Take the case of Veer, a writer here
at Digit. An otherwise unassuming indi-
vidual, he is transformed into a sleep shun-
ning, headphone-happy bundle of nerves
come issue closing. But that is not the
problem that had us up-in-arms that night
in July. Breaking the monotone and grab-
bing the attention of the otherwise key-
board-happy ‘Technology Journalists’ (as
we like to call ourselves), was a singular
and eerie whistling. We had been working
endlessly through the night and were
decidedly feeling edgy. So it was not with-
out reason that Sveta, our features editor

e

was startled. The eerie whistling was then
followed by an awkward wail. An investi-
gation revealed that the source of the
ruckus was not a table fan that had been
on too long, but Veer’s rendition of a vio-
lin segment from a classical piece of music.
Suffice to say, his performance ended

abruptly as a million paper
balls headed his way.
Veer’s dodging skills

7

have thus improved, though it is his
singing that needs help.
Even as we successfully quelled Veer,
a shout of “we need it now”, was heard
from the Test Centre. Deadlines not only
put people on the edge, but have also
been known to demand sacrifices—the
latest victim was Yatish. He is a Test Cen-
tre reviewer and perhaps the biggest fan
of Tux, the Linux penguin. His hard disk
was immediately required for the purpose
of running a test—the very same hard
disk that housed his beloved Linux. He

The Light Side Conquers All

This month saw a special treat for Club

Digit members. Subscribers were invited to
a special screening of Star Wars Episode II:
Attack of the Clones. The event was held in
six cities and gave us the unique opportuni-
ty to interact with our beloved readers. In
Mumbai the venue was the Russian Cultural
Centre and we had a blast! Star Wars fans
from all walks of life thronged together and,
as one of our writers put it, “had a jolly

FEM 133

good time”. Although almost everyone
missed identifying Ayesha Dharkar, the new
Queen of Naboo, the highlight of the movie
was the cool battle sequence involving
everybody'’s favourite Jedi Master—Yoda. As
he leapt into action, light-saber in hand, the
entire venue erupted in excitement. There
was much whistling and clapping and we
were amazed as our seemingly gentle tech-
nology readers revealed their lighter side.

21 \LLUSTRATION : Mahesh Benkar

was not pleased and as misty tears cloud-
ed his vision we caught a whisper of “I'll
never forget you, my dear,” as he hit the
format button.

Troubles at the Test Centre were not
restricted to Yatish though. Hatim, our
deputy head of the Test Centre, was the
latest to take part in the not-so-fun game
of find-the-missing-editor. “So I just have
to verify these numbers? No problem,”
said Hatim. Our editor however was fran-
tically trying to close the August issue and

was busy with other tasks. Hatim

.' went back and forth between his
desk and the editor’s and before long,

the night sky found him still awaiting a
clearance. Frustrated beyond belief, he

. decided to boot up Quake IIl Arena for

# aquick frag session and promptly fell
~- asleep holding the keyboard and the
mouse. Things ended well as he got
the required all-okay from the big-
chief at an unearthly hour. The only
problem was that it was so late that he
had to crash at a friend’s place and boy
was he grouchy the next day!

Unearthly hours are regular guests
here at Digit. Working non-stop through
the weekends though, brings in the
inevitable demand for nourishment. But
that doesn’t mean that we have to leave
our chairs, heaven forbid! We have
devised other solutions. Certain team
members are diplomatically manipulated
to stay back in case we need them for
“some last minute references and cross
checks”. Incidentally, they happen to
have vehicles at their service and are
gullible to whines. Our taste buds are con-
sulted, the weather is taken into consid-
eration and a general discussion on what
each person feels like eating ensues. So it’s
pizzas for lunch, then frankies at tea,
biryani for dinner interspersed with hot
vada pavs to drive away the chill and ice
cream to beat the heat. And once the foo-
dathon is over, we start thinking about
what next to eat, until the grim reaper of
deadlines (our editor) taps us demand-
ingly on the head and we ignore our
grumbling stomach till the next issue
closing.

The circle completes itself. ]
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Yeh Dil Maange More!

It looks like the fan following for the much anticipated Unreal

Tournament 2003 is getting younger and more
demanding! Wouldn't be a good idea to
keep these guys waiting!

IF YOuU oMLY
KHNEW THE POWER

OF THE
MICRO30OFT

The software developers’
drinking song

99 little bugs in the code,

99 bugs in the code.

Fix one bug, compile it again,

101 little bugs in the code.

101 bugs in the code...

Your chal?ce to

Highlight the lighter side of computing. Mail
your contributions to: Backbyte Digit, Plot

D-222/2, TTC Industrial Area, MIDC, Shir-
vane, Nerul, Navi Mumbai 400 706
or e-mail us at backbyte@jasubhai.com
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Hounding the
weak

So that’s what it felt like

when that trainee first
joined the company’s

6 o’clock Quake III Arena

fragging session!

Is that a mouse in your monitor?

Talk about introducing your pets to computing—
this hamster looks absolutely at home in this pala-
tial 17-inch monitor!

Error messages we're likely to
see in the next Windows

Smash forehead on keyboard to continue.

Enter any 11-digit prime number to continue.

Press any key to continue or any other key to quit.
Press any key except... no, No, NO, NOT THAT ONE!
Press Ctrl-Alt-Del now for 1Q test.

This will end your Windows session. Do you want to
play another game?

Windows message: "Error saving file! Format drive
now? (Y/Y)"

File not found. Should | fake it? (Y/N)

Bad or missing mouse. Spank the cat? (Y/N)

Your hard drive has been scanned and all stolen
software titles have been deleted. The police are

on the way.
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